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Introduction

This guidebook is meant to help you with managing your business finances
by guiding you through the basics of keeping appropriate records for your
company using Quickbooks. It will help you with numerous things involved
in creating your company file in Quickbooks. Be it retail and E-commerce
business (eBay sellers, food trucks, coffee shops, etc.), appointment-based
business (doctor’s office, driving school, dentist’s office, etc.) or field
service and professional businesses.

Whether you’re a big business like Amazon or an up-and-coming
entrepreneur, QuickBooks is bound to increase the efficiency of your
working process. As you already know, QuickBooks is a business running
and accounting program. It allows you to handle a variety of different
aspects of running your business.

From accounting to data entry, QuickBooks brings efficiency to your
business process. No more hassling around with your accountant, no more
posting data entry jobs on Amazon to find good underpaid workers.

The guide will show you how to keep better track of your bills in
Quickbooks, as well as ensuring they are all paid on time. It will also help
you go through the tracking of your sales, creating sale receipts and



invoices for your customers. By regular and accurate updating of your
record keeping information in Quickbooks, you will find it easier to make
use of the multitude of financial reports that can be generated by
Quickbooks for the analysis and better management of your business
performance.

1. QuickBooks Online is a software that is easy to use and made for
small business accounting. It enables your business to track all your
expenses, income, and even your inventory. It can track your GST
in an instant and enables you to pay your business taxes. With
QuickBooks Online Accountant, you can find a new way of
managing your business, and you can change the way of your
accounting practice, consulting, or bookkeeping. QuickBooks
Online Accountant makes it a lot easier to work and to manage your
business.  It’s cloud-based software.

●        Secure –it is hosted by Intuit, and it is using a bank-level
security

●       Accessibility – You can access it anywhere and at all times.

●        Data entry automation – you are able to get data into
QuickBooks automatically with some awesome features

●        Unlimited Accountant Access – You are able to connect
with your accountant without any problems, and you can
stay connected as long as you want to

●        Mobile –You can access it by using Android devices or
iOS. There is no reason to sit at the desktop because you
can enter data whenever you want and wherever you are

●       No Desktop files – It does not require any desktop files, so
you won’t need any backup.



Seeing all of these features, it’s no surprise, so many businesses are relying
on digital technologies more. Compare QuickBooks to traditional
accounting. With traditional accounting, you’re almost completely at the
mercy of your accountant.

If your accountant makes a mistake, you’ll have a rather hard time
discovering it. On the other hand, QuickBooks lets you take the whole
process into your hands. It is intuitive and easy to use, you don’t need to go
through college to be qualified to use it; in fact, this book is all you need!

If your company is big, you might want to have an accountant handle it
anyways, but it also makes their job easier. QuickBooks is extremely easy
to use for accountants, and it comes with the additional benefit of being
really easy to check for errors. This means that if there’s an error, you’ll be
able to catch it quickly, possibly even before the payment is processed.

QuickBooks is also excellent for traveling entrepreneurs. You won’t always
have your PC or laptop with you, but QuickBooks will let you manage your
business straight from your smartphone. QuickBooks eliminates any and all
issues you might have had with the employees on your payroll.

QuickBooks also edges out against using on-site digital measures for your
accounting. If you’re using Excel sheets and Word documents, then you’re
at a high risk of being compromised. A simple fire or virus could end up
annihilating all of your files, incurring a devastating loss. QuickBooks is
cloud-based, meaning none of the files need to be stored on the devices
you’re using, so you’re at no risk of being hacked. In fact, QuickBooks’
security measures are at the level of an international bank.

With that being said, like with all advanced software, QuickBooks requires
some training to learn. That’s why this book is here; we’ll guide you step by
step through every nook and cranny of QuickBooks, making you an expert
in the next 150 pages!





Chapter 1
 



Setting Up QuickBooks

QuickBooks Online is easy to set up, and you are all set. You are able to set
up your business file in a bit less than 20 minutes, so it makes it really
simple. But, there are a few important steps to follow to make sure that you
are setting up business files efficiently and accurately.

The setup is optimized for speed and simplicity; however, it still requires
some instruction. We’ll dedicate this chapter to getting your QuickBooks
business account up and running.

When you reach the end of this chapter, you should be able to:

●       Set up a business file

●       Set up basic settings

●       Set up basic accounts

●       Importing a list information Company File Setup

There are some important steps you need to fulfill in order to set up the file
of your company. If you do that setup flawlessly, you really make it easier



for your accountant, bookkeeper and, of course, yourself to stay compliant
with taxes and GST., you or your business need to subscribe to the software
so you can use QuickBooks Online. Your business is also able to subscribe
if it visits intuit.com and signs up in order to get a free trial. Also, your
accountant is able to set up a file using the QuickBooks Online Accountant.

Company File Creation
First thing’s first: you need to create a company file, given that it’s a place
where you store all your company’s financial records. You can either start
from ground zero, by creating a new company file, or you can upload and
convert records from another small business program. For those of you who
are new to bookkeeping, there is always the option of using a file someone
else created. For instance, if you had help from an accountant to start up
your company, they might be able to help you once more by providing a
QuickBooks company file that is already customized for your business, and
in turn, give you a head start.

If you don’t have an accountant, worry not, we’ll guide you through setting
everything up, so you won’t ever need one. Luckily, QuickBooks is rather
simple to use, and setting up a business file isn’t exactly rocket science.

At the beginning of this chapter, we will explain how to start up your
QuickBooks. Further, if you are starting your company files from scratch,
we will guide you through the QuickBooks setup dialog box, as well as the
Easy Step Interview to get you running (and to see what chapters besides
this one help you to get the job done). On the other hand, if you are moving
from another program, we will try to make the transitional ride the least
bumpy. Furthermore, we will go through the opening of the company file,
updating it to the latest version of QuickBooks, and basic company info
modification.

●        Start with visiting the QuickBooks
site https://quickbooks.intuit.com, then signing in with your

https://quickbooks.intuit.com/
https://quickbooks.intuit.com/


QuickBooks Online account. Once the site is opened, select the
‘’Create New Company” option, which can also be found in the
“File” menu on the toolbar.

●        Choose the “Start Interview” option and begin answering the
interview questions.

●        Enter your company information: You aren’t required to fill in
anything except the company name, but for the purpose of saving
time and making things easier later on, you should fill in all the
required information.

●        Selecting your business industry should be the next step. By
selecting your business industry type, QuickBooks will customize
its settings to better accommodate the needs of your company.

●        Next, select your company organization type (sole proprietorship,
partnership, corporation, etc.). Correct selection of your company
organization type will furthermore facilitate tax preparation later on.

●        Select the first month of the annual accounting period. January is
the usual starting month of the annual accounting period, but this
can be modified to your company’s preference.

●       Set up the administrator’s password. This is especially important if
any other person except you has access to your computer or the
company file so that only you will be privy to the full QuickBooks
company file. Select “Next,” then specify where do you want the
company file to be saved



Customizing QuickBooks for Your Business
The QuickBooks Home page is laid out like the workflow you follow when
you’re bookkeeping, so it acts like a roadmap to many of the accounting
tasks you perform. Shortcuts to other helpful QuickBooks features are
sprinkled throughout the program’s left icon bar; top icon bar; and Vendor,
Customer, and Employee Centers. But your business isn’t like anyone
else’s. Let’s say you run a strictly cash-sales business. You couldn’t care
less about customer lists and invoices; making deposits, though, is a daily
event. Fortunately, you don’t have to accept QuickBooks’ initial take on
convenience. The Home page and the icon bars come stocked with a set of
popular shortcuts, but you can add, remove, rearrange, and otherwise edit
which features appear there. You can also add your favorite features,
windows, and reports to the Favorites menu. This chapter covers all your
options.

In addition to tweaking QuickBooks’ layout, you can also customize the
program’s forms. QuickBooks helps you get up and running with built-in
business form templates. They’ll do if you have to blast out some invoices.
But when you finally find a few spare minutes, you can create templates
that show the information you want, formatted the way you want, and laid
out to work with your letterhead. You can even create as many versions as
you want. For example, you can make one invoice template to print on your
letterhead and another for creating electronic invoices to the email that
includes your logo, company name, and address.



This chapter describes the most efficient ways to create forms: using
QuickBooks’ form designs or built-in templates as a basis for your own.)
Further down in this guide you can learn how to fine-tune forms with
advanced customization techniques and even create templates from scratch.

●        Further, answer the Easy Step Interview Questions to customize
Quickbooks for your company.

●        If your company deals only in selling products, select “Products
only.” If you provide services in addition to selling products, “Both
products and services” should be selected.

●       Specify whether or not you sell products and/or services online.

●       Select whether or not you charge sales tax.

●        If you provide custom work or other services for which you wish
QuickBooks to create estimates, select “Yes.”

●        If you take customer orders and want Quickbooks to track them,
select “Yes.”

●       If you wish to use sales receipts, select “Yes.”

●        If you would like to be able to send and create billing statements,
select “Yes.”

●        If you want to perform partial billing for payment, select “Yes” to
use progress invoicing.

●       Select “Yes” if you wish to keep track of the bills owed and receive
reminders for when they are due.

●        If you print checks or accept credit cards, select the appropriate
answer.

●       Select the preferred response for Inventory tracking.



●        Select “Yes” if your company has more employees. Also, if
tracking time spent on projects done by you or your employees,
select “Yes.”

●        If your businesses involve multiple currencies, select the
appropriate response.

●       Using accounts in QuickBooks: to set up your accounts you need to
know the date you would like to start from and how would you like
to organize your income and expenses.

●        Next, select a date to begin covering your finances. A reminder,
whatever date you choose, all business activity that has occurred
since that date must be entered. For this reason, it is simpler and
more effective to choose a more recent date from which to begin
tracking your finances with QuickBooks.

●        Enter the appropriate bank account information, including the last
bank statement ending date and balance

QuickBooks recommends a set of income and expense accounts based on
the industry selection you made earlier in the interview. However, you can
review these account selections and select or deselect any accounts to better
reflect your business. Modifications or additions to your accounts chart or
any part of the Easy Step Interview can be done at any time after the
creation of your company file.



Familiarizing yourself with the QuickBooks homepage
Because you’ve got more than enough work to do with the running of your
business, so you don’t want bookkeeping to take any more time than
necessary. QuickBooks’ left icon bar and top icon bar both offer shortcuts
to your favorite features. Each icon bar has its pros and cons, so you have to
decide which one you prefer (or you can turn them off completely). This
chapter shows you how to access QuickBooks’ features from the menu bar
and icon bars. During a rousing bookkeeping session, you might find
yourself with more than one QuickBooks window open simultaneously. In
this chapter, you learn how to work with all the windows you open. If you
prefer to focus on one task, you can tell QuickBooks to display only one
window at a time.

As its name implies, Supermax view supersizes a window for you to see
more info without scrolling. You’ll learn lots of window tricks in this
chapter. Another way to get your accounting done quickly and efficiently is
by accessing features via the QuickBooks Home page. The page not only
provides a visual roadmap of the bookkeeping tasks you perform regularly,
but it also gives you quick access to tasks and information related to
vendors, customers, and employees, along with the features and overall



financial info you use most often. Click an icon, and the corresponding
window or dialog box appears, such as Chart of Accounts, Item List, Write
Checks, or everyone’s favorite—Make Deposits. This chapter explains how
to use the workflow icons on the Home page, as well as the Vendor,
Customer, and Employees Centers that open when you click the
corresponding button on the Home page’s panels. You’ll also see how to
review your company’s finances in the Company Snapshot window

The QuickBooks homepage is divided into several groups that are well-
organized and connected with workflow arrows that will help you manage
and perform business tasks better, faster, and easier.

Vendors: The vendor area and the vendor center accessible you can find on
the toolbar can help you to track your purchases and enables you to
categorize your expenses.  You can pay and enter bills, edit and create a
vendor list and make an order of purchases for your business. The vendor
center gives you a complete picture of where your money is going. From
one screen, you can see all your vendors and exactly what you owe them.
Click on a vendor's name to view an entire history with that vendor. You no
longer need to run separate reports to see exactly how much business you
are doing with each individual vendor. Also, you can sort your bills by the
due date so that you can stay on top of your finances. If you need to talk to
a vendor, click on the vendor name to see all the contact information. If a
vendor calls you to follow up on a late payment, you can look up the bill
quickly and see the check number and when you paid for it.

Customers: The Customer area and center will help you to manage any and
all sales to customers. It also allows you to create estimates and invoices,
track accounts and create statements, as well as receiving payments and
creating sales receipts. The customer's center is a lens for all your customer
information. Without having to sift through multiple screens, you can view
a list of all your customers and see pertinent information for each of them.
Click on a customer's name, and you immediately see all the activity you



have had with them as well as their contact information (phone number, fax
number, and payment terms)

Employees: Indicating in your Easy Step Interview that you have
employees will cause an employee center to be created in order to better
and easier to manage your employees. The employees center lets you see
exactly what you are paying each employee. Click on an employee's name
to view that person's payroll history. If you need to get in touch with an
employee, their contact information is right in front of you.

Company: The Company area of the workflow diagram will allow you to
manage lists including your chart of accounts as well as items and service
lists.

Banking: The Banking area helps you to record any deposits and write and
print checks associated with any one of your bank accounts.

Answers in the Easy Step Interview make icons specified to appear on the
homepage. If you specified that you would like to make an estimate in
QuickBooks, an “Estimates” icon is going to appear in the Customers area,
or it won’t show otherwise. If you want to change some of the settings that
are created in the Easy Step Interview, you can do it by selecting Edit →
Preferences from the toolbar your company or personal preferences will be
changed for you at any desired time.

Setting up Customers, Vendors, and Jobs
Maybe you enjoy parading through your sales department trumpeting, “We
aren’t getting anywhere until someone sold something!” It is quite possible
for you to cite that maxim in your accounting department as well.

It doesn’t matter whether you sell products or provide services, bagging the
first sale with a new customer creates an avalanche of possible actions,
including, but not limited to making a new customer entry, creating a job
for the work and the much expected and desired goal that is invoicing



(delivering a bill for the service provided or goods sold, which states how
much the customer owes to you) your customer for the purpose of
collecting income. The parties to which you provide services or sell
products go by a myriad of names: shoppers, clients, consumers, members,
etc. In the QuickBooks dictionary, there is only one word that fits the
person, party, or group of people who buy goods or services from you, and
the word is the customer. In QuickBooks, a customer represents a
documentation of information concerning your in vivo customer.
Quickbooks uses the information you entered about your customers, and
with it completes sales forms as well as invoices with your client’s names,
payment terms, address, and other general information.

Real-world customers the key to your success, though are the customers in
QuickBooks really that necessary? In spite of you running a, let’s say,
primary cash business, cataloging your customers in Quickbooks isn’t such
a bad idea. For instance, creating QuickBooks records for the recurring
customers at your store cuts your time necessary to fill out their information
on each and every new sale by doing it automatically. Furthermore, if your
business is project-oriented, you can assign a job for each project you start
for a customer in QuickBooks. For QuickBooks, a project is each and every
job you signed (or was begged to sign) to perform for a customer—
repairing a yacht, creating a billboard ad, anything really. Let’s say you are
an electrician, and you do work for a general contractor on a regular basis.

You might set up several jobs, one for Setting Up Customers, Jobs, and
Vendors, for each place you do work at Scott estate, Hammond estate, and
Julliard estate. Then you can see and track expenses and income by job and
assess the profitability for each and every one. Although, if your business
doesn’t handle jobs, there is no need for you to set them up in QuickBooks.
For instance, record stores sell records, not services or projects. If your
business doesn’t do jobs, you can just create customers in QuickBooks and
simply continue to invoice them, or even filling out sales receipts for their



purchases. Although, before you begin receiving payments, you will need to
get busy with the vendors and pay up for their products and/or services. The
Internet service provider, your marketing manager, and the hardware store
that sells you the equipment all fall into the category of vendors.
Information required to be filled out isn’t that much different from that of
the customers.

Deeper into this guide, you will learn how to create customers, vendors, and
jobs in QuickBooks. You will also learn how to apply the program’s
customer, vendor, and job fields for your business. And you’ll learn how to
manage the customer, job, and vendor records you create in QuickBooks.

Creating Customers in QuickBooks
Unfortunately, your first task is to convince would-be customers to work
with your company. After you’ve worked around that obstacle, it’s clear
sailing to creating customers in QuickBooks. More than one way to create a
customer record is available in this:

1. Using QuickBooks Setup. After starting this app, you can easily use
the Setup dialogue box to get customer information, along with the
employee and vendor info. You can also get the info via email, or
simply paste it from Excel. If you want to input more records to this,
just go back to Setup.

2. One by one.  It is advisable to use the New Customer option when
you want to create customers. Unfortunately, sometimes you don’t
have the time to create them one by one, so it is also possible to do
in bulk without closing the tab.

Customers can also be inserted into the system in bulk.  The Add/Edit
Multiple List Entries are useful because they let you move data from any
Excel-like software and copy information from customers onto others. The
Customer Center is a gathering place for jobs and customers alike: viewing,



creation, and modification of the records, as well as transaction creation.
The Customer Center can be opened in four simple ways:

1. Pressing CTRL+J while the app is open

2. Pressing “Customers” in the header of the Customers tab of the
QuickBooks homepage.

3. Open the menu, press on Customers, then go to the Customer
Center.

4. The icon bar contains a “Customers” option, press there.

Now for a quick and easy method of creating a single customer in
QuickBooks:

1. Use the toolbar contained in the Customer Center to create a new
customer with their job.

2. In the Customer Name field, type a code or a unique name, followed
by the naming convention you’ve chosen. Everything else you can
ignore; this is the only field that is mandatory to fill in.

3. To archive the said customer’s record and exit the New Customer
window, select OK. To discard any entries and changes you made,
select Cancel.

To create a job for a customer, close the New Customer window and open
the New Job window. So, it’s a lot faster to create all your customers first
and then add the jobs for each one.  To help you find what you want to fill
out, the New Customer and Edit customer tabs are separated into sections.
Both the contact and the address info are found within the 1st section, the
Address info. Any fields that are related to payments can be found on the
Payment Setting tab. The next tab, Sales Tax Settings, can be completely
skipped in the case that your business doesn’t sell taxable goods. Next,
Additional Info tab, which used to be a jumble of different types of fields,



now has a couple of miscellaneous fields, like a sales rep, customer type,
and custom fields you’ve created. The following few sections will guide
you through each tab and its respective fields.

Contact Information Entering
In the case you intend to bill your customers, send them products, or to just
check in on them, you will need to have the address and contact
information. You can write this down in the New Customer’s Address info
tab. Quick advice on how to fill this tab:

Company Name - This is where you put a way for the program to refer to
the customer, be it a name or a nickname. Note, however, that the way you
call them here is how they’ll be referred to on invoices and other documents
you do via this app.  After you’re done QuickBooks will automatically
insert that name into the “Bill To” section.

Contact - This is the place where you enter the primary contact’s name, as
well as what you wish to refer to them with, for the purpose of addressing
letters, invoices and other communication between companies. Please note
that QuickBooks copies everything you entered here into Invoice/Bill To
field. This will also let you input the Job’s title.

Invoice/Bill To - This is where you’ll place the address you wish to show on
your invoices. If you want to change it, there’s an Edit button, as well as
other options which will help you specify your street, postal code, street
address, and other basic information. Naturally, QuickBooks also supports
copy-pasting this from anywhere else.

Ship To - If you won’t be shipping anything to your customer, then there’s
no need to fill this out. However, if you are shipping things, then first you’ll
need to check if the shipping and billing address are the same. If they are,
you’ll just need to press Copy, and you’re done with it. If they aren’t, you’ll
need to add the shipping address manually. 



Payment Information Input
The Payment Settings window is there to display how much you’re owed,
as well as how much you want to extend the customer’s credit. In these
fields, you’ll need to input the customer’s payment information such as:

Account Number. - In QuickBooks, account numbers are entirely optional.
Big accounting programs usually assign specific numbers to customer
records, which in turn speeds up the process of locating them. The
Customer Number field is an identifier, so you should probably keep it the
same as any of your other business apps.

Terms of Payment - This section belongs to the terms you and your
customer have agreed to follow. It is used by the program for both your
payment terms towards your customers, as well as the terms you’ve agreed
to with your vendors. This also includes the most used methods, which can
help if you’re just trying to get your business off the ground and don’t know
much about it. You can also define your own payment terms, which will
make it, so you don’t need to insert them every time you use QuickBooks to
send an invoice.

Preferred Delivery Method - You can choose from email, mail, or none to
establish a method of delivery of information that your customer prefers. If
you select E-mail, QuickBooks will automatically activate the email
checkbox whenever you create forms for this specific customer. The
Mailing method displays QuickBooks Billing Solutions, an add-on
QuickBooks service for mailing invoices, though additional billings may
apply. If you prefer to print out information, and then send it the old-
fashioned way, you should select None.

Preferred Payment Method - This allows you to choose the preferred
payment method of your customer. The drop-down list includes but is not
limited to the few most frequent methods, such as a check, cash, or credit
card, though you can add others if you desire so. The payment method



specified will appear automatically when you select this customer in any of
your future endeavors, useful for repeat clients. If a customer wants to pay
with a method different than the one you specified here, simply select said
method in the Receive Payments window.

Credit card information - Concerning credit card payments, you can specify
all relevant information such as the name on the card, billing address, postal
code, and the expiration that can all be specified. It should be brought to the
attention that you can only enter one credit card number for one customer.

Credit Limit - Here, you can specify the amount of credit you’re willing to
extend for the customer in question. If you do so, then QuickBooks will
warn you whenever an invoice or an order exceeds the amount of the credit
limit you specified, but it will not stop you from going through with the
order, that is entirely up to you. If you don’t intend to go through with the
credit limit, it might be best that you skip entering values in this field.

Price Level - Most businesses will have different price levels for different
customers. A good example of this is how not everyone pays the same for
airline tickets. QuickBooks will let you insert discounts and markups to
process for these transactions. You can have multiple pricing levels and
name them however you’d like. This will let you be much more organized
when it comes to giving out discounts or markups. Quickbooks also makes
it really easy to apply these for any purchases a given customer makes.

Add Online Payment Link to Invoices - Online payment links on invoices
allow customers to pay you through the Intuit Payment Network either by
making a payment directly from their bank accounts into yours or by credit
card. (The fees you pay for this service vary based on how the customers
pay). However, setting up this feature requires a couple of steps. First, be
sure to sign up for the Intuit Payment Network service. If you don’t sign up
and your customers click an online payment link, they’ll see a message
telling them that you haven’t signed up for the service yet. There’s a section



called Payment settings, which you can use to instruct QuickBooks which
online payment option to use for the customer. “Follow Company Default”
applies the setting that you selected in QuickBooks’ preferences. Choosing
“Always ON (bank only)” means the customer can pay only through a bank
account regardless of your company preference. With “Always ON (bank or
credit card),” the customer can pay by bank account or credit card. “Always
OFF for this customer” means QuickBooks doesn’t display the online
payment link on this customer’s invoices.

Sales Tax Information Specification
Now, the Sales Tax window will pop up regardless of whether you’ve turner
Quickbooks Sales Tax on or not, which can be a bit annoying to some users.
While that’s true, if you don’t have it turned on, it’ll be practically useless.
All of the fields in the window will be covered with a monotone grey,
signaling they aren’t to be used. Now if you do pay sales tax, you’ll want to
choose the Tax option in the Tax Code tab and pick the rate.

There’s also a variety of ways to customize your customers. The following
will show you the fields that can be filled in, and a few simple ways can be
used:

●        Customer Type. You can categorize the customers by type, which
can ease communication that is customized for each type, or to
determine which types pay off the most. After you’ve set up
customer types, you can categorize a customer by choosing from
this list; it will display the entries from your Customer Type List.

●        Rep. Adding a name in this field links a sales representative to a
customer, which can aid you with tracking of the results of the sales
reps. To make sure your customers receive the best customer
service, it is recommended to assign a customer service
representative to each and every customer, as to keep them in
constant communication with your company regarding all your



services. When you start creating a Rep entry, you can use the
existing names in the Vendor, Employee, or Other names list, or, if
you wish so, add a new name to use as a rep.

●       Custom Fields. QuickBooks provides up to 15 custom fields, which
you can be used to enter key information for which QuickBooks
doesn’t provide. Given that custom fields do not have a drop-down
list, all your entries need to be entered consistently.

Additional Customer Contact
While you’re making a customer file, you can determine information about
a single contact in the Address Info tab in the New Customer window. You
can specify which jobs those contacts perform. Furthermore, all of these
contacts are also editable, and you’re able to delete them as you see fit, this
is most useful in case the people you’ve got saved are in the process of or
have already changed their job.

After selecting a customer, you’ll get to see the contact information for
them, as well as have the option to simply add even more contacts to their
record. This can be accomplished by clicking on Manage Contacts in the
lower-right corner and selecting Add New. After that, all you need to do is
finish the infoboxes and whatever other additions you wanted to introduce.
When you’re done with it, simply click Save and Close and QuickBooks
will exit the window.

Job Creation in QuickBooks
If you are involved in project-based work, you are aware that every job has
a starting point and an ending one. Whether you build custom housing or
surveillance systems, QuickBooks’ job-tracking features can be used for
financial performance analysis by the project.

Let’s say you wish to know if you’re earning money on the suburban estate
building, or on the remodeling low-income estates, in addition to the



percentages pertaining to your success/fail ratio. If you use QuickBooks for
this, It’ll easily and smoothly estimate the financials around it; it’ll be
almost like having an accountant! Jobs and customers are inseparable from
each other in the program, so you’ll want to keep a close eye on both. A job
will always stay with a customer. Actually, if you tried doing your job
before you’ve finished creating a customer, a message box will pop out
notifying you that first, you need to make a simple customer file in order to
create a job. Thankfully there are two tabs for both creating and editing
customers; both contain tabs for the customer information, as well as job
information. So, effectively, whenever you create a customer, you
automatically create one job with it, although you can add more jobs later
on if it is necessary. The following section will show you how to do just
that.

New Job Creation
As it was mentioned before, in order to create a job, you must create a
customer first. When you are done with the creation of the customer,
complete these simple steps in order to add a job to a customer’s record:

●       Under the Customer Center’s Customers & Jobs tab, right-click the
customer for which you wish to create a job, next select Add Job in
the shortcut menu. As well, you can select the New Customer & Job
tab->New Job. In both cases, a New Job window will open.

●        In the Job Name box, enter a name for the desired job. Choose it
well, as it will appear on invoices and/or other customer documents.
Up to 41 characters can be typed in this box. Job name should be as
short and as descriptive as possible both for you and your customer.
QuickBooks will fill in the rest of the job fields using the
information you entered for the customer for which the job is
created. You will only need to manually edit the fields on the
Payment settings, Address Info, and Additional Info. Let’s say that
the address for the material shipping for the job differs from the



customer’s; you will then be required to fill out the corresponding
fields.

●       If you wish to provide further information about the position, select
the Job Info tab and enter values in the proper areas. If you’re
adding sorts of jobs, you are able to cross-reference these with other
jobs that share characteristics. This also doesn’t change based on
which customer gave you the position. If you input information in
the Job Status section, it’s going to give you a recap of exactly
what’s happening in the Customer Center. If deadlines are a concern
for you, you can estimate the dates for the job, and simply insert
those in the appropriate area.

●        Once you’re done with that, simply press OK, QuickBooks will
then save the job and close the window.

Vendor Setup
In order to make a new vendor entry through the Vendor Center, press
CTRL, and N at the same time. You can also do this through the menu bar.
However, the shortcut streamlines things. Now, most of the fields you will
find are quite similar to the customer creation field. This should make the
process quite a bit easier, for example, the Vendor Name and Customer
Name fields work the exact same way, making it a lot easier to navigate
through.  Similarly, QuickBooks advises leaving the Opening Balance field
without an entry, and instead of building the Vendor Balance by inputting
invoices and payments.  This can prove to be quite helpful, especially when
the vendor and the customer are the same people, just for different products.

Now, if you’re actually printing off your bills and all the sheets you need to
pay them, you’ll have to place some contact and address info here, so that
QuickBooks knows where to send them. These fields are quite obviously
quite similar to the corresponding customer fields; they are also filled the



exact same way, so once you’ve mastered that feel free to move onto
payments.

Setting Up Payments
Payments are in the Payment Settings section, and they, while rather easy to
fill, are also integral, so we’ll walk you through it, nonetheless.

●        The Account Number is pretty much the same as the customer
account number section. Naturally, in this case, it’s reversed, and
the vendors give your company a number, rather than vice-versa.
After the vendor gives you your number, you just need to input it
here. Obviously, you should keep this number secure and close to
you. This is because there’s a lot of malpractice that can be done
with it, and it serves as easy proof in case of trouble.

●       As with before, you’ll be selecting the payment terms under which
you and the vendor will operate. Once you’ve got a deal with your
vendor, simply input it here, quite similar to the customer settings.

●        Now when it comes to the way your name will be printed on the
checks, QuickBooks will auto-fill it with the info you already
entered. You can change it; however, it generally isn’t advised.

●       Again, same as the customer side, you want to input the credit limit.
This is the amount of credit that a vendor is willing to give you. You
simply input however much that is, and QuickBooks will notify you
every time you’re trying to get past this pre-set limit. This can be
quite useful as it lets you always keep your credit limit in mind.

●       The Billing Rate Level is again, same as the customer side of things
just reversed. If you have any kind of special discount with a
vendor, this will help you set it up. Instead of tediously going
through all your numbers and dropping them by say, 10%, you can
simply insert this in QuickBooks, and it’ll do it for you. It also
works for billing employees, so if you bill them by seniority, you
could have a category for every year they’ve worked and how much



of a raise they’ve accrued so far. This is one of the most underrated
capabilities of QuickBooks, and you’d do best to use it to the fullest

Setting up Sales Tax
In the Tax Settings tab, QuickBooks has two fields. They are as follows:

1. Vendor ID. You are only required to put in the vendor’s social
security number or the employer’s identification, EIN for short, if
you intend to do a 1099 form for the said vendor.

2. Vendor suitable for 1099 form. Mark this checkbox if you intend to
create 1099 for this vendor.

While writing a cheque, upcoming payments, or simply checking out the
changes in the vendor credit card, mark the account to which you want to
give the payment. The Vendor options, including creation and editing,
enable QuickBooks to know which accounts you usually use. The easiest
way to solve the hassle of expense accounts is to simply allow QuickBooks
to access the previous monetary transactions you’ve made. This way,
whenever you record a bill, credit card, change, or a check for someone,
QuickBooks will create a brand-new bill by using the total amount and the
accounts you selected on the previous transaction.

Additional Info
With all the New Vendor window’s tabs, the Additional Info tab is rather
sparse, which is probably why it’s the last tab in the list. Here are its fields
and what you can do with them:

●        To enable you to categorize vendors, QuickBooks has a useful
function called the Vendor Type, which will let you sort out
vendors. As an example, if you give all agencies you pay taxes to
the same tax type, you’ll be having a much easier time reporting
your taxes.



●       Now, if you’re trying to get to different information, you’ll have to
use the custom setting, which will let you set everything manually.
You are eligible to add seven more custom fields.





Chapter 2
 



Sales and Income Managing

Notifying your customers of the amount they owe you, as well as payment
deadlines, is an important step in accounting. After all, if money isn’t
flowing into your organization from outside sources, eventually you’ll close
up shop and close your QuickBooks company file for the last time.

Although businesses use several different sales forms to bill customers, the
invoice is the most popular, and, unsurprisingly, customer billing is often
called invoicing. This chapter begins by explaining the differences between
invoices, statements, and sales receipts—each of which is a way of billing
customers in QuickBooks—and when each is most appropriate. After that,
you’ll learn how to fill in invoice forms in QuickBooks, whether you’re
invoicing for services, products, or both. If you send invoices for the same
items to many of your customers (and don’t use the program’s multiple
currencies feature), QuickBooks’ batch invoice feature can help: You select
the customers, add the items you want on the invoices, and the program
creates all the invoices for you.

If you track billable hours and reimbursable expenses with QuickBooks,
you can also have the program chuck those charges into the invoices you
create.



Finally, you’ll find out how to handle a few special billing situations, like
creating invoices when the products you sell are on backorder. You’ll also
learn how to create estimates for jobs and then use them to generate
invoices as you perform the work. And, since you occasionally have to give
money back to customers (like when they return the lime-green polyester
leisure suits that suddenly went out of style), you'll learn how to assign a
credit to a customer’s account, which you can then deduct from an existing
invoice, refund by cutting a refund check, or apply to the customer’s  next
invoice.

Creating and Sending Invoices

An invoice is a form you use to charge customers for everything, ranging
from an app to a loaf of bread that they purchase from you. You may also
use an invoice in order to keep track of how much your customers owe you
when they don’t pay you. Invoices list everything you need to know about
the sale, the services you are offering and/or the products you want to sell
included. Invoices are also very handy because they can show the quantity
and rate of the price of any item to prices (for example, discounts or
markups), invoices will work for you.

●       Depending on which edition of QuickBooks you use, you have up
to three features for creating invoices:



●        Create Invoices can handle everything you throw at it: services,
products, billable time, and billable expenses. It’s available in
QuickBooks Pro and higher.

●       Create Batch Invoices lets you select all the customers to which you
want to send the same invoice (that is, the same items and the same
amounts). If you send the same invoice to the same customers all
the time, you can set up a billing group for those customers and,
from then on, simply choose the group. After you create the invoice,
you can print or email it to the customers in the list. This feature is
available in QuickBooks Pro and higher, as long as you don’t use
multiple currencies.

●        Invoice for Time & Expenses, available only in QuickBooks
Premier and Enterprise editions, can do everything that the Create
Invoices feature can do, but it’s a real time-saver when you invoice
for billable time and expenses. You specify a date range and
QuickBooks shows you all the customers who have billable time
and expenses during that period. When you choose a customer or
job and tell the program to create an invoice, it opens the Create
Invoices window, fills in the usual fields, and fills the invoice table
with the customer’s billable time and expenses. Once you’re in the
Create Invoices window, you can add any other items you want, like
products you sold or discounts you’re offering. This feature also lets
you create batch invoices for time and expenses.

●       Invoices inform your customers about every bit of information they
need to know about what they purchased and what they owe you. If
you created customers and jobs with settings such as payment
terms, tax items, and sales rep, as soon as you choose a customer
and job in the Create Invoices window’s Customer: Job field,
QuickBooks fills in many of the fields for you.



Receiving Payments

In between performing work, invoicing customers, and collecting payments,
you have to keep track of who owes you how much (known as Accounts
Receivable) and when the money is due. Sure, you can tack on finance
charges to light a fire under your customers’ accounting departments, but
such charges are rarely enough to make up for the time and effort you spend
collecting overdue payments. Far more preferable are customers who pay
on time without reminders, gentle or otherwise. Because companies need
money to keep things running, you’ll have to spend some time keeping
track of your Accounts Receivable and the payments that come in. In this
chapter, you’ll learn the ins and outs of tracking what customers owe,
receiving payments from them, and dinging them if they don’t pay on time.
You’ll get up to speed on Income Tracker, a handy dashboard that shows
estimates you’ve created, how much customers owe—both overdue and not
—and what’s been paid in the past 30 days. QuickBooks’ Collections
Center can highlight customers with overdue or almost-due invoices, gather
the info you need to collect what customers owe and make it easy to send
out reminders. In contrast to invoices, sales receipts are the simplest and
most immediate sales forms in QuickBooks. When your customers pay in
full at the time of the sale—at your retail store, for example—you can
create a sales receipt, so the customer has a record of the purchase and
payment. At the same time, QuickBooks will send the money that you’ve
gained straight into your account with almost any bank. (Sales receipts
work only when customers pay in full because that type of sales form can’t



handle previous customer payments and balances.) In this chapter, you’ll
learn how to create sales receipts for one sale at a time and to summarize a
day’s worth of merchandise.

When you receive money from a customer, you should record the
transaction and mark the invoice as paid. When you receive a payment, the
accounts receivable records are updated, and the payment is ready to be
deposited into an account.

1. To receive a payment:

2. Go to the Customers menu and click Receive Payments.

3. Fill in the top portion of the form, including the customer's name,
the payment amount, payment method, and the date on which the
payment was received.

4. Check the column to the left of the invoice to which you want to
apply for the payment. You might be asked to decide how to apply
the payment for one of the following scenarios:

5. The overpayment can become a credit or refund

6. Underpayment can be left as is or written off

7. The customer has unused credit to be applied

8. The customer has available discounts

9. Choose the appropriate selection, and you should see your choices
reflected in total amounts for selected invoices. If the customer has
a discount or available credits, you can choose how to apply them.

10. Click “Save & Close” or “Save & New” if you have more customer
payments to receive.



You can set a preference so that payments received either go to any account
you’ve set up for funds that haven’t been deposited automatically or
automatically get calculated and applied as you select invoices in the list.
To set this preference, go to the Edit menu, click Preferences, and then click
the Company Preferences tab in the Sales & Customers area

Creating and Sending Sales Receipts

A sales receipt is the form you use when you make a sale for which you
receive full payment at the time of the sale. Sales receipts can include
payments by cash, check, or credit card.

However, if your customer didn’t pay in full, it’s not unlikely that you want
to calculate taxes, record the sales, or print a receipt used for a sale. If you
do want to do these things, without any problems, you can create sales
receipt. Examples of businesses that commonly use sales receipts include
beauty salons, pet groomers, dry cleaners, and restaurants. If you need to
track how much a customer owes you or you do not receive full payment at
the time of the transaction, do not use a sales receipt. Instead, create an
invoice, as described previously in this chapter.

To enter a sales receipt:

1. Go to the Customers menu and click Enter Sales Receipts.



2. Fill in the top part of the form, including the Customer: Job, Date,
and Payment Method.

3. Click the Template drop-down arrow and then click the sales receipt
template you want to use.

4. In the bottom part of the form, enter the items purchased.

5. Save the transaction

You can also use a sales receipt to create a summary of sales income and
sales tax owed. You can summarize daily or weekly sales on a sales receipt.

Whenever you want, you are able to go to the customer center. On the
customer's list, you can see all your customers or the ones that have open
balances. You can do so by selecting from the drop-down box that is under
“Customers & Jobs.” You can see a list of every transaction of yours with
customers and invoices, deposits, sales, etc.  in the lower part of the
customer center. You are also able to select specific types of transactions
and specified time periods with the drop-down boxes that can be found
above the list of transactions and the list is going to be changed as you like
it.





Chapter 3
 



Bills and Expenses Managing

Although most small business owners sift through the daily mail looking for
envelopes containing checks, they usually find more containing bills. One
frustrating aspect of running a business is that you often have to pay for the
items you sell before you can invoice your customers for the goods.

If you want your financial records to be right, you have to tell QuickBooks
about the expenses you’ve incurred. And, if you want your vendors to leave
you alone, you have to pay the bills they send. Paying for expenses can take
several forms, but QuickBooks is up to the challenge. This chapter explains
your choices for paying bills (now or later) and describes how to enter bills
and record your bill payments. If you pay right away, you’ll learn how to
write checks, use a debit or credit card, and pay with cash in QuickBooks,
among other options. If you enter bills in QuickBooks for payment later,
you’ll learn what to do with the recurring ones, as well as reimbursable
expenses and inventory. QuickBooks is happy to help you through every
step of the process: entering bills you receive if you want to pay later,
setting up bill payments, and even printing checks you can mail to vendors.

When to Pay Expenses When it comes to handling expenses, you can pay
now or pay later; QuickBooks has features for both options. (You can
choose to not pay bills, but QuickBooks can’t help you with collection



agencies or represent your company in bankruptcy court.) Here are the pros
and cons of each approach:

●       Pay now. If bills arrive about as often as meteor showers, go ahead
and pay each one immediately, so you’re sure they’re paid on time.
In QuickBooks, paying right away means writing a check, entering
a debit card transaction, entering a credit card charge, making an
online payment, or using money from petty cash—all of which are
described in this chapter. When you pay immediately, you don’t
have to enter a bill in QuickBooks; you can simply record the
expense payment transaction.

●       Pay later. If bills arrive as steadily as orders at the local coffee shop,
you’ll probably want to set aside time to pay them all at once so it
doesn't interfere with delivering services or selling products. What’s
more, most companies don’t pay bills until just before they’re due
—unless there’s a good reason to (like an early payment discount).
Setting up vendor bills for later payment is known as using
Accounts Payable because you store the unpaid expenses in an
Accounts Payable account.

In QuickBooks, entering bills for later payment delivers all the advantages
of convenience and good cash management. You can tell the program when
you want to pay bills—for instance, to take advantage of an early payment
discount or the grace period that a vendor allows. Then you can go about
your business without distraction, knowing that QuickBooks will let you
know when bills are on deck for payment.

Creating And Sending Sales Receipts



Each time you set up a new area of QuickBooks, you should review all of
the company settings that are related to that area. Before you use Company
Settings, you should understand each type of revenue transactions and sales.
Estimate – is a non-posting transaction that enables you to give your
information to your customer on how much you think you will charge them.
It is some sort of a quote or a proposal Invoice – the sales transaction often
used if you want to enable the customer to pay on account if required

An invoice will make Accounts Receivable bigger and income Payment as
well. Income Payment is a transaction that is used in order to receive some
payment that is against an invoice. It will decrease Accounts Receivable
and, but it also increases a bank account or Undeposited Funds Sales
Receipt – – sale transaction that is used when a payment is received in a
time of sale. It can increase income, and it also increases a bank account,
and if not a bank account, then Undeposited Funds Credit Memos – they are
useful when a customer wants to negotiate for a lower price or if customers
want to return something.

This can enable a credit in Accounts Receivable, and it is often used in
order to invade future invoices Refund Receipts – they are used if a
customer wants to negotiate or return something, but, if a customer has a
refund receipt, you will refund payment of theirs. Delayed Charges and



Credits – you can find them in Essentials and Plus only, and it’s a non-
posting transaction that reflects some probable revenue increases or
decreases. They can show useful in future transactions.

Company Settings
You should click on the Gear icon in order to access the Company Settings.
You can find four tabs with the left - hand side to set specific preferences
like how you would want to use the company file. Sales also have their own
category, but you can also find some sales settings that are under the
Advanced Settings

Customize Sales Forms
So, the very first setting under the Sales tab enables you to change the sales
forms. This change is also applied to Invoices, Estimates, and Sales
Receipts. Feel free to find your style, uploading of your logo included.

This enables you to rename your sales forms, and also to identify which
areas you want to see in the Header section three custom areas included.
With the Columns tab, you can easily identify which columns you would
like to see and put them in any order you want.

The Footer tab enables you to add some custom message and some footer
on invoices in addition. With the More tab you can make more changes. Be
sure to check at billable time and expenses if you invoice with the time and
expenses in mind. If you invoice for time, you are able to include the
employee's name on the form if you want and some group activities by time
period or possibly type and have some groups added.

You are also able to show some account summary placed at the top of the
form. This can give you the balance forward, as well as invoice charges and
also the total due.  Sales form content - this enables you to have and options
like specified p invoice terms and delivery method you can change on a
sales form. You are also able to add additional line items or items like



discounts, shipping, or deposit area. If you changed the forms before, you
could also add three custom fields to the transactions.

That is turned on in the Sales form content. The fields should be set up here
or on the Customization page. But be sure to remember that here is where
you should be indicating in order to have your custom fields to be public,
internal, or both. Products and Services- you can identify whether you want
to show the Product/Service column on sales forms in order for the
dropdown list of the Products and Services List to be available. You can
also turn on the preference with tracking inventory. Inventory can only be
used in QuickBooks Online Plus. More sales settings - The Messages
setting enables you to create default email text if you are emailing sales
forms and a default message on the form alone. Online Delivery settings
relate to emailing forms of yours and that you want a customer to be able to
see. There is a variety of options for sending HTML, plain text, or even
using Online invoice.

There are also some preferences that are to be chosen by statements.
Advanced settings - Be sure to check under the Automation section in the
Advanced settings. Pre-fill forms are there to ask you if you want
QuickBooks to copy some information from your last transaction by using
the same customer as last time. When the preference is turned on to
instantly apply for credits, some of the available credits to the next invoice
will be applied by QuickBooks. Be sure to be careful with turning this
preference on. 

It could be that a customer does not want the credits of the next invoice to
be applied — but wants to apply the future invoice. There is also a
preference to have QuickBooks instantly invoice some unbilled activity.
When you turn this on, you are certain to have a notification in the
Activities feed received. If you wish to invoice from an estimate, you
should turn on the preference in order to copy estimates to invoices. Then,
you can only copy for accepted estimates or for pending and accepted



estimates. You should really know your customer and be sure that turning
on the Automation preferences is good for them. If your customer has
problems with Accounts Receivable, you should look these settings up.

Alternative Entry Points Used For Entering Sales Transactions

Customer Center
The Customer Center, can be accessed by selecting Customers located in
the left navigation bar, is used for adding, reviewing, and editing customers
that QuickBooks Online company does business with. The list of Customers
is able to be exported or printed, and it is also able to be filtered or sorted
by many parameters. Beside every Customer listing, you can find a drop-
down box from which you can create transactions like estimates or
invoices, you can also send a reminder of some balance owing, send a
statement or print. Also, batch actions are able to be performed for the
entire list: printing or sending statement or statements and sending an email
directly from QuickBooks Online. These emails could use your own choice
of email client or web –email. Entering Transactions from the Customer
Center

Step by Step: Creating an Estimate



You can find many ways to create an Estimate in QuickBooks Online. In
order to create an Estimate from the Customer Center, there are a few steps
you need to follow:

1. You should select Customers from the left navigation bar

2. If needed, select Clear Filter/View All above the Money Bar in
order to produce a full listing of Customers.

3. You should select the drop-down box that is in the far-right column
for the specified client -> Create Estimate.

4. Be sure to complete the on-screen estimate for the wanted client,
with the wanted date, Products and Services you chose, the
description, quantity and rate (override the rate if you want to) of
everyone, the sales tax. 5. Complete any other wanted area like the
Discount and the Message to the Customer.

5. Complete any other wanted area like the Discount and the Message
to the Customer.

6. You select Save and close or (with click on the drop-down box that
is next to Save and Close) you select Save and New.

Step by Step: How to Create an Invoice from an Estimate

In order to create an Invoice from the Estimate you’ve created, the simplest
way to find that Estimate is to do that from the Money Bar in the Customer
Center.



1. You should select Customers that is on the left navigation bar.

2. You click on the Estimates rectangle found at the far-left section of
the Money Bar

3. You locate Cool Cars; you created that Estimate for and then you
click on 1 open estimate.

4. You will see the Transactions listing that should appear, then find
the estimate that you would like to turn into an invoice, after that
you should select Start invoice located the far right.

5. Now you make changes to the already-populated invoice as wanted.

6. You select Save and close, or you can also select Save and New.

Reminder: If you are not willing to invoice for the whole of the estimate,
you are able to change line items or the number on the invoice. Even so,
QuickBooks still consider estimate fully invoiced. There is no progressing
with invoicing in QuickBooks Online.

Step by Step: How to Create an Invoice for Unbilled Activity
You are also able to simply create invoices for any one of unbilled
activities.

1. You can select Customers from the left navigation bar.

2. You should click on the Unbilled Activity rectangle located in the
left part of the Money Bar. (It will create a list of an unbilled
activity.)

3. Remember that you can check a list of unbilled activity and that you
can click on Start Invoice from here or just click to see that unbilled
activity. You should click on Unbilled activity for the client for
whom you wanted to check the unbilled activity.



4. You click on Start Invoice.

5. Reminder: If there are multiple activities listed, you are able to
create a separate invoice for every activity. If you wish to create just
one invoice for every unbilled activity, you should do it from the
Customer Center alone.

6. You add any charges, a discount of sales tax, and then Save and
close.

7. Now you enter the Transactions from the Sales Transactions page
that is in the Sales Center

Step by Step: How to Create an Invoice
1. You click on the Sales under Transactions located on a navigation

bar

2. Then this will open either the Sales Transactions or Sales Center.
You can find the next steps that are suggested under the Actions
column. You are able to filter the Money Bar there with the exact
same way as in the Customer Center. Also, you are able to create
New Transactions at the top right of the screen. You click on
Invoice

3. Now you create a new invoice for the wanted client. Now when you
entered the client's name, QuickBooks will open a drawer located
on the right side that will show you time or expense activities, those
that are marked Billable. Also, you are able to simply add them to
the invoice. Now, the difference between creating the invoice from
the Action column and from here for that client or activity is that, if
you chose here, you are able to make a choice of what will be added
where, but if you make an invoice from the Action column it
instantly puts the unbilled activity on the invoice. 



4. You should invoice for the installation only with clicking on Add
and then Save & Close.

5. This will bring you back to the list of Sales Transactions. You
should clear the filter so that you will be able to check all the
transactions. Remember that this is sorted by date, and also, you can
sort by every column header when you click on the header. It might
happen you can’t see the columns you need, then you should click
on the Gear icon and after that, choose the columns that you want to
be displayed. 

Step by Step: How to Receive Payment
1. Now you need to receive payment. If someone sends you a check

payment, you should click on Receive Payment located next to the
client’s name.

2. Now, A listing of Outstanding Transactions will show up, but with
the invoice checked. Now you are able to deposit to Undeposited
Funds, or you can deposit into a bank account directly. If you have
signed up for QuickBooks Payments, then you might process a
credit card right here. The guide will help you learn more about
payment. You can choose Undeposited Funds, and then you Save
and Close.

3. You need to know that, from the Sales Transactions page, you are
able to enter transactions that are based on the listed transaction or
you can make new sales transactions located at the top of the page.

4. About entering Transactions from the Quick Create.

5. You can have the expanded look of Quick Create opened; then you
are able to check a list of sales type transactions located under the
Customers column.



Step by Step: How to Enter Delayed Charge
1. You can click on the Delayed Charge. Remember that a delayed

charge is a non-posting transaction. Be sure to remember what you
are telling QuickBooks is that it’s necessary for you to invoice a
client for something, and you do not want to invoice for it at the
moment. If you are a hypothetically a landscaping service, so you
are doing gardening for a number of clients. Every time you record
where you gave a service that day even so you only invoice once a
month. You are able to record every activity you want in
QuickBooks as a Delayed Charge and at month end easily create an
invoice.

2. Enter the desired customer’s name. Now in the date area, you
should type W in order to go to the weeks’ beginning. You should
also enter the wanted service right under the Product and Service
column. Now, you enter 4 under the number columns, after that you
enter $35 under the rate column. Then, you click on Save and New 

3. After that, you enter the client’s name, after that in the date area,
you should type K and +. Typing K will bring you to this weeks’
end, and the plus key will advance a day which will bring you to the
next weeks’ beginning. After that, you enter the service that is under
the Product and Service column. Then you enter 3 right under the
quantity columns, after that you enter $35 under the rate column.
Now, you click on Save and Close.

Step by Step: How to Create an Invoice from Quick Create
1. You should choose Invoice from Quick Create.

2. Now you enter the client’s name. Right after you enter the client’s
name, if there happen to be an unbilled time or unbilled charges,
then a drawer will open on the right side so you can simply add
those to the invoice. 



3. Now, you click on Add all and then Save and Close. 

Step by Step: How to Recur Transactions
If you are not willing to have an obligation to enter monthly recurring it
makes it even better, then you just need to have QuickBooks to instantly
create an invoice and then email it to your clients. Now you use the
Recurring Transactions feature. Remember that most transactions (journal
entries, sales, and purchases) may be made recurring.

1. Now, from Quick Create, you should click Invoice. 

2. You type in the wanted client’s name and then choose the service
under Product/Service. Then you leave the quantity at 1, and you
leave the rate at $35.00. Look at the bottom of the screen and click
on Make recurring.

3. It should open a screen where you should be able to create a
recurring invoice template. Now you could name the template,
choose if you want it to be automatically entered, if you want it to
automatically send an email, if scheduled, you set up the schedule.

4. Remember that you have a lot of choices if you want to create a
template. You can experiment with it in your sample file. Remember
that if you have a transaction that is already recorded and you want
to make it recur, you can open it up and then click on Make
recurring located at the bottom of the screen. Note that most
transactions are possible to be made recurring also.

Step by Step: How to Recur Transaction List
1. If you want to see a list of recurring transactions, you click on the

Gear icon and then open Recurring Transactions under lists.

2. You can add new templates from here, and edit a template that
already exists, you use or delete it.



3. Expense and Purchase Transaction

4. When the new area of QuickBooks is set up, you should review the
settings of the company that is related to that field. Now, before you
check the Company Settings, you should make sure that you can
understand the types of expenses as well as purchase transactions.

5. Bill – If there is a transaction that you entered when you receive a
bill from a vendor even though you are not willing to pay it until
some other time. You can find this in Essentials and Plus only
Expense – it’s a way to enter money, credit card purchases or checks

6. Checks – it’s a way to enter transactions that will make your bank
account reduced. If payment is a check, you are able to print it.

7. Bill Payment – those transactions are used to pay for the bills that
are entered. It is only available in Essentials and Plus.

8. Purchase Order – you can use a purchase to tell a vendor you want
services or goods. It’s only available in Plus.

9. Vendor Credit – you can enter a vendor credit in order to record
return from a vendor or refund. It’s only available in Essentials and
Plus

10. Credit Card Credit – These transactions record a credit card refund

11. Some of these transactions could be launched from many of access
point even though others don’t have that variety.

12. Determine Appropriate Expense-Related Settings

13. Company Settings

14. You can click on the Gear icon so you can access the Company
Settings. You’ll find four tabs along the left side. Then you set the
preferences depending on how you want to use your company file.



Note that expenses have their own category, even though under the
Advanced Settings there are also some expense settings.

You can also turn in using Purchase Orders here. If you check under
the Advanced tab, you will find the same types of automation
options that we saw with clients. Would you like QBs to
automatically make it able for your bill payments to apply? You
should think about it before you turn it on. It’s a good idea to turn
on bill warnings and checks that are duplicate under the
Miscellaneous sections.

15. Alternative Entry Points used to Enter Purchasing Transactions are
something you should be able to recognize.

Vendor Center
So, the Vendor Center can be accessed if you select Vendors in the left
navigation bar, which is used for editing, reviewing, and adding vendors.
The list of Vendors is able to be printed or exported, filtered, and can also
be sorted by many parameters. There is an Action column which has a drop
- down box which can be used to make transactions like vendor inactive or
checks or bills beside every Vendor. Also, you are able to email vendors in
batch with the Batch Actions drop-down list. This enables your emails to
use any choice of your email client or web-based email.

Step by Step: How to Create a Bill
1. You select wanted Create bill for a customer you want in the Action

list. Remember:  You can either post to an account directly or just
use some item on the Products and Services List.

2. Now, under Account details, you should enter Advertising for
$2,500.

3. Use the keyboard shortcut Ctrl + Alt + S to save.



4. Enter a second bill for another desired customer for, let’s say, Meals
and Entertainment, $250.00 and Save and Close.

5. If you use a keyboard shortcut, QuickBooks will save the
transactions and assume that you want to enter a transaction of the
same type as that one. Even does, it does not assume you want to
save your vendor, which means you should enter a new customer for
the vendor. The Vendor Center will show two open bills for the
wanted customer.

Step by Step: How to Pay Bills

1. You should click Make Payment option located next to the name of
the customer. You can find this option in the Action column.
QuickBooks will open the Bill Payment screen, and you will see the
list of bills as well as a check that is marked for you so you can pay
it. Look at the top of the screen; you are able to choose to pay via
credit card or bank account.

2. You can find Save and Close at the bottom of the screen. 



3. You can get a list of transactions or drill down on the name of the
vendor with the Customer Center.

4. Go to Entering Transactions and then Expenses

5. It’s mentioned earlier in this guide when you click on Expenses that
are under Transactions located on the Navigation bar, you will get a
list of the last year of transactions. You can filter this screen for the
view to be modified. You are also able to drill down on the desired
transaction. You might print checks or enter a new transaction 

Step by Step: Entering Expense Type of Transaction

1. You should choose Expense on the New Transaction drop-down
menu. In order to recap what was said in this guide, with Expense
type of transaction, you can increase a credit card’s payable for
company’s purchases or reduce your bank account. It’s a fine type
of transaction for “shoebox” customers. 

2. You enter an expense for the wanted vendor. It is paid with a
Mastercard for Dues & Subscriptions, and payment is $10.

3. Now you click Save and New at the bottom of your screen.



4. You should enter a transaction for one of your vendors. It’s paid
$100 for Commissions and Fees. Now, Save and Close.

5. Both expenses will show up at the bottom of the Transactions page,
even though one affected a credit card account and the other on the
bank account. Use the Check feature if you entered every check. 

Step by Step: How to Pay Multiple Bills
1. You already learned how to pay a single bill. The bill you paid with

the Vendor Center can be paid from the Expense Transaction page
too. When you want to play more bills at the time, choose Pay Bills
option from Quick Create.

2. Now you choose the Pay Bills option from Quick create.

3. Now you select Checking like the Payment Account.

4. After that, you select which bills you want to pay, and then enter the
payment method and a payment date Printed Check.

5. Remember that located in the upper right corner; you are able to list
the bills however you want them. Now you click on Pay Bills.

6. QuickBooks is going to give you print the checks option and listed
paid bills if you’ve clicked on Pay and Print. Step by Step: How to
Create a Check

Step by Step: Create a Check (write a check to pay a bill)
1. Click on Quick Create and choose Check.

2. Enter the vendor: for instance, Drawer will pop up on the right side,
and it will allow you to add the bill into the check when you enter a
vendor name and bill related to its name is big. Effect of the
accounting is to decrease Accounts Payable and decrease the bank



account. It will help clients prevent mistakes like writing a check for
some bill that already entered.

3. In order to add the bill to the check, you should click Add. It will
change the type of transaction from Check to the Bill Payment. Now
you save and Close.

4. Enter the item details or the account if you didn’t pay a big bill with
this check.

Step by Step: How to Print Checks in Batch
1. You choose Print Checks by clicking on Quick Create

2. You would like to see if your cheques are lined up before you print
them.

3. Preview and Print once you choose which ones to print. Make sure
you starting check is correct before you do that.

4. Now you go to Transactions -> Banking

5. You can link your credit card and bank accounts to QuickBooks by
using The Banking Center. After QuickBooks will automatically
download transactions, but you are able to even download manually
with a click on the right corner on Update option.

Step by Step: How to Use the Banking Center
1. Click on Banking under Transactions located on the Navigation bar

2. You can see at the top of the screen, that your linked accounts are
shown together with the downloaded transactions that should be
matched or entered. You are able to click on Update option so you
can import the last transaction, even though they’re downloaded
nightly.



3. You can import OFX, QBO, CSV or QFX files that are formatted If
your bank account can’t connect to QuickBooks. By clicking on the
icon that is next of Update icon, you are enabled to add. You can
also manage and create rules with an option under the Update icon.
But first, make sure to understand other parts of the Banking. Also,
in Excluded and QuickBooks, you can find tabs meant for New
Transactions located in the middle.

4. New transactions – Those are transactions that are just downloaded.
Be sure to act to them.

5. In QuickBooks – Transactions that added or matched from the New
Transactions tab. There is not even one in the sample file, but once
you used the Banking Center in some live file, there will be a list of
lot transactions.

6. Excluded – Downloads you don’t want in QuickBooks because they
have already reconciled and entered. They are not likely to be a
match.

7. At the next part of the page, you will see a list of downloaded
transactions. You should show All transactions that are downloaded
and remember it’s not unlikely to see a tab of Recognized
transactions. Transactions like this could be matched, or
QuickBooks assumed basted of earlier rules and transactions. There
are a Gear and a Printer icon on the right. You can have listed
transactions printed.

8. Now you click on the Gear icon. Set as many rows as you want as
well as columns you would like to see.

9. After that, you click on Copy Description. It will enable
QuickBooks to automatically copy the transactions of the bank into
the Memo field. You can see the Memo field on reports. You can



find it useful for troubleshooting entries. Before you add it to
QuickBooks, you can edit the memo. You will see that in the match
or category list, several transactions are matched by QuickBooks.

10. Then you click on the column header Match or Category

11. Match will be found by QuickBooks automatically. It could be
against payments from the client, check, bill payment deposits, and
more. Be sure to know that you can match each of them
individually if you click on match located at the action list. So, if
you want to have several transactions entered at the moment, you
should first select the first one you will enter and then just hold your
shift key while clicking the last transaction, then on batch actions
click the down arrow key and then accept everything that is
selected. It will match a transaction that’s entered on QuickBooks
already, with the downloaded transaction.

12. Click for the Hicks Hardware on the selection box. Then you hold
the shift key, and for Hall Properties, you click on the selection box.
All transactions between Hall Properties and Hicks Hardware will
be selected by holding down your Shift key

13. Now you choose Accept Selected option that is listed on the Batch
Actions drop-down list. Move transactions from New Transactions
to the In QuickBooks.

14. Now you click on the heather of the column for Description on the
New Transactions. You can find two expense transactions that are
for A Rental. The account to use and the vendor name are still
unknown to QuickBooks.

15. Now you click on the header of the column for Description on the
New Transactions. You can find two expense transactions that are



for A Rental. The account to use and the vendor name are still
unknown to QuickBooks.

16. As a posting account, choose Equipment Rental. When you do so,
QuickBooks will guess that you want the second transaction so A
Rental could use the A Rental vendor so it can post it to Equipment
Rental. Each transaction can be added individually or, under Batch
Actions, and then by clicking on the selection boxes, you should
choose Accept Selected option as. By clicking Split, you can split
the transaction.

17. In the middle of the page, there is a question, so be sure to locate
the vendor. Remember that This transaction can’t be posted by
QuickBooks.

18. Choose Manage Rules by clicking on the Update drop

19. Then you click on New rule option.

20. Now, in the Description area as the rule name, enter the desired
vendor.

21. Vendor should be selected as the Payee and Supplies and then as the
Category. Be sure to do that right

22. Now you click the Save option.

23. Then you click on Bank and Credit Cards option.

Some complex rules can be created like this. Hypothetically if the vendor is
any less than $500, then post to Supplies. You can make some other rule
where the vendor is more than $500 and post it to Equipment. The rules for
splits can also be created. If a vendor’s transactions are split 40% Telephone
and 60% to the Internet. You could see three radio buttons by clicking on a
transaction that’s in the Banking Center.



Change the radio button to Find, If you think there should be a match. If
your transaction can’t be found, it’s probably reconciled in QBs. Check the
box and Batch Actions and choose to Exclude selected option if you don’t
want it to be reconciled in QBs. If the transaction is a transfer between
accounts of two companies, be sure to use the Transfer button to indicate.

Use the Quick Create Menu to Identify Additional Transactions
With the Quick create, you can access some other types of transactions.
Time tracking is a case where a transaction can be accessed only via Quick
Create function. It can also be tracked by the Weekly Timesheet function or
the Single Time Activity function. Even if you aren’t signed up for
QuickBooks Online Payroll, you will still be able to use this feature.

Step by Step: How to Fill out a Single Time Activity
1. You select Quick Create (+) that is on top of the QuickBooks Online

window.

2. You select Show More if necessary.

3. Select Single Time Activity that is under Employees.

4. Now you enter the name of the Vendor or Employee whose time
you want to track.

5. Now you Enter the date for the time that is being tracked. 6. Now
you enter the Customer for whose time you track

6. You should enter the Service that is being rendered during the
chosen time.

7. Check the billing rate and if the time is billable, but only if Billable
preference is turned on.

8. Be sure to enter the time tracked HH:MM format.

9. Now you enter a description of the finished work.



10. You select Save and New or select Save and Close.

Step by Step: How to Fill out a Weekly Timesheet
1. At the top of the window of the QuickBooks Online, select Quick

Create

2. Select Show More if you need to.

3. Select the Weekly Timesheet located under.

4. Now you enter the name of the Vendor or Employee whose time
you want to track.

5. You should the work week for which the time Employee or Vendor
are tracked.

6. Enter the Customer for his own tracked in each row of the Weekly
Timesheet You can also enter the Taxable status and the Bill rate if
you want to.

7. . Now you select either Save and New or Save and Close.

Step by Step: How to Make a Bank Deposit
1. At the window of the QuickBooks online, select Quick Create

2. You can select Show More if necessary.

3. Then you select Bank Deposit that is under the Other.

4. Choose which bank account you are going to use for the deposit.

5. Fill in the date.

6. On the Top part of the screen, some monies in Undeposited Fund
might show up.

7. If they are part of the deposit, select the Existing Payments.



8. Add some other payments that are received, In the Add New
Deposits area.

9. By clicking in the posting account, only If you are taking cash back
from the deposit.

10. Click on either Save and New or Save and Close.

11. Using Summary only or preprinted deposit slips, you can print a
Deposit Slip and Summary.

12. You are able to write a check for some expenses you are tracking
using QuickBooks expense accounts. If you are using purchase
orders or inventory, you can also write checks for inventory part
items as well.

13. You want to write a check:

14. Click Write Checks in Banking.

15. You can the account you want to write a check from while holding
down arrow key after you clicked the Bank. In case the vendor is
not already set-up in QuickBooks, QuickBooks is going to ask you
to add the new vendor. In case the vendor was added to the vendor’s
list previously, that vendor’s check address will be filled
automatically by QuickBooks.

16. You should fill in the on-screen check same as you would fill a
paper check.

17. Using the Expenses tab, you should itemize your expenses.

18. Enter the items that are on the Items tab if you are purchasing them
for your inventory.

19. Click Save and New or Saved and Close when you are finished
entering all the information. If you want to see checks that are



already written use the Previous and Next navigation buttons

20. To find and print a single check:

21. Load the blank check form into the printer.

22. Go to the Banking menu and click Write Checks.

23. Click the Find button and search for the check you want to print.

24. Double-click to view the check you want to print.

25. Click Print.

26. In the Print Checks window, choose the options you want and click
Print.

Entering Bills
At first glance, entering bills in QuickBooks and then paying them later
might seem like more work than just writing checks. But as you’ll learn in
this chapter, there are several advantages to entering bills in QuickBooks,
and the program makes it incredibly easy to pay them

You are advised to enter bills immediately upon receiving them and paying
them afterward. Use the Enter Bills window for entering of bills upon
receival. Then use the Pay Bills window for payment of the bills. You can
set up QuickBooks to remind you to pay bills when they are due to be paid.
Using this method, you keep your money in your business for as long as
possible. You might still use a check to pay the bill, but this method enables
you to track the quantity of the money you owe. And at any time, you can
run reports to analyze unpaid bills for information such as to which vendors
you owe money. Do not simply write a check in the Write Checks window
to pay bills that you entered in the accounts payable register or the Enter
Bills window. Use the Pay Bills window to pay these bills.



●        On your homepage, you can find an Enter Bills icon and click it.
You will see the window of the Enter Bills opening in order to
record your bill.

●        Be sure to enter the information in the Bill template like date,
amount due, the bill due date and vendor.

●       You are able to associate the bill with asked items or your expense
account; it’s the same as with writing checks. By using drop-down
box, you are able to select the item or the account You can create
items or an account when you select Add New and add new item or
account

●        Click Save and New or Save and close when you entered every
information needed. You can select Edit → preferences from the
toolbar.

●        If you want to be reminded about your bills, Then you choose
Reminders from the left list, and then you select the Company
Preferences tab.

●        Feel free to change the settings of your reminder like the time
frame that is used for the reminder

Paying Bills



Entering bills in QuickBooks isn’t the same as paying bills. The bills you
enter in your company file are a record of what you owe and when, but they
do nothing to send money to your vendors. Pay Bills is the QuickBooks
feature that actually pushes your money out the door. It lets you select the
bills you want to pay, how much to pay on each one, as well as the payment
method, account, and date. If you have credits or early payment discounts,
you can include those, too.

●       On your homepage, you should click on the Pat Bills icon.

●        You will see every listed entered bill of your when the Pay Bills
window pops up.

●        Then you select one or more bills you want to pay, the method of
payment, the account you are using to pay bill/bills and the
payment.

●       You can print checks, or you might want to show the check number
of some written check of your if you pay with a check.

●       QuickBooks is going to make sure to decrease the amount of your
account that is used for checking by the amount of 17 paid bills.

●        QuickBooks is also going to increase the amount on your credit
card account, same as the paid bills if you paid with a credit card.

●        QuickBooks is going to automatically adjust the needed accounts
and write a check (only if you used your method of payment to be
check) if you click Pay Selected Bills

●        Click “Pay Selected Bills,” and QuickBooks will automatically
write a check (if you selected check as your method of payment)
and adjust the associated accounts to reflect the bill payment.

●       You are not required to go through the Pay Bills window to be able
to pay them. You can enter checks, credit card payments, and cash
expenditures directly in the appropriate registry. Though, if you
enter bills via the enter bills window, or the accounts payable



register, you are required to use the pay bills window for your bill
payment. Do not use the Write Checks window to pay a bill that
you have entered with either of these methods.

At the left side of the vendor center, you can check every one of your
vendors, and it’s always very easy to access. You can also choose to view
your vendors, individually or all of them by selecting in Vendors. Vendors
will be listed for you, so it’s very simple to use.

If you synchronize your QuickBooks bank accounts with your bank
accounts in real life, you make it possible to download your transactions
and your bank balances in QuickBooks company file that you have , which
is great because you will always know and can always check the state of
your wallet. So, you can update your QuickBooks accounts quickly, be sure
you are not giving any checks and you can always check your balance. This
banking online is possibly the future, and everyone must agree that it’s a lot
better since it’s able and it’s very convenient, and it enables you to manage
your cash flow at any time. You can always know exactly how much you
have all the time, so it also makes it a lot easier to track if someone is using
your money even though they don’t have your approval. You are also not
very likely to lose your money like this, so you can feel safe. Remember
that you are able to transfer any amount between your checking account and
account of your money market. Because of online banking, you don’t have
to do boring stuff like walk to the mailbox, write checks, lick stamps, etc.
You can also access it from anywhere, and you can run some of your
errands while being online like paying your bills for example. When you
submit payment transactions online, you need to know that the billing
service that is used will transfers funds





Chapter 4
 



Banking Transactions Managing

By synchronizing your real-world bank accounts with the bank accounts in
QuickBooks, you can download your bank balances and transactions into
your QuickBooks company file, so you’ll always be able to know the state
of your wallet. (The connection you set up between the two is called bank
feeds in QuickBooks, to differentiate it from online banking that you
perform by logging into your bank account outside of QuickBooks.) That
way, before repaying your aunt the start-up money she lent you, you can
quickly update your QuickBooks accounts, check your balance, and be
certain that you aren’t giving her a check that bounces.

Besides managing your cash flow, banking online is much more convenient
than the old paper-based methods of yesteryear. For example, you already
have a lot of transactions in your QuickBooks account register (from
receiving payments against invoices or making payments to your vendors)
and you can easily match these transactions to the ones you download from
the bank, so you know how much money you really have in your account—
and whether someone is helping themselves to your money without
permission. Plus, you can transfer money between your money market
account and your checking account when you find yourself awake at 2 a.m.

Banking online also lets you pay bills without having to write checks, lick
stamps, or walk to the mailbox. After you submit payment transactions
online, the billing service you use either transfers funds from your bank
account to the vendors or generates and mails paper checks. Online billing
also lets you set up recurring bills so you can go about your business
without worrying about missing a payment. All this convenience requires
some setup. QuickBooks needs to know how to connect to your bank, and
your bank needs to know that you want to use its online services. This



chapter explains how to apply for online services with your financial
institution and set up bank feeds in QuickBooks to perform all these tasks.
Once your accounts and bank feeds are set up and online services activated,
you’ll learn what you need to know about taking transactions through the
internet, as well as online payments. And if you enter transactions in your
company file, you’ll also learn about matching them with the ones you
download—and correcting any discrepancies.

Banking Accounts Linking
QuickBooks can zip you through the two basic ways of producing and
distributing invoices and other forms: on paper and electronically. Within
those two camps, you can choose to produce and send forms as soon as you
complete them or place them in a queue to process in batches. For sporadic
forms, it’s easier to print or email them as you go. But when you generate
dozens or even hundreds of sales orders, invoices, statements, or checks,
printing and emailing batches is a much better use of your time. If you have
workhorse transactions that you enter again and again, QuickBooks can
memorize them and then fill in most, if not all, of the fields in future
transactions for you. For transactions that happen on a regular schedule—
like monthly customer invoices or vendor bills—the program can remind
you when it’s time to record the transaction, or even add the transaction
without any help from you. You can also memorize transactions that you
use occasionally, such as estimates, and call on them only when you need
them. QuickBooks’ search features can help you track down financial info,
which you can appreciate if you’ve ever hunted frantically for a transaction.
Whether you want to correct a billing problem on a customer’s invoice,
check whether you paid a vendor’s bill, or look for the item you want to add
to an estimate, QuickBooks gives you several ways to search. You can look
for different types of transactions within various date ranges in the
Customer, Vendor, and Employee Centers—and the Inventory Center, if
you use QuickBooks Premier or Enterprise. The Item List window sports a
few search boxes for finding the items you want. Form windows, such as



Create Invoices, have a Find button on their Main tabs so you can quickly
find transactions of the corresponding type. You can use the program’s
Search feature to search throughout your company file or QuickBooks. And
the full-blown Find feature is perfect for surgical searches.

The first step is to click Connect account on the Dashboard under the Bank
Accounts menu. First, select your bank and after providing your
information, press Sign in. After you connect, you will be able to see all of
the accounts you have at this bank. You then register what kind of account
the account you use for your business is. QuickBooks will provide you with
all of the information regarding transactions in the past 90 days, but these
transactions are not in QuickBooks yet.  After the first download, you will
have to arrange and review your expenses on your own. The Category and
Match buttons are there to help you manage your transactions. QuickBooks
will provide you with information on where it tried to find categories. To
learn more about a transaction, select it from the list. You can change the
category of the transaction through the transaction menu. Then click Add to
save the transaction. You will be provided with a summarization of how
your business is doing on the dashboard. To learn more about how your
expenses are categorized and how you spend money, there are report
functions such as Profit and Loss.

Importing, Matching and Adding of Transactions
One of the many benefits QuickBooks provides you with is the fact that it
saves you a lot of time that you would usually waste on manual input of
each transaction instead of simply downloading them. Nearly every big
bank will let you to easily and quickly connect to QB, though, it should be
noted that a number of smaller banks and unions simply do not have that
option. In order to import transactions into QB, your online banking ID and
password are required to log in. However, this is only asked of you the first
time, as QB stays connected to your bank account for the purpose of
downloading day-to-day transactions.



●       In the Left Menu Bar, select Banking. To locate your bank/financial
institution, you can do one of the following: enter the name of your
bank in the search field or click on the bank list below and find it
manually. Punch in the ID and password you would normally enter
to access your bank account. Your bank shows every account you
have with them. Be sure to select only the business accounts that
you want to connect to QuickBooks.

●        Select every account you wish to be connected to QB by simply
clicking anywhere in the account row

●        Account Name: From the drop list, click the QB account that you
wish to connect with the bank account. In case you still haven’t set
up a bank account in QB, click Add on the account drop list.

●       The account setup window will pop up. Fill in the blanks in order to
set up a bank account in QB

●        Account Type: Choose the type of account for which you want to
import transactions into QuickBooks. Normally, this is either a bank
account or a credit card one.

●        Detail Type: Here, you wish to provide more info on the category
of the bank account.

●       Name: How will the account name be displayed in QuickBooks.

●       Description: Enter the name of the bank and the type of the account
(e.g., checking, savings, etc.)

●        save and Close: Double-check to make sure that you have made
selections in all five fields. Click the Save and Close button.

Bank Deposits Recording



The Make Deposits window is like an electronic deposit slip. The payments
you chose to deposit are already filled in. If you have other checks to
deposit besides customer payments, they don’t automatically show up in
this window. However, if you’re keen on adding them, you can do so
manually. If you’re depositing a payment made in a foreign currency, in the
“Exchange Rate 1 [currency] =” box, type the exchange rate that your bank
used for the transaction. The table of deposits then shows the deposit
amount in the foreign currency, and the lower section of the window shows
the deposit total in both the foreign currency and your home currency. After
you make your foreign-currency deposits, you can see how much you
gained or lost due to changes in the exchange rate by choosing
Reports→Company & Financial→Realized Gains & Losses. This report
shows the payment amounts in your home currency, the exchange rate, and
the resulting gain or loss.

You need to record a deposit in QuickBooks if you receive a check from
someone other than a customer. To begin, on the Homepage, select the Plus
sign in the top and select Bank Deposit right below the Other column on the
far right. The record deposit window will display the following:

●       Bank account – Choose from the drop list that one account that you
want to deposit this check to.



●        Balance – this is the current balance of the bank account you
selected.

●       Date –the date you will make the deposit

●       Received From – select from the drop down the person or business
that you received the check from. If they weren’t set up in QB, you
could do so here by selecting Add new from the drop-down menu.

●       Account – select from the drop down the account that you want to
track this deposit.

●       Description – type a description here that will help you to identify
what this check was for.

●       Payment method – select a payment method.

●       Ref no. – if the payment method is a check, type the check number
in this field.  Otherwise, you can leave this field blank.

●       Amount – enter the amount of the deposit.

●       Cashback goes to: select the petty cash account here if you plan to
get cash back.

●       Cashback memo: indicate here if there is a specific purpose for the
cash back

●        Cashback amount: enter the amount of cashback you plan to
receive from this deposit.

●       This is the total amount of the deposit less the cash back amount.

Once you have completed all of the fields, Save and Close. When you’re
moving money between bank accounts, if you simply accept the Online
Banking transactions (see next section), you may accidentally create two
unrelated transactions. We want to transfer $500 from the Checking account



to a Savings account. Select + | Transfer. Enter the accounts to transfer the
money to and from, the amount of the transfer, and the date of the transfer.

It would be helpful to put a description of the transaction in the memo field.
If this transfer happens on a regular basis, then you can make it a recurring
transaction. Click Make Recurring to set this up. Click Save. You can save
several hours a week of clerical tasking by using Online Banking. It is
found under Transactions | Banking. This feature works in one of two ways:

●       A direct connection to your bank or credit card company. It “sucks
in” all that day’s transactions for your approval. Some banks charge
for this service.

●        Download the month’s transactions from your bank’s website and
import them into QuickBooks Online.

This service is always free but may be labor-intensive. If you do have
Direct Connect, you can finish each day, as part of the ’15-Minute Books’,
by opening up Online Banking. Any transactions that you entered manually
into your QB will be marked as “Matched.”

For transactions that don’t match, click on them to edit. If it’s a Vendor who
you will use frequently, update the Payee line. If it’s a one-off expense or a
Payee you don’t want to accumulate in your Vendor list (like a restaurant or
a gas station), leave this field blank or create a generic Payee (like
“Restaurant” or “Gas Station”). Next, modify the Expense category. Be sure
to choose the right one and be very sure not to leave it as Uncategorized
Income or Uncategorized Expense! When done, select Accept. For
Deposits, this is usually when I go to + | Bank Deposit to gather the
corresponding individual transactions. As soon as we’re done, QBO notices
the new matching dollar amount and Matches the transaction. Every time
you label a new type of transaction, QBO will create a Rule, so the next
time it sees that same Payee from the bank, it will modify this entry
automatically.



Sometimes one Payee might have two different types of transactions. For
example, Intuit is my Payee for the Dues and Subscriptions for my QBO
account. Intuit is also the vendor for my Merchant Services Fees account,
and I have to keep an eye on each transaction to be sure it gets filed
appropriately. In another scenario, some banks only provide generic Memos
like “Check,” and Online Banking will auto-fill it with the most recent
previous transaction. Fortunately, you can create manual Rules to control
these situations. If the transaction is a Transfer between bank accounts, also
make sure it’s marked as a Transfer using the radio buttons above the
Payee. Otherwise, you’ll wind up with two transactions indicating money in
and money out instead. While it still needs maintenance to import cleanly,
this new feature automates the time-consuming task of manually entering
every single debit card and credit card charge. It also helps you discover
transactions you missed or ones you created that never hit the bank.





Chapter 5
 



Business Credit Card Transaction Managing

In QuickBooks, the credit cards you use can be set up as accounts or
vendors, depending on how you prefer to record your credit card
transactions. Here’s the deal: tracking credit card charges using an account
has several advantages. With a credit card account in QB, charges can be
entered as they happen (which takes no time at all if you download credit
card transactions;). Then, when you receive your statement, you can
reconcile the credit card account as you would a checking account, so you
can see whether your records and your charge card company’s match. To
prevent credit card charge payee names from filling your Vendor List with
entries you don’t need, store names in the Memo cell or create more general
vendors like Gas, Restaurant, and Office Supplies.

Credit card vendor.
If you set up a credit card as a vendor, you don’t have an account to
reconcile when you receive your credit card statement. In addition, the
name of every establishment you bless with credit card purchases won’t fill
up your Vendor List. The drawback to this approach is that you still have to
allocate the money you spent to the appropriate accounts, and you can’t
download that split transaction from your credit card company. With the



statement in hand, open the Enter Credit Card Charges window (choose
Banking→Enter Credit Card Charges) to enter a single transaction
allocating the total statement balance to each of the charges you made. (On
the window’s Expenses and Items tabs, add entries to allocate charges to the
appropriate expense accounts.) That way, the transaction does double-duty
by reconciling your charges to the statement, which will make your
accountant happy

The transactions from your business credit cards will not be posted even
when you import them. You will still have to take a few more steps before
completing registration, such as reviewing and giving additional
information. A tutorial on reviewing card transactions so that you may add
them to your register and financial statements.

At the top of the Banking Center, you will be able to see, at the top of the
page, all of the banking and credit card accounts you have set up.

If the account is linked to your bank account, you will be able to see your
credit card balance as of the latest sync in the top blue portion of the box.

●       The current balance in the QuickBooks register is displayed at the
bottom portion of the Account box, and the number of transactions
is displayed in the For-review tab.

●       If the top of the box shows $0.00, it may mean that the account has
not linked properly.

●        The bottom portion of the account box will show the current
balance in the QuickBooks register and, in the For-review tab, the
number of transactions, similar to the linked account.

●        Any transaction you make will be placed in one of the following
tabs:



●        For Review – this is where your transaction will go before you
finish reviewing it, before posting it, most commonly when the
transaction is first imported.

●       In QuickBooks – this tab keeps track of all of the transactions that
have been matched or added to the register in QuickBooks. 

●        excluded – this tab will show the transactions you removed from
the For-Review tab.

●        By clicking on the left-hand menu bar and selecting banking, you
will be able to manage downloaded credit card transactions in the
bank center. We advise by immediately sorting the transactions in
the For-Review tab. Within this tab, two additional tabs can be
found:

●       All – this tab keeps track of all transactions (including those placed
in the Recognized tab)

●        Recognized – If a transaction that is already recorded in your
register is recognized by QuickBooks, a green MATCH tag will be
displayed next to it, and it will be moved to the recognized tab. 

●        By clicking the Match link located in the action column, you will
add the transaction to the register. QuickBooks will add the
transaction to the register and include it in your financial
statements.

People often function on a subconscious schedule. Whenever you perform a
transaction, no matter how small, the chances are that you will do so from
the same retailer. If you have previously downloaded vendor names or
descriptions, QuickBooks will recognize them and will suggest as to which
account the transactions should be coded to.  Upon accepting the change,
QuickBooks will redirect all transactions that fit those parameters to the
same account.



For example, if you have previously coded Bluehost.com transactions to
your Advertising account, then the next time a Bluehost.com transaction is
downloaded, QuickBooks will suggest coding it to the Advertising
account.  If you accept the suggestion, then QuickBooks will categorize all
transactions with the Bluehost.com description to the Advertising account.

If a customer returns a product or finds an overcharge on her last invoice,
you have two choices: Issue a credit against her balance or issue a refund by
writing her a check. In the bookkeeping world, the documents that explain
the details of credit are called credit memos. On the other hand, when a
customer doesn’t want to wait to get the money she’s due or isn’t planning
to purchase anything else from you, a refund check is a logical solution. In
either case, refunds and credits both begin with a credit memo.

When you purchase items using your business credit card, you may need to
return something because it was damaged, or it just didn’t work out. The
vendor will usually process the return using the same credit card that you
used to make the purchase. When this credit shows up on your credit card
statement, you need to be sure that it is flagged as a credit card refund and
that it is coded to the same account you coded the original purchase.



From the Home page, click on the Gear icon to the left of the company
name and select Chart of Accounts. From the chart of accounts list, click on
the View Register link next to the credit card as indicated below. The Credit
Card register will display. From the drop-down, select CC Credit. Complete
the following fields:

●       Account – From the drop-down, be sure that you are in the correct
register. If not, select the credit card that you need to enter the credit
return for. This is the credit card that the vendor credited the
purchase to.

●       Date – Enter the date that you returned the product.

●        Ref No./Type is a field you don’t have to fill out. It is
recommended that you put CREDIT. Below the ref number field is
the transaction type. QuickBooks will put the transaction type based
on your prior selection.

●        Payee – From the drop-down, select the vendor that you returned
the product to.

●       Memo – Include any additional information about the return in this
field (e.g., reason for return).

●       Payment – Enter the cost of the item that was returned.

●        Account – From the drop-down, select the account that the credit
for the return should be categorized to. It is best practice to use the
same account that you categorized the original purchase for the
credit card refund.

●        Save – After you complete all of the fields, you can save this
transaction.

If you need to edit a credit card refund that was previously entered, you can
do so by following these steps:



●        From the Home page, click on the Gear icon to the left of the
company name, and select Chart of Accounts.

●        From the drop-down, select the credit card that you entered the
refund.

●       Click anywhere within the transaction to activate the fields that you
can make changes to.

●       Once you have made your changes, be sure to save them

Business Credit Card Reconciling
You’ve opened your mail, plucked out the customer payments, and
deposited them in your bank account. In addition to that, you’ve paid your
bills. Now you can sit back and relax knowing that most of the transactions
in your bank and credit card accounts are accounted for. What’s left? Some
stray transactions might pop up—an insurance claim checks to deposit or
handling the aftermath and bank fees for a customer’s bounced check, to
name a few. Plus, running a business typically means that money moves
between accounts—from interest-bearing accounts to checking accounts,
from PayPal to your checking account, or from merchant credit card
accounts to savings.

For any financial transaction you perform, QuickBooks has a way to enter
it, whether you prefer the guidance of transaction windows or the speed of
an account-register window. Reconciling your accounts to your bank
statements is another key process you don’t want to skip. You and your
bank can both make mistakes, and reconciling your accounts is the way to
catch these discrepancies. Once the bane of bookkeepers everywhere,
reconciling is practically automatic now that you can let QuickBooks
handle the math. In this chapter, the section on reconciling is the only must-
read. And if you want to learn the fastest way to enter any type of bank
account transactions, don’t skip the first section. You can read about



transferring funds, loans, bounced checks, and other financial arcana
covered in this chapter as the need arises.

Similar to your personal credit card accounts, it is important that you
reconcile your business credit card accounts on a monthly basis.
Reconciling is the process of matching the transactions on your credit card
statement to what you have recorded in QuickBooks.

Preparing Business Credit Card reconciliations on a regular basis will help
to ensure the following:

●        Any discrepancies between your records and the credit card
companies are resolved in a timely manner (e.g., a credit card
charge that comes through for a different amount from what you
authorized.)

●       Timely notification of any fraudulent transactions. For example, if
you notice transactions listed on your credit card statement that you
did not authorize, you can notify the bank as soon as possible so
that they can investigate.

In addition, reconciling your credit card transactions in QuickBooks helps
ensure every transaction is noted in your books. This helps keep your
financial statements, like profit & loss and balance sheet up to date.

Before you follow the steps to reconcile, be sure that you have your credit
card statement handy for the credit card. We will refer to the credit card
statement often during this process.

Here are the steps to reconcile a business credit card account in Quickbooks
Online

From the Home page, click on the Gear icon to the left of your company
name. Below the Tools column, select Reconcile. Complete the fields, as
indicated below:



●       Account: Select the credit card account you would like to reconcile
from the drop down.

●       Beginning balance: QB automatically fills in this field with ending
balance from the previous month. Check if this amount matches
what your bank statement says. If it does not, you should see a
notification that says, “Hold on! Your account isn’t ready to
reconcile yet”. Click on the “We can help you fix it” link and follow
the instructions to resolve the difference before you reconcile the
current month.

●        Ending balance: Enter the ending balance that appears on your
bank-given statement in this field.

●       Ending date: Enter the ending date of your bank-given statement in
this field.

●       Start reconciling: When you are ready, click the “Start reconciling”
button to go to the next step.

You will see the following information:

●        Statement Ending Balance – The amount that you entered
previously in Step 2 will appear in this field. Be sure to double
check this because it will cause you to be out of balance if it is
incorrect.

●        Beginning Balance – As discussed previously, this is the ending
balance from last month’s statement. QuickBooks will populate this
field for you.

●       Cleared Balance – As you start to reconcile each item, this amount
will change depending on whether you have selected a charge or a
payment transaction.



●        Charges – This amount will increase as you select charges to
reconcile from the detailed section below.

●        Payments – This amount will increase as you select payments to
reconcile from the detailed section below.

●        Difference – Quickbooks will handle this for you. It is the
difference between your statement balance and the cleared balance.
The goal is to get to a difference of zero.

●        Transactions – In this section, you will see all of the charges and
payments that have been recorded in QuickBooks as of your
statement ending date. You can filter this section to just show
Charges, Payments or all by clicking on each of the tabs.

If you are new to reconciling, I recommend that you reconcile the area with
the least number of transactions first. Our goal is to make sure that every
charge and payment listed on the credit card statement is marked as
“cleared” in the reconciliation window.

To mark an item as “cleared,” click the radio button to the right of the
Payments column. Let’s start with payments first. Once you have marked
all of the payments in this window which show in the statement of the
credit card, verify that the total payments cleared matches the total
payments amount in the statement of the credit card. If the total payments in
the statement match the total payments we have “cleared” in QuickBooks,
you can move onto charges. However, if your payments do not match, head
over to the section for troubleshooting tips on how to fix the out of balance.

Once all charges and payments match the credit card statement, you should
have a difference of $0.00. Behind the scenes, QuickBooks will mark all of
the charges and payments that have been reconciled as cleared. Click the
“Finish now” button to generate the credit card reconciliation report. It’s
important that you save all credit card reconciliation reports for every credit



card account. You can create a folder for each credit card account to keep
these reports in.

Try some of these tips if you’re having trouble getting a $0.00 difference
between what’s in QuickBooks and what’s on your credit card statements:

If possible, narrow the search down to the transaction type. Figure
out whether you aren’t in balance with the charges and payments.

If out of balance for both charges and payments, then tackle them
separately. In other words, balance charges/cash advances first and
then move onto payments/credits or vice versa.

Look for the exact dollar amount that you are off. For example, if
your difference is $50.00, then look for a transaction for this amount
on your credit card statement and then on both the charges section
and payments section of the reconcile window.

Triple check the information that you entered from the credit card
statement in step 2 above.

Check to see if there are any transactions in the reconcile window
that you did not select. If the transaction is on your credit card
statement, then make sure the radio button next to it is selected.

If you do have a transaction on the credit card statement that is not
in QuickBooks, then you will need to add it to QuickBooks.





Chapter 6
 



Reporting

Just when you think things cannot get any more hectic, the final days of the
year bring a mountain of additional bookkeeping and accounting tasks with
them. QuickBooks can delegate most of those tasks with just a few clicks if
you have kept on top of your bookkeeping. (If you avoided this task,
however, you might find yourself in a position where not even QuickBooks
can help you.)

The tasks you have to perform at the end of each fiscal year (or whatever
period of time suits you) and how to delegate them to QuickBooks will be
described in this chapter. When you work with an accountant, you may
never run a report from the Reports→Accountant & Taxes submenu unless
your accountant requests it. Sniffing out any problem will be easy, however,
as long as you prepare your own tax returns and run the following reports at
the end of each year: the Audit Trail report (Reports→Accountant &
Taxes→Audit Trail) is an excellent tool when it comes to files that several
people from your company worked on disappear. QuickBooks’ audit trail
feature, which is always turned on, keeps track of changes to transactions,
who makes them, and when. By running the Audit Trail report, you can get
even more information based on files that are deleted or removed. (You
have to be the QuickBooks administrator or have permission to access
sensitive files.)

Profit and Loss/Balance Sheet
Reports are critical for maintaining feedback and specialized business
activities. The objective of reports is producing information on the
company’s financial status, as well as conducting stabilization and
development in all of the company’s activities. Reports are expected to be
easily readable, concise, dependable, and accurate. They show whichever



financial changes that are directly related linked to a company’s financial
status. The purpose of reports can impact the direction the owner will take
and the choices he will make down the line. They are fairly helpful when it
comes to management in the way of further clarifying the figures. Also,
they may be of use to the management for shareholder’s annual reports.
When you want to find information, the best place to start is a report.
Knowing how to handle reports is one of the keys to a successful business.
Ranging from basic financial reports to customized reports, they are an
asset to any business owner.

The QuickBooks Online reports are easy to organize. This means that you
will easily create formats tailored to your unique needs and save that format
so you can run the report; however, many times with little to no changes
required.

The QuickZoom feature in every report allows you to access the
information down to the transaction level through a link that is unique to
every report. Just by hovering your mouse button over the report you will
make it turn slightly blue, and all you need to do is click the link you are
provided with.

If you want to be good at reporting, you will have to successfully
comprehend a few rules. The first thing you should learn is the difference
between Cash and Accrual. Cash basis reports focus on the part of the
transaction that occurs upon completion, where it accounts for the exchange
once it is done, while accrual refers to the start of the transaction, where the
transfer of money just began. It is wise to learn how these can affect your
growth and the information you base your decisions upon. Accrual reports
are hailed to be more important as they are a better indicator of the success
of transactions. However it is wise to occasionally check up on cash reports
as it can give you insight on the flow of cash. We are now ready to dive into
the reports in QuickBooks Online. First, an introduction to the Report
Center is due; then we will discuss the Report Groupings and then we will



learn something about each group as well as individual reports. You can
find your categories in the Report Center or Report Dashboard. With one
click of the right mouse button, a menu will be revealed for any report.
From the left navigation menu, click Reports. This brings you to the Report
Dashboard (or Report Center) where you can easily access multiple reports.

The first thing you will spot on The Dashboard is a summary of Profits and
Losses. Next to which you will find a search bar of a sort which will help
you go through reports without cycling through them. The reports are then
broken down into four tabs:

Recommended – In the recommended section, you will find the
most basic of reports every businessman needs. This includes Profit
& Loss, Balance Sheet, Expenses by Vendor Summary, A/P Aging
Summary, etc. Each of these reports belongs to a group, but this
makes them easier to access.

Frequently Run – This section will give you a summary of the
reports you run the most often, as well as the results of said reports.

My Custom Reports – This will give you the reports you specifically
asked QuickBooks to save. From here you can edit them, run them,
or distribute them.

All Reports – This is where you will find the nine categories of
reports, as well as find any reports that are available via
QuickBooks. This allows you to edit and customize your reports as
much as you like as well as access new formats that may be
available.

Business Overview reports analyze how your business is doing from
different perspectives. Here you will also find all of your major financial
reports:



Balance Sheet, Statement of Cash Flows and Profit & Loss, with Profit &
Loss Detail and Balance Sheet Summary. Here you will also find your
Company Snapshot and Scorecard, where you can find graphical
representations of your company’s performance relative to the industry.
Finally, in the Activity Log, you will be able to see everything that has
happened in your company’s file.

First, let’s get better acquainted with financial reports. To put it simply, they
indicate how healthy the company is running. Learning to read reports is
very easy. It is only a matter of following simple instructions; if you ever
followed a recipe, you will have no problem with obtaining this skill. The
three main financial statements are as follows:

Balance Sheet – Displays everything a company possesses and what
it incurs at a single point in time

Profit & Loss statement – Displays all the money a company has
accumulated and expended in a certain timeframe

Cash flow statement – Displays the transfer of capital between a
company and the outside world in a certain timeframe.

The Balance Sheet, to put it simply, dictates the worth of your business. It
provides you with a general summary of your company. It takes what the
company owns (assets) then subtracts what it owes (liabilities) from that to
give you how much your business is worth (your equity). It accounts for
each asset, liability, and equity as of a specific date.  You can consider it a
short review of the change of equity over time.

Asset is anything a company possesses that has value. This usually implies
they can be sold or used by the company to create a product or provide
services that can again be sold for profit. Assets include but are not limited
to physical property, things that cannot be touched, but still have a value,
such as patents or trademarks, investments, and of course, cash.



Any amount of money one company owes to another is considered a
liability. All kinds of obligations can be viewed as liabilities, such as bank
loans, rents, mortgages, payroll, taxes, environmental cleanup costs, etc. 
Furthermore, liabilities also encompass obligations to the provision of
services and/or goods to customers in the future.

Equity shows the net worth of a company (by subtracting liabilities from
assets) as well as how the company interacts with the owners. If a new
owner is putting money in the company or old ones are not putting enough
money in it, that is what equity accounts for.

Step by Step: The Balance Sheet
Follow the line from Reports to Recommended Reports and finally
Balance Sheet

Pay attention to the two lists, one indicating assets and the other
indicating liabilities

Click Customize, then Add Subcolumn for Comparison and Select
Previous Period

Run Report.

Profit & Loss shows how much money you made and how much you spent.
This report, also known as an income statement, summarizes your income
and expenses for all accounts you have on your balance sheet, dictating if



you are operating at a profit or loss. Different from a balance sheet, this
report shows change over time, as opposed to information in a single point.

To understand how Profit & Loss reports are constructed, think of them as a
flight of stairs. You begin at the top with the full amount of sales and
income generated in the accounting period. As you descend down these
proverbial stairs, you constantly deduct every expense. When you reach the
final stair, after deducting every last one of the expenses, you are left with
how much the company actually earned or lost in a period of time. “The
bottom line” is another name for this.

For a new business owner, one of the most important things is setting
milestones in the form of achievable goals he is going to strive to over time:

The first goal would usually be making sales. The product he opts to sell
should be something that someone else would buy so that he can receive
income. That is the first element, Income, and Revenues.

The second goal should be selling the product at a price where profit is
achievable, meaning that a product should pay for its own production costs
and more. If a product is made for 5 dollars, he should aim to sell it for
more than that. In the next paragraphs, we will discuss profit and loss and
the price of goods sold. Which brings us to a new term, Gross Profit, which
represents the amount of money that remains after you subtract the sold
goods price form the income.

The third goal should always be selling enough of the product. Enough
being the amount of money, which can cover the costs of running the
business. These expenses are something that a business owner has to pay no
matter how much of the product he is considering overhead. Office rent,
Bank Services. Payroll, etc. are all a part of these expenses. The thing that
tells you if you have succeeded with doing this is the Net Operating
Income.



The fourth goal is earning enough money for you to be able to take some
home. During the company’s operation, many unforeseen things can
happen. The overall Net Income accounts for this. To be more accurate, it
tells you if, after everything, your business has made any money. This
opens a new train of thought for the owner if he wants to reinvest in the
business or take the money home.

Step by Step: Profit & Loss
Open the Reports menu, then click All Reports, then go to Business
Overview and then finally click Profit and Loss. Notice the list
income and below, the list of expenses.

Click Customize -> Change the Transaction Date to be Last Quarter.

Change the Accounting Method to be Cash Basis.

Run Report.

Company Snapshot

The Company Snapshot report gives you information on money coming in
and out of your business. It also allows you to check on how your company
is doing in relation to the competition. In order to access the report, you
have to:

Go to Reports, then All Reports, then Business Overview and,
finally, Company Snapshot.

You might have to install the Adobe flash player, which will only
take you a moment.

The following will be presented to you upon the report’s opening:

My Income – A graphical representation of the five accounts with
the most income for a selected period will be provided in the top-left
box. The other accounts will be lumped into a category called Other



My Expenses –The accounts with the greatest expenses for a
selected period will be shown in the top-right in the form of a pie
graph. The Other category is where the other accounts will be listed.

Previous Year Income and Expense Comparison charts – These
charts have been added to allow you to compare income and/or
expenses from year to year. You can scroll over the chart itself to see
detailed data used to make up the chart you see in this section.

Who Owes Me – all of the customers that owe you money will be
shown in the bottom-left corner, along with their current balance.

Whom I Owe – The vendors you owe money to will be shown in the
bottom-tight box along with your open balance with them.

Step by Step: Company Snapshot

First, you go to Reports, All Reports, Business Overview and then
Company Snapshot

In Previous Year Expense Comparison select Change the Quarterly
to Monthly

Make sure All Accounts is changed to Utilities

See a monthly comparison of the Utility account last year versus this
year

Scroll over one month to see the exact total.

Scorecard

Through the Intuit financial software, Intuit gathers company data from
thousands of small companies. While respecting the Privacy Policy, the data
gathering is done to be consistent with the industry and popular practices.
The gathered data excludes company-specific information such as phone
numbers and addresses so that companies cannot be identified. This lets you



compare your business to others in the industry. Here you can see how your
Net Profit Margin, Sales Growth, and Cash Flow compare to others. Look
at the bottom for My Overall Score. The Income and Expense tabs compare
over time and details for the date range set and the respective tab you’re on
to see trends in applicable categories.

Manage Accounts Receivable
Manage Accounts Receivable reports show you how much someone owes
you and who owes you in the hopes of receiving payment. The reports
include A/R Aging Summary and Detail, Customer Balance Summary and
Detail, Invoice List and Statement List, Collections Report. One of the
more unpleasant tasks a business owner must perform is collecting money
from those who owe them. These reports will help you pursue the correct
individuals and sort the debts others have to you.

Customer Balance Detail tells you who owes you money, how much and
when. The report shows you all of the instances of customers owing you
money, sorted by parameters of similarity, this might also benefit you
personally.  The Customer Balance report might come up when taking a
loan from a bank.

Step by Step: Customer Balance Detail

In Reports select All Reports then Manage Accounts Receivable and
Customer Balance Detail Report

Notice the four columns which indicate Customers, Dates, Amounts,
and Balances.

Collections Report which shows how you collect overdue payments

This report lists overdue invoices and credit memos that were
unapplied for based on the customer. It shows since when the
invoice was due, as well as by how much is the deadline
overextended, as well as the personal information provided by the



customer. This report is very similar to the Customer Balance Detail
report because of its usability. If you want more information on the
balance, you can quickly access the details by clicking the
transaction.

Step by Step: Collections Report

From Reports go to All Reports then Manage Accounts Receivable
and finally Collections Report

Pay attention to the columns that show Customers, Dates, Past Due
Amounts, and Balances.

A/R Aging Summary tells us how long you have been working on
getting the money

The A/R Aging Summary lists every single customer with an open
balance and invoices in different columns based on how long
overdue the payment is. (30, 60 and 90+ days)

Step by Step: A/R Aging Summary

From Reports go to All Reports then Manage Accounts Receivable
and then A/R Aging Summary

Pay attention to the columns that show the customers’ timeliness
and overall balances

Review Sales

Review Sales reports let you discover where you can make the most money
by analyzing sales. This report gives information on sales by customer,
sales by product as well as income by the customer, as well as a list of
customer contacts and more. By showing you the best and worst the market
has to offer, this lets you know what you need to sell more of. This also



allows for insight on customer activity to help control the market and set up
a reward system for valuable customers.

Customer Sales Summary gives information on how much each customer
purchased from the company.

The Sales by Customer Summary report is a very valuable tool as it shows
which customers contributed the most to your company. You can check this
activity for whatever period suits you the best.

Step by Step: Sales by Customer Summary
1. Reports -> All Reports -> Review Sales -> Sales by Customer

Summary.

2. Customize -> Date: All Dates -> Sort by Total in descending order.

3. Take note of the customers who have purchased your product and/or
services over time the most

Customer Detail sales report is a more detailed version of Sales by
Customer Summary.  It gives you information on each transaction that
contributed to each total, In addition to income from each customer. As
with all reports, you can set the time frame to whatever date you want in
order to analyze the data more thoroughly.

Step by Step: Sales by Customer Detail
To find your Sales by Customer Detail, go to Reports, then All Reports,
then Review Sales and finally Sales by Customer Detail.

Date: You can select whichever period interests you.

Pay attention to the four columns that show Date, Product/Service, QTY,
Rate, and Balance.

Product/Service Detail Summary what the details per product or service.



This report gives more detail then Sales by Product/Service Summary. It
lists the contributions of most impactful transactions in a selected time
frame, as well as dollar and unit sales for each product or service. This
helps you see which of your products or services were the most profitable
or popular in the time period.

Step by Step: Sales by Product/Service Detail

Go to Reports, then select All Reports, then click Review Sales and select
Sales by Product/Service Detail.

Date: Last Quarter.

Pay attention to the four columns showing Product/Service, Date,
Customer, QTY, Rate, and Balance

The Unbilled Charges Report tells you where and which invoices need to be
made.

In this report, you will be able to see transactions that have not yet been
invoiced but were marked billable. For example, an IT company helped an
individual with network setup. In order to complete the job, they would
have to have purchased a server on the client’s behalf.  If the credit card
charge was marked Billable and the client was entered in the Customer
field, the server will be shown in the Unbilled Charges report until the
invoice is made.

Step by Step: Unbilled Charges
After selecting Global Create go to Delayed Charge (it might be
required for you to click Show More).

In Customer dropdown, you need to select whichever vendor or
customer that is in question.



In the Product/Service dropdown, click Design. The description,
Rate and Amount, and QTY will be pre-filled.

Click Save and Close.

Reports -> All Reports -> Review Sales -> Unbilled Charges.

Manage Accounts Payable
Accounts Payable managing reports show how much you owe to vendors
and how much time you have until the payment must be made so you may
pay your dues on time, as well as take a moment to breathe. The reports
include A/P Aging Summary and Detail, Bill Payment List, Vendor Balance
Summary and Detail, Unpaid Bills. Managing cash that is going out of the
business is crucial for any owner. If you become good at running and
reading these reports, you might develop a sense for when the dues should
be paid, earlier or on time.

The A/P Aging Summary tells you how much money you owe to your
vendors and how long overdue it is.

This report gives you a summary of your unapplied vendor credits and
unpaid bills. You will mostly use this report to check which vendors you are
the most overdue on, so that you may pay your dues strategically when the
money starts coming in. For Example, you will always want to pay vendors
that charge interest first, unless some other factors are in play. The report
will show you all of the unpaid bills that have been entered in the current
period and totals owed to the vendors for each vendor.

Step by Step: A/P Aging Summary
To find your A/P Aging Summary you go to Reports, then All Reports, then
Manage Accounts Payable and, finally, A/P Aging Summary.

Pay attention to the four columns that show Vendors, Current, Past Due by
days late, and Totals.



The Vendor Balance Detail tells you what the detail behind the money is
that you owe to your vendors.

The vendor balance report tells you how long the bill has been due for, as
well as which vendors you owe money to. This report lists the vendor's
balances that have not been paid off. This is very important information for
any business owner, as this may come up when you are trying to get a loan
from your bank. If a vendor can be seen on this report, it indicates that there
are transactions that need to be completed. If you need more information
about the transaction, all you need to do is click through.

Review Expenses and Purchases
The Review Expenses and Purchases reports show you where you are
spending your money.  Expenses by Vendor Summary, Vendor Contact List,
Transaction List by Vendor, Purchases by Vendor Detail, Open Purchase
Order List and Purchases by Product/Service Detail are all included in these
reports. It takes a lot of time and energy to properly evaluate how well you
can control and cut costs. These reports help you facilitate the flow of
information, so you can make decisions more efficiently.

The Transaction List by Vendor shows you all of the interactions you have
had with your vendors.

The Transaction List by Vendor will summarize all of the transactions you
have made with each vendor in a certain period of time such as Cash
Expenses, Bills, Credit Card Expenses, Checks, Bill Payments, and even
Purchase Orders. You can show this report to a vendor and compare with
his/her monthly transaction statement to make sure the entries match. This
makes it easier to address any discrepancies in the two reports.

Activity: Transaction List by Vendor
To access this report, go to Reports, then All Reports where you
select Review Expenses and Purchases and finally Transaction List



by Vendor.

Take note of the easy-to-follow layout, memos, transaction type, and
amounts.

The Vendor Contact List gives a printable list of all of your vendors
as well as their provided contact information

The Vendor Contact List gives you an easily traversable list of all of
the vendors you have done business with so far. It is easy to
customize, as all you need to change the information and new ones
is a click on their name. This will give you the Vendor setup screen
where you can manage all of this. After saving, you will need to
refresh the browser for the changes to take place.

Activity: Vendor Balance Detail

Go to Reports, then select All Reports, then Manage Accounts
Payable and, finally, Vendor Balance Detail.

Pay attention to the four columns showing Dates, Vendors,
Amounts, and Balances.

Manage Payroll
Manage Employees reports will help you manage the activities of your
employees as well as their payrolls. Depending on if you have payroll
turned on, the reports will include: Time Activities by Employee Detail and
Recent/Edited Time Activities. Employers use the time reports in order to
monitor the work of their employees, as well as to ensure timely entry of
data. If you turned on the payroll module in QuickBooks Online, this group
would become Manage Payroll.

Manage Sales Tax
Manage Sales Tax reports show you the amount of sales taxes you have
collected and then tend to the fulfillment of the appropriate tax agencies.



Taxable Sales Summary and Detail, Sales Tax Liability Report come as a
part of this report. Knowledge of the potential of tax collection and payment
in any place of business is important for any business owner who operates
in multiple locations. QuickBooks will give you tax reports so you may
prepare for monthly, quarterly and annual sales tax returns, as per the details
you gave QuickBooks.

The Sales Tax Liability Report tells you how much you collected in taxes in
a period of time.

The Sales Tax Liability Report gives you lists of government entities and
sales tax rate that you have charged your customers in a certain time
period.  This report is printable, so you can have an easier time with sales
filings. If you seek more information while viewing this report, you simply
click on the Sales Tax center and see Taxable Sales versus Gross sales in
order to find your non-taxable sales, which you will often need to report
while finalizing tax collection.

Products and Inventory Managing
Products and Inventory managing reports are a great tool when it comes to
checking how stacked your inventory is. It also shows you how much
money you can make off of the items in your inventory based on the
information given. Inventory Valuation Summary and Detail, Sales by
Product/Services Summary Product/Service purchases, and Detail are all a
part of this report. Business Owners are required to maintain accurate on-
hand inventory records. For inventory tracking, QuickBooks provides you
with several reports needed to track the inventory and give further insight
into purchases and sales.

The Inventory Valuation Summary tells you how much of a product you
have on hand.

It shows you how much of each product you have as well, as well as how
much money was invested into making that amount of the product, which



will, in turn, give you an average cost of a single product. The total value of
the assets should match your Balance Sheet inventory of the same date.

The Deposit Detail tells you what customer payments made up for each
individual deposit.

It helps you find whatever info is missing or incorrect when it comes to the
bank deposits. While looking at this report, you may compare the lines with
individual deposit slips to keep your bookkeeping in order and prevent
customer payments from appearing to be additional income. 

The Trial Balance report gives you information on the ratio of debit and
credit is on all of your accounts.

It will list all of the accounts in the chart, along with their debit and credit
balance as of the date of your choosing. If everything is clean, the total
debit should match total credit.

The Recent Automatic Transactions report tells you which transactions are
automatically added to your list.

To ease your workload even more, every once in a while, we will set up for
recurring transactions to be automatically entered.  For example, if you set a
certain number of recurring transactions to be entered on every 1st of the
month. You should run this report in the first, second, and third month.

The Journal report tells you exactly what happened with your debits and
credits during a month. It will tell you the exact debits and credits of every
transaction in a specified time and displays them in order of occurrence. It
is an excellent tool when you document the detail of any time period while
preparing it for a tax return on any other financial statement

A list report is another useful tool for any owner, and there are several ways
to open one in QuickBooks. After selecting the Gear icon and going to the
List column, you will see a shortcut for the Products and Services list, as



well as the Recurring Transactions list. By selecting All Lists, you will be
given the option to access many other lists:

Step by Step: To run a Customer List
First, open the Report Center.

Select the All Reports grouping.

Click on Review Sales.

Find the Customer Contact List below.

Step by Step: For Vendors
Select the All Reports grouping.

Click on Review Expenses and Purchases.

You can choose to print the Vendor Contact List.

Open the Report Dashboard/Center.

Click the All Reports grouping.

Click on Vendors and Purchases.

Scroll down to the Customer Contact List.

My Custom Reports

After you customize your report to be a great tool for both you and your
clients. Saving the customizations will save you a great amount of time for
any time you run the report in the future. Furthermore, you can select if you
are the only one that has permission to see your customizations.

Activity: Custom Reports
Select the report you want to customize and select the Customize
option.



Click Run Report after you add a Subcolumn of your choosing.

Click Save Customizations after you adjusted the report to your
liking.

Select a proper name for the report.

If you wish to share this report with all of the company users, then
click share this report. Otherwise, do not, you will be the only one
able to view this.

Click OK

Heads-up: If you add a report to a group, you will be able to align a
common schedule for all of the reports in that group. They will appear in
the group name along with all the other reports in that group. If you add a
report with a different email schedule, it will sync with that of the groups.
After you save the customization on a report, you should select reports and
click My Custom Reports so that you may manage your Custom Reports
and Custom Groups. Pick which group of reports or single report you want
and select the function on the right. You can also set up a scheduled email
in HTML or Excel.

Other standard reports may be sent to you in order to help you with
monitoring information. They can be sent to you weekly along with
financial reports. If you want to send a set of standard reports, you might
not need to customize them at all but adding standard reports to your group
may make the process much easier. On a side note, if you apply any
additional changes to the reports, you will need to click Save
Customizations again.

Activity: Automatic Distribution
First, select Reports and go to My Custom Reports.

Select whichever report or group you wish and click Edit.



By selecting the box next to Set the email schedule, you will be
provided with more options.

Select Edit Schedule and set it to your desired time frame.

Put in the email addresses while separating multiple addresses with
a comma or a semicolon.

Select a note that will be attached and give it a subject line.

Choose how it will be delivered. Usually this is done via HTML in
the body of the mail. Save.

Heads-up: If you have accounts that you often receive complaints
about, the automatic distribution report is an excellent tool for
monitoring the productivity of those accounts, as well as figuring
out what needs to be done in order to resolve the issues.

Export your Reports

You usually do this by downloading the report in the form of an
Excel file. This is helpful for analyzing and using the data. To export
your reports, do the following:

Open the report that is intended to be exported.

In the top toolbar, select the Excel option.

The report will download as an Excel file to your default downloads
folder.

Send Reports

Sending reports from QuickBooks Online is a quick and easy way to
share financial information. The default format for sending reports
is as in-line HTML. You can send reports to multiple recipients and



even include a note in your email. Follow these steps to send a
report:

Open the report that you would like to send.

Click the blue Email button from the top toolbar in the report.

Type in the email address you wish to send to.

Add a note if you wish.

Press Send.

Cash Flow Statement
Thanks to non-cash accounting anomalies like accrual reporting and
depreciation, Profit & Loss reports don’t tell you what you’ve got in your
proverbial wallet. Looking at your cash flow statement report helps you
figure out whether your company generates enough cash to keep the doors
open. Your balance sheet might look great—$10 million in assets and only
$500,000 in liabilities, say—but if a $50,000 payment is due and you have
only $3,000 in the bank, you have cash flow problems. The concept of cash
flow is easy to understand. It's just as every film-noir detective says, follow
the money. Cash flow is nothing more than the real money that flows into
and out of your company—not the noncash transactions, such as
depreciation, that you see on a Profit & Loss report.

Making a cash flow statement is easy because you have only one report to
choose from. Simply choose Reports→Company & Financial→Statement
of Cash Flows, and QuickBooks creates a report that displays your cash
flow for your fiscal year to date. To look at your cash flow report for a
quarter or a

Accounts Receivable and Payable Aging Report
In between performing work, invoicing customers, and collecting payments,
you have to keep track of what amount is owed by which customer (known



as Accounts Receivable) and when the money is due. Sure, you can tack on
finance charges to light a fire under your customers’ accounting
departments, but such charges are rarely enough to make up for the time
and effort you spend collecting overdue payments. Far more preferable are
customers who pay on time without reminders, gentle or otherwise.
Because companies need money to keep things running, you’ll have to
spend some time keeping track of your Accounts Receivable and the
payments that come in. In this chapter, you’ll learn the ins and outs of
tracking what customers owe, receiving payments from them, and dinging
them if they don’t pay on time. You’ll get up to speed on Income Tracker
(new in QuickBooks 2014), a handy dashboard that shows estimates you’ve
created, how much customers owe—both overdue and not—and what’s
been paid in the past 30 days. QuickBooks’ Collections Center can
highlight customers with overdue or almost-due invoices, gather the info
you need to collect what customers owe and make it easy to send out
reminders. In contrast to invoices, sales receipts are the simplest and most
immediate sales forms in QuickBooks. When your customers pay in full at
the time of the sale—at your retail store, for example—you can create a
sales receipt, so the customer has a record of the purchase and payment. At
the same time, QuickBooks posts the money from the sale into your bank
account (in QuickBooks, anyway) or the Undeposited Funds account. (Sales
receipts work only when customers pay in full, because that type of sales
form can’t handle previous customer payments and balances.) In this
chapter, you’ll learn how to create sales receipts for one sale at a time and
to summarize a day’s worth of merchandise.





Conclusion

Thousands of small companies and nonprofit organizations turn to
QuickBooks to keep their finances on track. And over the years, Intuit has
introduced various editions of the program to satisfy the needs of different
types of companies. Back when milk was simply milk, you either used
QuickBooks, or you didn’t. But now, when you can choose milk from
soybeans and rice as well as cows—and with five different levels of fat—
it’s no surprise that QuickBooks comes in a variety of editions (which, in
some cases, are dramatically different from their siblings), as well as six
industry-specific editions.

Choosing which QuickBooks installation to use can be difficult, luckily
we’ve dedicated this portion of the book exactly to that. The six industry-
specific editions will ensure that you’re not paying a dime over what you
need for the privilege to use QuickBooks.

From the smallest of sole proprietorships to burgeoning enterprises, one of
these editions is likely to meet your organization’s needs and budget.
QuickBooks isn’t hard to learn, as you’ve seen so far.

Many of the features that you’re familiar with from other programs work
the same way in QuickBooks—windows, dialog boxes, dropdown lists, and
keyboard shortcuts, to name a few. And with each new version, Intuit has
added enhancements and features to make your workflow smoother and
faster. The challenge is knowing what to do according to accounting rules,
and how to do it in QuickBooks. This book teaches you how to use
QuickBooks and explains the accounting concepts behind what you’re
doing.

Whenever you think about accounting software that can be used by small
businesses, you will usually think of QuickBooks first. For the past 20



years, Intuits financial management platform has been dominating the
marketplace for accounting software, and it keeps on improving. Intuit
makes sure to launch updates regularly, ensuring an enjoyable experience
while you work. 

At this moment, more than 80 percent of the market share for small
business is owned by QuickBooks. QuickBooks should be at the top of the
list whenever you research accounting solutions for small businesses.

QuickBooks will attend to all of your needs. Whichever style of operation
suits you best, it will opt to suit your needs. On the other hand, having so
many options, it can be quite a tiresome task to choose which product will
serve you the most and improve your working efficiency.

QuickBooks Self-Employed
If you are self-employed or a freelancer, you will find the most use
out of the newest edition of the product line, since it is cloud-based.
The ease of access and simple functions will do you better than most
other software out there.

The Self-Employed and Self-Employed Tax Bundle are your two
most beneficial solutions.

QuickBooks Self-Employed gives you the ability to:

Connect your credit card accounts to your bank accounts

Separate your personal and business transactions in order to make
the tracking of the flow of money in your business much easier.

Keep track of and calculate IRS Schedule C tax deductions and
expenses more easily.

Make quick work of calculating quarterly taxes.



QuickBooks Self-Employed Tax Bundle does basically the same
thing, except that it has a connection TurboTax, which lets you:

Pay your taxes online

Save Schedule C deductions to TurboTax

QuickBooks Online
In 2014, Intuit’s market changed to a tremendous degree. For the first time,
the desktop version was overshadowed by the online version.

This was a great sign for the market, as the 1 million subscribers
QuickBooks managed to accumulate showed that small businesses are
ready to shift their accounting solutions to the cloud. The cloud solution
comes in three different packages: Simple Start, Essentials, and Plus.

According to the QuickBooks homepage, the common functions amongst
these three packages are:

“-Accounts payable and accounts receivable

-Monitor and manage income and expenses.

-Billing and invoicing

-Send unlimited estimates and invoices

-Essentials and Plus also offer recurring invoices.

-Expense management

-Track and process work-related expenses such as travel and
supplies.

-Financial reporting

-Simple Start has over 20 pre-built reports, Essentials has over 40,
and Plus has over 60 (includes sales and tax reports).



The QuickBooks Simple Start package includes:

One user license

Data import from Excel or QuickBooks desktop versions

Access for up to two accounting professionals (accountant and/or
bookkeeper)

QuickBooks Essentials includes the above capabilities as well as:

Three user licenses

Ability to set user permissions (accountant, bookkeeper, etc.)

Ability to postdate bills and payments

QuickBooks Plus includes all of the above and more. Additional
offerings include:

Five user licenses

Inventory tracking

Creating and sending purchase orders.

QuickBooks Desktop Products
An important thing to remember is that, while QuickBooks online is the
best choice for most small companies as it is very easy to use and access, it
is not identical to its desktop counterpart.

The options they offer are fairly similar, but the variety and quantity of
features. The most report options in the online version are 60, while the
desktop version can go up to 100. Additionally, QuickBooks offers more
products when it comes to the Desktop umbrella. Bellow this you will learn
more about the 2016 version of the different varieties. They include:

-Mac: This one is designed for usage on the Apple OS and is not scalable.



-Pro: This is a great option for businesses that are still fresh and can be
further scaled to Premier and Enterprise.

-Premier: This one is made for small businesses that have industry-specific
needs and can further scale to Enterprise.

-Enterprise: This one is designed aimed at small businesses that have been
in the game for a long time or midsize businesses that need a flexible
solution.

The desktop varieties are similar when it comes to the base features,
including the scaling on each package.

QuickBooks Desktop Products: Common Capabilities:

It lets you easily deal with core accounting

Makes Accounts, bank reconciliation and general books easy to
manage

Limited Payroll

Tracking of employee’s hours and printing of deposit slips. This
function can be further improved upon with an additional fee.

Making Bills and invoices

Automatic creation and sending of invoices as well as a collection of
payments.

Managing inventory

Tracking orders, sales, and deliveries in order to keep up the product
supply levels.

Financial reports



Tracking and visualization of trends, evaluation of KPI and
profitability, including P&L statements, balance sheets, etc.

QuickBooks Mac Desktop
Businesses should note; The Mac desktop product cannot be scaled, while
the Windows versions of Pro, Primer, and Enterprise can.

Other than the functions above, the mac Desktop includes several others:

The “Income Tracker” dashboard, where you can manage unpaid invoices

Project accounting which helps you to invoice projects to several phases.

Budget management in order to help you create fiscal year budgets and
track their progress

QuickBooks Pro
QuickBooks Pro is designed for small businesses that are just getting
started. It’s simple enough for business owners that lack advanced
accounting knowledge and makes it easy for them to share files and data
with their accountant.

Pro allows up to three users to work within QuickBooks at the same time
(requires separate user licenses). The Pro package offers the common
capabilities listed in the table above, plus the following:

The “Bill Tracker” dashboard lets users see unpaid bills, purchase orders,
etc. all in one place

Tracks sales and expenses in multiple currencies

Easy data import from Excel, Quicken and older QuickBooks versions

QuickBooks Premiere
QuickBooks Premier specializes in small businesses whose needs depend
heavily on the industry. Non-profit, retail, and similar organizations will



benefit the most from this.

It is ideal for those who just started off in the world of business. If you
already have your goals and are ready to go full force into the world of
entrepreneurs, Premiere is ideal for you.

Premier gives you the ability to work with five users at the same time,
which is a strict upgrade to Pro or Mac.

Premier includes every feature Pro has, as well as:

Job costs and estimation

Budgets and forecasting

Reports specific for the industry

QuickBooks Enterprise
QuickBooks Enterprise is where Intuit’s products shine the most. It is by far
the vastest solution since it includes several applications including the
QuickBooks Payroll. It is designed to support up to 30 user licenses.

Enterprise comes in three different packages: Silver, Gold, and Platinum.
Each package includes the capabilities of Pro and Premier along with
several additional functions:

Up to 14 different roles that are predefined (accountant, admin, etc.)

It allows files to be accessed by multiple users at the same time.

“Expanded list” allows businesses to track over 100,000 employees,
customers, vendors and inventory items (Pro and Premier allow 14,500)

QuickBooks Apps
Intuit has several branded applications designed to enhance the
functionality of the above-mentioned platforms. Businesses can purchase
these add-ons by paying additional fees:



QuickBooks Payments: It allows you to email invoices and charge for
services online.

QuickBooks POS: A cloud-based, iPad POS system. It lets you ring up
sales and accept credit cards while keeping track of your inventory from the
POS dashboard.

QuickBooks Payroll: Allows businesses to pay up to 50 employees by
check or direct deposit. Automatically calculates state and federal tax and
files year-end W-2 tax forms.

QuickBooks has established itself as a major player in the small to midsize
business accounting market. Whether you’re just starting out, or you’re
expanding and have more advanced accounting needs, QuickBooks has a
solution designed to fit your business.

Frequently Asked Questions
-How do I register my copy of Enterprise Solutions?
You can register online or by phone. Go to the Help menu and click
Register QuickBooks.

-How do I contact technical support?
Go to the QuickBooks Support Site at www.quickbooks.com/support.

-How do I purchase additional user licenses?
You can add users to your QuickBooks Enterprise Solutions in two ways: „
Purchase additional copies of QuickBooks Enterprise Solutions in a store. „
Buy additional user licenses by phone or web. To add a license by phone or
web, go to the Help menu, click Manage My License, and then click Buy
additional user license. Follow the onscreen instructions.

-How do I move my company file from one computer to another?
To move company files from one computer to another, QuickBooks
recommends using a portable file provider. The portable company file does



not simply copy the data for your company; it compresses the data into a
smaller file.

To move your company file:

Make the company portable file:

Go to the File menu and click the option which you want to do.

Click Portable company file and then click Next.

Select the drive (hard drive, CD, or ZIP disk) where you want to save the
portable company file.

Click Save.

Take the media containing your portable company file to the computer to
which you want to move your company file.

Open the portable company file on the destination computer: Go to the File
menu and click Open or Restore Company.

Click Restore a portable file and click Next.

Browse to select the portable company file you want to restore, click Open,
and then click Next.

Browse to select and change the location and file name associated with the
file you want to be created and opened from the portable company file. If
you select an existing company file, it will be overwritten with the data
from the portable company file.

Click Save

-How do I remove older or unneeded transactions from my data file?
The Clean Up Company Data utility exists to remove transactions for which
you no longer need to keep detailed records. You can choose to remove
transactions from a specific date (for example, all transactions date on or



before 12/31/04). Optionally, you can choose to remove unused list items,
such as obsolete customers and items. Before removing the transactions,
Enterprise Solutions makes a copy of your company’s file that is archived
and enters general journal transactions that summarize the transactions
being removed. To remove older or unneeded transactions:

Go to the File menu, click Utilities, and then click Clean Up Company
Data.

Select one of the options:

To remove transactions from a specific date, select Remove transactions
from a specific date and then select a date from the date box.

To remove all transactions in the file, click Remove ALL transactions.

Click Next and follow the onscreen instructions.

-How do I download and install an update or patch?
Periodically, Intuit provides updates to QuickBooks Enterprise Solutions
that you can download from the Internet. These updates can include a
maintenance release (also known as a patch), a new feature, a new service,
or timely information that could be relevant to your business. In order to
update QuickBooks, access the help menu, and click Update QuickBooks.
Follow the onscreen instructions. If you store your company file on a file
server and also installed the Enterprise Solutions application on that server,
you need to periodically run Enterprise Solutions on the server and apply
patches and updates.

-How do I back up or restore my company file?
Backup your company files daily. Backup copies are important insurance; if
you should lose data for any reason, you can restore data from your backup
copy. Enterprise Solutions enables you to back up and restore your data in a
number of ways. To back up a company file:



Go to the File menu and click what you want to do with it.

Choose the backup option you want, click Next, and follow the onscreen
instructions.

To restore a company file:

Go to the File menu and select Open or Restore Company.

Choose the restore option you want, click Next, and follow the onscreen
instructions. To view detailed instructions for each backup and restore
option, refer to the in-product Help.

-What should I do if I forget my password?
QuickBooks 2004 and later releases support case-sensitive passwords. If
you believe you are entering the correct password but still get the message
‘’The password you typed is incorrect,’’ your password might include
mixed-cased characters. Try the following solutions: Enter Admin and then
click OK without typing a password. Enter your password with Caps Lock
or Num Lock turned on or off. Enter variations of your password, using
mixed upper- and lower-case characters. Enter the password with a space
before or after the actual password. Enter the password in a text editor, such
as WordPad or NotePad, to confirm that your keyboard is functioning
properly. Restore a pre-update backup of your file that does not have the
case-sensitive password. When you restore this file, you can set your new
administrator password at the end of the update process. If you are still
unable to access your files, go to the Password Recovery website:
www.quickbooks.com/removepassword (additional fees may apply).

-How do I update my payroll to use the latest tax tables?
If you are a QuickBooks Payroll subscriber, you have two options for
updating your tax tables: Go to the Employees menu, click Get Payroll
Updates, and then click Update. Turn on the Auto-update preference. When
a new tax table is available, it is downloaded automatically, and you are



prompted to install. Payroll updates, which might include compliance
enhancements and updated payroll tax forms as well as new tax tables,
become available throughout the year. We recommend that you connect to
the payroll service at least every 45 days to make sure you have the most
current tax table available. Make sure that you download and install the
latest payroll update before you pay employees for the first time.

-How do I add another company's EIN to existing Payroll
subscription?
To add an EIN for another company:

Go to the File menu and select Open/Restore Company. Select Open a
company file, select Next. Choose the company file you want to add and
click Open.

Go to the Employees menu, click Payroll Service Activities, and then click
Use my existing Payroll subscription. When asked if you want help setting
up payroll, click Yes.

Click Add To Subscription and click Next.

Enter and confirm the new EIN to be associated with your existing
subscription.

Click Done. Enterprise Solutions updates your subscription in the new
company file. You can run payroll immediately. Note QuickBooks
Standard, and Enhanced payroll subscriptions can process payroll for up to
three businesses (EINs) on the same payroll subscription. QuickBooks
Enhanced Payroll for Accountants can process payroll for up to 50 EINs on
the same payroll subscription.

Key Shortcuts
-To start QuickBooks without a company file press Ctrl (while opening)



-To suppress the desktop windows (in the Open Company window) press
Alt (while opening)

-Display product information about your software version press F2

-Close active window press Esc or Ctrl + F4

-Dates Key Next day + (plus key)

-Previous day - (minus key)

-Today T

-First day of the week W

-Last day of the week K

-First day of the month M

-Last day of the month H

-First day of the year Y

-Last day of the year R

-Date calendar Alt + (down arrow)

-Edit transaction selected in register or lift Ctrl + E

-Delete the character to the right of insertion point, Del

-Delete the character to the left of insertion point Backspace

-Delete line from detail area Ctrl + Del

-Insert a line in detail area Ctrl + Ins

-Cut selected characters Ctrl + X

-Copy selected characters Ctrl + C



-Paste cut or copied characters Ctrl + V

-Increase check or another form number by one + (plus key)

-Decrease check or another form number by one - (minus key)

-Undo changes made in field Ctrl + Z

-Help Windows Key

-Display Help in context F1

-Go to next Help topic Tab

-Go to previous Help topic Shift + Tab

-Display selected topic Enter
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Introduction

Despite what many people outside of this field of expertise may think,
accounting, bookkeeping and financial analysis are fascinating endeavors.
If you are here, reading this introduction, you most definitely think the
same. But more than that, you want to make sure you assimilate all the
information you need to build a real career in the financial world.

We’ll be entirely honest with you: regardless of whether you are an
accountant, a bookkeeper, a financial expert, or you are just training to
become one of these, what lies ahead of you is bound to be quite difficult.

It’s not just dealing with numbers that’s hard. It’s the very essence of what
you do: handle the money of a business (or more, in case you work for
multiple companies and provide them with your consultancy and/or
services).

In the end, the main goal of every business is to make profit - and as a
financial worker, you are right there, at the core of what businesses do. The
responsibility is tremendous, because every single zero and every single
comma can make a massive difference in a company’s statements.

Fortunately, accounting, bookkeeping, and financial analysis are all a lot
easier today, and this is largely due to the avalanche of software programs
that have simply made everything a lot more facile to handle. From Excel
spreadsheets to advanced software that rolls all the financial needs of a
company into one interface, we have come a long way.

QuickBooks is, by far, one of the most widely used accounting software
applications out there - and not without reason, actually. Popular in the
small business sector, this software has made bookkeeping and accounting a
lot easier, and the results show it. More than 80% of the small business



market uses QuickBooks, and there is a very long list of accountants who
have become influencers around this brand (Infoclutch, 2020).

Undoubtedly, QuickBooks is a great solution for you too, especially if you:

●       Work or have a small or medium-sized business

●       Want to roll all the bookkeeping and basic accounting features into
one software

●        Want the flexibility of multiple QuickBooks versions, each one
adapted to your own needs

●        Want to be easily able to export online banking statements and
import them into your accounting software

●        Want to be able to easily integrate your accounting software with
your Customer Relationship Management software, shopping cards
(if you own an eCommerce business), inventory, and so on.

●       Want a good price/ value ratio.

We’re not here to convince you QuickBooks is good though, because if you
are here, reading this introduction, there’s a fair chance you have already set
your mind to an accounting and bookkeeping software (and you just want to
learn how to use it).

That is precisely what we intend to do in this book. By this point,
QuickBooks has grown to be quite the comprehensive software, and it does
come with a lot of features - so while we might not be able to encompass
them all, we will definitely approach some of the most important ones.
From thereon, QuickBooks will become like child’s play for you: the more
you practice with it and the more you “play” with it (of course, not on real
statements!), the easier you will find using it.



Before we jump right into the features of QuickBooks and how they can be
accessed, however, we will take a bit of time to provide you with some
explanations. They work as a background for the entire book and they will
help you understand why managing your numbers with a good software is,
now more than ever, absolutely crucial. Also, we hope you will understand
how QuickBooks fits into this entire scenario.

As such, the first chapter of our book will be focusing on the accounting
principles - the absolute basics of accounting both in the United States
context (via the Generally Acceptable Accounting Principles, or GAAP)
and in a more international context. This chapter represents the foundation
of accounting and how you should look at it, both when you use
QuickBooks and otherwise.

We will approach the 10 basic principles in GAAP, the differences between
rule based accounting versus principle based accounting, double-entry
bookkeeping, as well as GAAP alternatives and why they might be
considered.

Hopefully, by the end of this chapter, you will have collected a healthy
understanding of the topic and everything it entails, so that we can move on
to the more practical aspects of our book: actually using QuickBooks.

The second chapter of our book will be all about performing bookkeeping
tasks using QuickBooks: invoicing, making payments, managing inventory,
items, cash and accounts, as well as paying employees and suppliers you
might work with.

Starting with the third chapter, we will dive in a little deeper and explore
some of the main ways QuickBooks can help you in this area. More
specifically, we will discuss financial statements and reporting, budget
planning, how to calculate cost based activities, as well as how to set up
different projects in QuickBooks.



Last, but not least, we will dedicate our fourth chapter to helping you
explore some of the basic ways in which QuickBooks can help you with
more advanced financial tasks - such as making forecasts, for example.

The very last chapter of our book will circle back to the fundamentals. This
time, though, we will discuss the fundamentals of QuickBooks and how
data protection is important in the entire spectrum of accounting and
bookkeeping.

Hopefully, the book at hand will help you learn not just how to work with
QuickBook, but how to actually incorporate it in your day to day work and
in how you do your work.

Hopefully, we will teach you to love accounting and bookkeeping,
especially seeing how easy they can be when you have the right software in
your hands. If this is your first accounting and bookkeeping software, you
will find that this software is not only making your life easier, but helping
you fully customize the experience you have beyond all the numbers, all the
rows, and all the columns of a spreadsheet.

This book was not meant to be exhaustive in any way. Once you learn how
to perform the tasks described in it, however, we trust that you will be able
to find your way through QuickBooks no matter what task you need to
perform with it.

Remember, this is a software and it will constantly grow to accommodate
people's needs. As such, do not be surprised if you will encounter new
features in the near future, or if the design of the software will change.
Instead, focus on learning the basics behind how this program works and
you will be able to adapt to whatever situation gets tossed your way.

We created this book to be genuinely helpful for our readers, and we hope
we have achieved this.



Yes, accounting can be a very difficult, intricate, and even downright
confusing world. But if you manage to move beyond the hardships, you will
discover a world that is fascinating beyond numbers, a world that is ever-
changing no matter how anchored in the past it may seem, a world that
helps mankind itself move forward.

Even more, if you manage to learn how to use a reputable, reliable, and
trustworthy accounting software that has been on the market for nearly
three decades, the world of numbers will be at your feet!

As you will learn in the following chapters, accounting software is not
about simply entering information into a “machine”. It is about ensuring
that your financial data is safely managed and processed, about allowing the
future of digitalization to help your business grow further, about being
open-minded in front of change and, ultimately, about learning how to use
apparently basic software and reports to create novelty in your business too.

If we have to be honest, learning how to use QuickBooks is not the easiest
thing in the world. But it isn’t the most difficult one either. It is a matter of
how much you want to do this, how advanced you want to be at it, and how
much you want to make the most out of the data that gets fed into this little
accounting system you install on your computer.

If you are an entrepreneur, you will learn that, once you get past the initial
shock of using QuickBooks (which you will most likely experience, and we
are saying this from our own experience), you will discover that this is a
pretty straightforward piece of software and that it can be more than useful:
it can become instrumental for your business growth from hereon. From
how you present yourself in front of potential investors to how you present
yourself in front of different legislative organizations, QuickBooks can help
you with so much!

And if you are an accountant, you will find that QuickBooks can simply
make it all more efficient and more productive for you because instead of



struggling to manually compile reports and statements, you will be able to
do it with just a few clicks. The future is here, folks, and it’s amazing!

We wish you all the luck in your future endeavors and we genuinely hope
the pages ahead will help you gain a better understanding of QuickBooks,
how it works, and also the basic concepts behind the accounting world and
how they relate to an international setting.

Happy reading and happy learning, and may you always deal with happy
numbers!





Chapter 1
 



The Accounting Principles

Accounting principles are a fundamental part of an accountant's job,
especially in the United States where the FASB (the Financial Accounting
Standards Board) has already issued a standardized set of accounting
principles. These principles are usually called GAAP, or the generally
accepted accounting principles.

We will discuss each of them in a bit more detail in this chapter, but first
you must understand some underlying concepts. The generally accepted
accounting principles are not difficult per se, but they frequently expand
into a multitude of ramifications that have significant outcomes in the day
to day work of accountants, bookkeepers and financial experts in the US.

The Accounting Principles - Background and Explanations
First of all, you must consider the fact that, in the United States, companies
are legally required to release their financial statements and make them
public. Furthermore, any company that is publicly traded on stock
exchanges and indices must follow the GAAP guidelines and its ten basic
concepts.

Furthermore, you should keep in mind the fact that the generally accepted
accounting principles are not necessarily meant to make your life a living
hell when you do accounting or bookkeeping work. On the contrary, these
principles are bound to help you manage the intricacies and legalities of the
businesses you are helping, as well as to ensure that your corporate
accounting is on par with the best practices. In general, the FASB sees the
GAAP as the basis of their approved accounting methods and practices.

The main purpose behind the generally accepted accounting principles is to
make the entire financial reporting process a lot more transparent and easier



to handle on all ends of it: the business development side, the accounting
side, and the regulatory side. When the best practices are standardized, it is
easier for both internal stakeholders and external parties to make sense of
their records and their businesses’ evolution.

The GAAP were born out of a simple need: that of ensuring that people
who want to invest in a company have access to a set of reports that are
truthful, standardized, and reflect the true reality of what is going on in that
company.

As such, respecting the Generally Accepted Accounting Principles is not
even a matter of regulation only; it is how you can do your job the best way
there is.

The Underlying Principles behind GAAP
The Generally Accepted Accounting Principles are a set of guidelines
accountants are strongly encouraged to follow. There are a total of 10 such
guidelines, and most of them revolve around separating the transactions of
an organization from the transactions of its owners, making all the currency
units used in reports look standardized across the entire field, and,
ultimately, making the entire process of financial reporting more transparent
both for internal stakeholders and individuals that might be looking into
making investments in a company (from the exterior).

The GAAP were built on two main pillars, as follows:

●       The rules and standards FASB (the Financial Accounting Standards
Board) issued, as well as the rules and standards issued by the
Accounting Principles Board (which represented a primordial form
of the FASB). The norms emitted by FASB are regularly updated
and they are based on best practices that have been tracked ever
since the major stock market crash of 1929 (the same one that
started the Great Depression).



●       General industry practices. In general, it cannot be said that there is
a GAAP model that is absolutely followed by all the organizations,
in all the industries. Some businesses follow best practices
connected to their industry, for example, because it makes more
sense to follow guidelines that are specifically adjusted to the
complexities and specificities of a specific area of business.

In addition to these two pillars, the Generally Accepted Accounting
Principles complete the entire landscape and allow accountants and
bookkeepers to go above and beyond for the companies they work for.

The History of the Generally Applied Accounting Principles
Regulatory standards are never much fun, if we have to be completely
honest. Regardless of what industry they might happen in, regulations tend
to constrict and make people anxious.

And yet, having no regulatory standards means absolute chaos. Anarchy, if
you want to put it this way. If we are talking specifically about the
accounting/financial industry, picture a world where all companies could
present their financial information whichever way they want -  in terms of
structure, format, and in terms of content.

It would be, without a doubt, a world where nobody knows what to invest
in anymore, precisely because all companies would present their financial
information however they want best, in the most ideal light.

If you think that’s not that bad, think again. The Great Depression at the end
of the 1920s has been largely attributed to this type of behavior and to this
type of lack of standardization in the accounting and financial world. If it
were to happen again, it would be even more of a catastrophe, especially
now with a globalized economy.

In response to the disaster of the Great Depression, both the federal
government and professional accounting groups set out on the course of



creating standards financial professionals would abide by.

There have been numerous changes in the Generally Accepted Accounting
Principles (including their name), but the essence of why they were built has
always been about protecting both investors and companies, both the
general public and the internal stakeholders, and, overall, creating a safer
world for the financial pros as well.

Although used in their different forms and with adaptations that incorporate
the specificities of a particular industry, the Generally Accepted Accounting
Principles are nowadays used across all the 50 federal states.

Internationally, there is a different set of guidelines accountants should use -
but up to this point, there hasn’t been a consistent set of guidelines that are
considered to be universally true and tested. This is largely due to the fact
that the international financial community has many intricacies that are
difficult to encompass in a set of rules and/or principles. However, constant
efforts are being made in that direction, and for this reason, we will discuss
matters related to the internationalization of the accounting standards as
well.

The Ten GAAP You Should Know
As mentioned before, there are 10 Generally Accepted Accounting
Principles you should know. Each of them has its own particularities and
intricacies, but since this book is about QuickBooks, and not accounting in
general or the accounting principles in particular, we will move through
them quite quickly.

The purpose of this relay is to help you understand just how useful it is to
use a proper software application when it comes to handling the “numbers”
behind your company. The more automated these processes are, the more
standardized they can be - and as such, the more compliant with GAAP and
the current legislation they can be as well.



The Principle of Utmost Good Faith
This principle was actually borrowed from the Latin expression “uberrimae
fidei”. Used in the insurance industry and not exclusively, the idea of
“utmost good faith” (or, as it would translate literally “the most abundant
good faith”), this accounting principle is about precisely what it sounds:
complete honesty.

In other words, all reporting has to be done according to this principle. It
has to be sincere and honest. It has to be accurate and true to the reality of
the fact. It does sound like a good idea, but remember that especially these
days, there are actual methods that can be used to determine if something is
not right or doesn’t add up.

The Principle of Regularity
According to this principle, accountants and bookkeepers have to agree to
abide by the GAAP in a consistent, regular manner. They cannot use the
GAAP for one set of reports and then change it up to another one overnight.
Everything has to be consistent, so that investors can compare the facts in
different reports and make the best decision for their endeavors.

The Economic Entity Assumption
Whenever necessary, financial records must be separate for each of the
economic entities involved in a business. For instance, one can define the
following as “economic entities” from a financial point of view: school
districts, churches, businesses, and so on.

Accountants can combine accounting information from multiple entities,
but every economic event should be clearly associated with one of them.

Furthermore, the same principle dictates that business records should never
include the personal assets or personal records of the owners of a company.
This might go without saying to many people, but when running a (very)
small business, for example, things can fairly easily slip out of control.



The Monetary Unit Principle
Accounting records are to include quantifiable transactions only.
Sometimes, certain actions can reflect on the benevolence and on the
potential success of a company, but they are not actually quantifiable.

For instance, hiring a new Marketing Director will definitely have an
impact on your business’ success, but it is not something you can actually
include in financial records and statements (and as such, they should be
presented as separate pieces of information to investors).

The same principle says that all the accounting records have to use the same
currency. For instance, if you are a business in the United States, you will
most likely use USD for your transactions. Even if you do work with
external companies and pay them in, let’s say, euros, your financial
statements should only include the currency you have set as stable (USD, in
this case).

The Full Disclosure Principle
A company’s financial statement will include information about its past
performance, in most cases. However, if there are any situations an investor
should be aware of (such as pending lawsuits, transactions that are not
completed yet and cannot be included in the statements, and so on), they
should be fully disclosed.

One of the main ways to do this is by including them as footnotes to the
financial statement.

The Time Period Assumption
This principle says that there must be artificial time periods in reports. At
the same time, these time periods make accountants feel confused as to how
some elements should be reported. For instance, if you run a farm and you
acquire a new tractor, it might look like your farm is losing money if you
report this purchase as part of a year’s costs (when, in fact, you have



calculated that you will be using the same tractor 10 years from now as
well).

According to the time period assumption, the accountant has to set a time
period and report according to it, at all times.

Accrual Basis Accounting
There are several types of accounting, and accrual is one of them. Usually
laid in opposition to cash based accounting, accrual accounting means that
both revenues are recorded when they are actually earned, respectively
when the expenses are billed, but not necessarily paid.

Basically, in accrual accounting, you can record money even if you don’t
see it in your accounts just yet (or out of them, when it comes to expenses) -
as opposed to cash based accounting, where records must be made when
money reaches the account, respectively when money has exited the
account.

In GAAP, accrual basis accounting is recommended.

The Revenue Recognition Principle
According to this Generally Accepted Accounting Principle, all revenue is
recognized when the delivery of the product has been done (or when the
service has been completed, in the case of service-based businesses).

For instance, if you sell carrots and you have a supermarket that wants to
buy three tons of carrots from you, you can record the revenue the minute
you have delivered the carrots and you do not necessarily have to have
received the money from the supermarket yet to consider this as part of
your revenue.

The Matching Principle
As per this principle, bookkeepers have to record cost-related numbers in
costs at the same time as they record the revenue. For instance, if you have
a very large stock of a certain pair of shoes and you sell half of them, they



will move from inventory (assets of the company) into revenue. Following
the Matching Principle here means that you can safely transfer items from
one type of record to another, knowing that they are correctly transferred
and that the records still remain true.

The Cost Principle
As per this principle, assets are meant to be recorded at the value they had
at the time of their acquisition. Most times, you will find assets that either
appreciate or devalue over time, and following the Cost Principle helps
accountants know what the numbers on paper mean and how to put them in
relation to other items.

The Going Concern Principle
This principle says that all reports are prepared with the underlying
assumption that the business they belong to will be in business for an
indefinite amount of time in the future. As such, nothing needs to be rushed
(e.g. assets do not need to be sold at low values and debt does not have to
be paid before term).

The immediate consequence of following this principle comes with the
classification of assets and liabilities as either short-term (which are to be
held for less than one year) or long term (which are to be held for more than
one year)

The Principle of Conservatism
According to this principle, accountants have to use their judgment when
they record transactions that might need an estimation. For instance, when
new equipment is purchased for the company, the number of years that the
equipment will remain productive is a matter that requires estimation.

According to the Principle of Conservatism, accountants will use the less
optimistic estimate when two options are available. This ensures that there
will be no overestimation in the records and that things will be handled
according to the less optimistic version.



The Materiality Principle
According to this principle, there are records that are considered to be
immaterial - such as, for example, tracking how many paper clips the office
uses. As such, accountants can ignore any of the aforementioned principles
if doing this does not have any kind of effect on the users of financial
information.

Rule-Based Accounting vs. Principle-Based Accounting
There is an essential difference between rule-based accounting and
principle-based accounting, and it is something you definitely need to be
familiar with as an accountant, bookkeeper, or financial expert.

In principle based accounting, expert bodies suggest policies, which should
be followed by the companies who abide by this system of principles. If the
company fails to follow these policies, they will have to provide a
reasonable explanation for deviating from the standards. For instance, the
IFRS (International Financial Reporting Standards) are a principle based
system. This system is used internationally in approximately 120 countries.

On the other hand, a rule based accounting system is all about, well, rules.
They do not put out suggestions or policies, but actual rules that have to be
followed as such. Every company that abides by these systems has to
comply with all the regulations and should not deviate from them. Despite
the name, GAAP is generally considered to be a rule based system - one
that is used preponderantly in the USA.

There are several points that come as a direct consequence of following a
rule based or a principle based accounting system. The most important ones
are the following:

●       In the case of principle based accounting, the decisions made by the
accountant will be made not only based on the loose set of
principles and guidelines provided by the system, but also based on



their own judgment. On the other hand, in a rule based system, the
rules need to be obeyed in all situations (as such, restricting the
accountants and their expertise).

●        In the case of a principle based accounting system like the IFRS,
the accountants (as well as the auditors) can only apply their
knowledge of accounts to choose whether or not they apply the
IFRS or not. In the case of GAAP, however, financial specialists
have no wiggle room - they cannot change the rules and they should
obey them strictly. This means that, when the accountants follow
the rules and they prove to not be in the best interest of the general
public, the company can blame the rule system in the case of a
lawsuit.

●       As you may have figured out already, a principle based system is a
lot more flexible for companies because it allows them to adjust the
principles to the specificities of the company. At the same time, rule
based systems do not offer this option to companies, and the rules
must be obeyed as such, even when it is neither in the interest of the
business nor that of the public.

●       GAAP (the main rule based system) is mostly practiced in the US,
while IFRS’s system has been adopted in 120 countries on the
planet. In general, both governments and businesses prefer the IFRS
code of conduct precisely because it allows them to be a little more
adaptable, according to their business’ needs and how they progress
in time.

●       Last, but not least, it is important to note that both principle based
and rule based systems promote standardization (meaning that once
a company has settled on a set of rules, they are to follow them).
However, this is still being worked on and lack of consistency is
still an issue, particularly in the case of principle based systems.



Since GAAP and other rule based systems are a lot more rigid, this
is not as much of a problem in their cases (and thus, in the case of
the United States).

The bookkeeping framework is quite different in IFRS and GAAP. More
specifically, these are some of the notable differences you should be aware
of:

●        Stocks are recorded differently. In the case of IFRS, LIFO (last
units in first units out, a system in which the company records the
last units that were purchased as the primary units they sold) is not
possible. However, LIFO is actually possible in the case of GAAP
and companies can decide between LIFO and FIFO (first units in,
first units out).

●       In IFRS, improvement expenses can be promoted, but they have to
be considered costs in GAAP.

The list can go on and on. In essence, both types of systems follow a single
goal: to promote transparency and honesty in financial reporting. The
quintessential differences between a system like GAAP and one like IFRS
make them look like the opposing forces of the same spectrum.

However, the need for a universally accepted set of rules has grown to be
more and more poignant in the latter years, especially under the influence of
an economy that is more and more globally connected.

What the future brings for both GAAP and IFRS, however, is still a mystery
and, in some ways, a source of stress and anxiety for accountants on both
sides of the Pond.

Different Approaches to the Accounting Principles
Accounting principles are meant to help companies be more transparent
(and help the general public by protecting them from issues that might
ensue as a result of dishonesty, for example).



In general, the GAAP and the IFRS standards are viewed as the two main
options companies can take in keeping their records clean and ensuring that
their money reporting is clear and transparent.

Indeed, at the moment, these two sets of rules and principles have been the
two best options due to the comprehensiveness of their use, as well as the
widespread use. These guidelines make companies play by similar
standards and produce fiscal reports that can be read and understood a lot
easier by people from the exterior of said companies.

Beyond the Generally Accepted Accounting Principles and even beyond the
International Financial Reporting Standards, though, there are companies
who, for one reason or another, cannot and do not want to follow the pre-
established criteria of best practices in accounting.

As such, OACBA (Other Comprehensive Basis of Accounting) was born,
and it has been gauged by both the American Institute of Certified Public
Accountants  (AICPA) and by the International Accounting Standards
Board (IASB).

Commonly used by small to medium businesses more than other types of
businesses, OACBA allows these companies to adhere to a system of
accounting standards that is a bit more suited for their needs.

Furthermore, you should also consider the fact that there is an IFRS Light
version created by the IASB, and it is similar to the regular IFRS, but
brought forward in a minimized form. Now more than 10 years in age, the
IFRS Light is acknowledged in a lot of places and it might be a solution for
those who cannot follow the GAAP rules for one reason or another.

By comparison, IFRS Light contains only 230 pages of guidelines, while
the official length of the GAAP in the US is of no less than 20,000 pages,
making it virtually impossible to know everything by heart (and thus,
making sure that you abide by said rules in totality).



In addition to that, AICPA has created standardized models for small to
medium businesses as well and it is aiming to create a set of principles that
are less difficult to follow for SMBs than the GAAP system is.

It is very important to mention that, although outside of the normal GAAP
specter, OCBOA rules are still legally accepted. According to the
Statements on Auditing Standards, an OCBOA can be considered any of the
following:

●        Statutory bases of accounting (such as, for example, the one used
by insurance companies when under the state insurance commission
rules)

●       Income-tax-basis statements

●        Cash basis or, in some cases, modified cash basis financial
statements

●       Any financial system that has been prepared using a pre-established
and definitive set of criteria that is supported by accounting
literature and can be applied to all the material items that are
reported in the financial statements.

Do keep in mind that OCBOA should not be seen as a way to deviate from
the GAAP and do whatever you please, but that even outside of the
Generally Accepted Accounting Principles, there is a world of principles
that must be adhered to. For instance, OCBOA regulatory systems should:

●       involve professional standards

●       provide the option of audits, compilations, and reviews

●       disclose their basis of accounting

●        title all the statements in a way that distinguishes them from the
GAAP basis titles



●       disclose information the same way as the GAAP rules request it

●        ensure that any changes in the rules do not affect the rules so
extensively as to create a GAAP basis with departures (so, a GAAP
that is adapted to the sole needs of the company, for example).

Given that you consider working with QuickBooks for your accounting, it
is likely that you have a small to medium business (or that you work for one
in case you are an accounting professional). As such, it is recommended for
you to look beyond the Generally Accepted Accounting Principles, which,
no matter how widespread and easy to understand they might be, are still
insufficient and inadequate in many cases.

Double-Entry Bookkeeping and What It Means
The last part of our first chapter is dedicated to helping you understand
double-entry bookkeeping and everything it entails for you as the
accountant and/or bookkeeper of the company.

Double entry bookkeeping is a method used by bookkeepers to ensure the
accuracy and correctitude of the data they enter in their bookkeeping
systems. The need for such an approach arises especially when businesses
develop and the probability of making mistakes in bookkeeping becomes
higher as well. Although a double entry bookkeeping system cannot keep
you 100% safe from mistakes, it can lower them quite a lot and allow you
to double check if anything wrong might have slipped in.

The double entry bookkeeping system is not new in any way, and it
developed in the times when Eurpeans did a lot of trade, precisely because
human error could have led to major issues.

Basically, what happens in the double-entry system is that the transactions
are to be recorded in two accounts: the debits one and the credits one. When
a transaction is recorded in a debit account, it offsets in the credit one. As
such, when summed up, all the debits must be the same as all the credits.



This allows bookkeepers to double-check their statements and ensure that
they are accurate and error-free.

There are different types of accounts, all of which are based on different
types of transactions. In general, a business transaction in accounting can be
considered to be any interaction between two or more economic entities
(such as, for example, between customers and businesses or between
vendors and businesses).

There are seven types of accounts: liabilities, revenue, gains, expenses,
losses, equities, and assets. A bookkeeper and an accountant’s job is to
record and track the changes in every account and ensure that the economic
events have been correctly registered.

When you want to use the double entry bookkeeping method, you need
several types of records:

●       An asset account, which records the sum of money associated with
what a business owns (e.g. the equipment that has already been paid
for)

●       A liability account, which shows what the company owes (such as a
mortgage for example)

●        An income account, which shows the money a business receives
(e.g. sales revenue)

●       An expense account, which shows the money a business uses (such
as payroll costs, for example)

Accounting software can usually help accountants and bookkeepers with
the double entry bookkeeping method because they are intentionally built
around it. QuickBooks qualifies here as well. Without this feature, it would
be quite difficult for the financial expert to track basic information (such as



the inventory, for example) and prepare it for tax records and end of the
year statements.

When you set up the software, you will have to configure the generic chart
of accounts the business uses at the moment, so that the software can work
with them and implement the double entry bookkeeping method.

To help you better understand how the double entry bookkeeping method
works, imagine the following example. If you own an eCommerce business
and you will record sales revenue worth $200, you will have to make two
main entries: $200 going into the “Cash” account as debit and another $200
going into the “Revenue” account as credit.

If, however, you have to borrow money from a financial institution, you
will have to enter the purchase you make with that money in both your
assets account and your liabilities one. When brought face to face, the two
accounts will basically show the same economic event, but from two points
of view: that of increasing the assets and that of increasing the liability as
well.





Chapter 2
 



Bookkeeping with QuickBooks

Quickbooks is one of the most popular accounting and bookkeeping
software programs out there, and not without reason. Comprehensive, easy
to use, and reliable, QuickBooks is the kind of investment that will pay off
in every respect.

Before we jump into the actual details on how to use QuickBooks, we
would first like to take the time to underline an important difference: that
lies between bookkeeping, accounting, and financial expertise.

In essence, a bookkeeper’s job is to identify, record and measure financial
information (what comes in, what goes out, and so on). An accountant’s
job, on the other hand, is a bit more complex and it can have more extended
consequences. Accountants summarize and interpret financial transactions
and their input can sometimes lead to important financial decisions that
have to be made.

Last, but not least, financial experts (or financial analysts as they are more
frequently referred to) step it up a notch: they do not only analyze the
current data, but make future predictions based on a variety of factors as
well.

The good news is that QuickBooks can help all levels of financial expertise,
from bookkeepers to accountants and more. In this book, we will take a
closer look at bookkeeping and accounting with QuickBooks (but do keep
in mind that all the data QuickBooks stores and helps you manage can help
you elevate everything to a new level as well).

Invoices



Not all invoices are created alike, and as such, this software will allow you
to create an invoice form that is coordinated with the specific requirements
of your business. For example, if you sell products, your invoices will have
to include the description of the sold products. However, if you sell
services, your invoice will have to correctly describe what you sell.

QuickBooks is pretty amazing at allowing you to create invoices that fit
your business mechanism and what you actually do on the market - and all
of it with fair ease of use.

To start creating invoices in QuickBooks, you will have to first go to the
window that says “Create Invoice”. To do this, go to Customers and then
Click on Create Invoices. Once you click there, you will be prompted with a
window that includes a form template drop-down list in the top right part of
the screen.

From there, choose the type of invoice form that suits your needs (product
invoice, service invoice, etc.). Pick your invoice and take a look at how it
looks (the software will redraw the Create Invoice window to show you a
preview of how your template looks).

There might be cases when your invoice doesn’t fit the template, and in this
case, you will have to create a new type of invoice that suits your needs. To
do this, start with one of the provided templates and customize it to your
needs. To do this, simply choose a template (whichever is closer to your
specific needs) and then click on the Customize button on the Create
Invoices window (keep in mind that you might have to maximize this
window to see the Customize button properly).

If you still want to keep the initial template, choose one and click on
“Copy”. This will duplicate the existing template and it will allow you to
make your custom arrangements on the copy, leaving the initial pre-created
template intact.



How to Customize Your Invoices with QuickBooks
QuickBook allows you to customize your invoices in a multitude of ways.
We will list below some of the most important and most commonly used
ones, so that you can take your pick when you want to customize invoices
in this accounting software.

●        The Logo. Some companies prefer adding a logo of their business
to the invoices because it helps them with branding efforts and
creates a certain type of imagery in the mind of the person who sees
the invoice. To add a logo to your QuickBook invoice, simply check
the “Use Logo” box in the window. The software will take you to a
dialog box where you can select your chosen image (the actual
logo).

●        Add Color. Likewise, you can also add different colors to your
invoices (to make them more in tune with your brand, for example).
To do this, simply choose the color scheme you want to use from
the drop-down box in the window and click on “Apply Color
Scheme” when you are ready.

●        Change Fonts. Same as you can change colors and add logos, you
can change the fonts on your invoices as well. To do this, you will
have to simply select the text on which you want to apply the
change and then click on the button that says “Change Font”.
Immediately, QuickBook will display a dialog box from which you
can select your font, font style, and font size. Once you have made
your selection, simply click on the “OK” button and the changes
will apply to the selected text.

●        Adding Company & Transaction information. This feature will
allow you to show the receiver of the invoice the most important
information. As mentioned before, different needs require different
types of invoices, and this QuickBooks feature is golden precisely



because it allows you to customize the information that goes on the
invoice. To get here, simply select the box that is connected to the
piece of information you want on your invoice. For instance, you
can select the “print company name” information and it will appear
on the invoice. When you check this box, the software will prompt a
dialog box that allows you to edit and update your company name,
as well as other pieces of information related to it (address, phone
number, and so on).

That’s basically it! Play around with the invoice side of QuickBooks and
you will discover plenty of options you can use to adapt these invoices to
the specific needs of the business. Other elements you can customize in the
same way include:

●       Header information

●       Columns information

●       Footer information

●       Print information

Additionally, you can use the Layout Designer tool offered by QuickBooks
to customize the layout of your invoice as well. This might be helpful, for
example, when you want a certain piece of information to show first on the
invoice.

To actually send an invoice to a customer, you will have to use the same
window. The basic steps of sending the invoice are:

1. Identify the customer and the job

2. Confirm or edit the header information

3. Confirm or edit the invoice field information

4. Describe the items that you are selling



5. Include a message for the customer by using the Customer Message
box (which you can find at the bottom of the screen)

6. Click on Save & Close or on Save & New, depending on what you
want to do (close the Create Invoice window or create a new
invoice)

Payments
Sending POs is essential to every business, and these little sheets of paper
have a very simple and straightforward purpose: they tell the vendor that
you want to buy an item from them.

A PO is, in many ways, a pre-contract to the purchase.

If you have a very small business, you won’t need to send purchase orders.
But when your business grows a bit past the small mark, you may decide to
use POs for the simple reason that they are a way for you to track the items
you have ordered.

Furthermore, a purchase order adds a formal note to the purchasing process
of a company, which limits the amount of spending management can make
without further approval or at least without formalizing the purchase. For
example, you have the option to decide that nobody in your company can
buy anything beyond $50 if they do not have a purchase order.

As it is expected from an accounting software, QuickBooks allows you to
create purchase orders. To do this, you must first go to Vendors and then
click on “Create Purchase Orders). This will prompt a window which you
will use for the PO. In some cases, you might find that your Vendors menu
does not have this option. In this case, it means that you need to configure
your QuickBooks a little because it sometimes comes as “default” without
the option of sending POs.

To do this, go to your Edit menu and then click on “Preferences”. Next,
click on “Items & Inventory” and then click on the tab that says “Company



Preferences”. Check the box that says “Inventory and purchase orders”, and
then click on “OK”. This will activate the PO option in your QuickBooks
and you can use it as you normally would.

Going back to sending POs, once you have selected the “Create Purchase
Orders” option from the Vendors menu, you will simply have to use the
drop-down menu to select the vendor to whom you want to send the PO. To
add new vendors to your list, go to the Vendors menu, and then click on
“Vendor Center”, then on “New Vendor” and proceed to adding the new
vendor.

Once you have selected your vendor, you will have to select the Class from
the drop-down list (this will categorize the type of vendor this PO belongs
to).

The Ship To drop-down list will allow you to select the address you want to
send the PO to. This list will include the customers, vendors, and the
employees as well, so remember to select the right one. Once you select the
person or entity, the software will automatically fill in the spaces with the
necessary information.

Once you have selected the correct address, you will have to confirm the
PO date and the PO number and then move on to confirming the vendor and
address information once more. These might seem like “extras” you don’t
need, but given that there is financial information in the middle, you
definitely want to make sure that everything is correct.

Next, you will have to confirm each item you are ordering. This includes
the actual name of the item and its description. The options you have in the
description section include the following:

●       Quantity

●       Rate



●       Customer

●       Class

●       Amount

Once all this is done, you can just move on to printing and saving the PO
(to add it to your records and allow the software to pick it up as part of the
data your accountant (or you) will work with during the reporting process.

Inventory and Items
Managing your inventory can be quite difficult when you have a million
other things to do, but fortunately, accounting and bookkeeping software
like QuickBooks can help with this.

If you choose to use QuickBooks for your inventory as well (which you
should because it allows you to roll all of your bookkeeping tasks into one
place), you have multiple options on how you can see the inventory
information. 

If you are looking at the Item column in the Create Invoice window, for
example, you will see a drop-down list. This will allow you to see the items
in your inventory so that you can add them to the invoice.

Another way to look at the items in your inventory is by going to the Lists
menu and then choosing the “Item List” command. This will display the
special Item List window, which allows you to see the items in the
inventory, along with their code, their description, the types of items they
are, the account that is credited when you sell these items, and so on.

The same window will allow you to easily see the stocking levels and
prices. If you want to learn more about an item all you have to do is double-
click it. When you do this, the QuickBooks software will pop a window that
says “Edit Item”. You can use this to see information about the item or to
change bits of information about it.



To add an item to the list, you simply have to go to Lists and then click on
the “Item List” command. This will display the window called “Item List”.
If you select the Item button (which you will find in the lower left side of
the window), QuickBooks will display a menu. Click on New Command
and it will automatically prompt the New Item window.

In this new window, you will see a bunch of boxes which you can use to
describe the item you want to add. First, you will have to select the type of
item you want to add (your selection here will prompt new boxes in the
window so that you can describe the item appropriately). Once you are done
describing the item, it will automatically add itself to the inventory list.

You can also add items more quickly, from other windows. For instance, if
you are in the Create Invoices window or in the PO window, and you
realized you need to invoice or PO for an item that is not in the list, you can
simply click on the drop-down box called “item” and select the “Add New
Entry” option. This will allow you to display the New Item window and
proceed with adding the item as per usual.

Also keep in mind the fact that QuickBooks will allow you to add different
types of items that suit your business model. For instance, you can add a
service item or a product item, depending on what you sell or what you
want to PO for.

Furthermore, the software will also allow you to add non-inventory items.
These items are items you are selling but do not necessarily want to add to
your inventory. Furthermore, you can also describe items with a specific
sales tax code, which will allow you to track and see if and how much tax
the items are subjected to.

Overall, there are a lot of things you can do in QuickBook when it comes to
inventory and items. Setting them straight from the beginning will allow
you to easily navigate other functions of this software, but even if you



forget about something or if it pops up unexpectedly, you can still add it on
the go.

Additionally, QuickBooks is quite amazing at allowing you to adjust the
item count and values as well, and all you have to do is edit an item and
select whatever bit of information you need to change.

Last, but not least, QuickBooks will also allow you to create inventory
patterns that are suited for your specific type of business. For example, if
your business is in manufacturing, you will need inventories for both the
parts that make the products and the products themselves. In QuickBooks,
keeping these separated and connected between themselves is easy because
the software will allow you to branch out the items list and make them as
comprehensive or complex as you need them to be.

Cash and Account Management
The most essential way a business will proceed with their cash and account
management is by writing checks - either to pay bills or to pay employees,
for example. There is a specific window in QuickBooks that deals with the
recording (and, when needed, with the printing of) checks.

The way you access this window is by going to the Banking menu and
selecting the “Write Checks” window. To actually write a check, you should
follow these steps:

1. Go to the drop-down list called “Bank Account” and pick the
correct account on which you want to write the check.

2. Identify the number of the check by using the “No (check number)”
field. You can leave this field empty as well (such as, for example, if
you don’t know the check number). If you want to print the check,
remember to check the box “To Be Printed”. This will appear in the
middle of the “Write Checks” window.



3. Select the correct date for the check, which you can enter in
mm/dd/yyyy format, in mmdd format, or in m/dd format, as you
wish. QuickBooks will automatically transform it in the
mm/dd/yyyy format for the purpose of consistency.

4. To identify the entity to which you are paying the check, fill in the
Pay to the Order of field. If this is the first check you are writing for
that person or entity, you will have to manually fill in their name in
the field (and the rest of the data will be pulled from the database).
If you have made a payment to this person or entity before, you will
simply have to click the arrow you see on the right side, right next
to “Pay to the Order of” and select the correct payee from the list
that will be prompted.

5. Add the check amount in the dedicated field.

6. Include an address. This step is optional, if you want to include the
payee’s address, but you can skip it as well. If you have entered an
address to be associated with this payee in previous checks,
QuickBooks will automatically pull that information. Pay attention
if you want to include a different address this time - you can do it
simply by just clicking the edit button for the address and update
whatever QuickBooks pulled from the database. In general, though,
you will only want to include the address when you are printing out
the check and you want it to show through the address window of
the envelope.

7. Include a memo. If you want to add any kind of additional
information, you can use this option. For example, you can use the
memo option if you want to print the check and if you need some
space to identify the account number or the invoice number the
check is associated with. However, in most cases, memos are mostly



useful when you print out the checks (which happens quite
sporadically these days).

8. Check the Online Payment option. If you want to make the
payments through online banking, you can select this option in
QuickBooks and allow it to automatically send the payment through
your online banking option. Basically, what QuickBooks will do is
send the information on the check to your bank and they will handle
it from there.

Keep in mind that, to be able to do this, you will first have to make
sure you set up your online banking integration with QuickBook. To
do this, go to your Banking menu and select “Online Banking”, and
then click on “Set Up Account for Online Access”. This will guide
you through the entire process of setting up your online banking in
QuickBooks.

Do keep in mind that you should first call your bank and see if they
offer online banking options and if so, how you can access them.
These days, almost every financial institution has this option and
almost everyone can access their online banking account in a matter
of seconds, but if you have never done it before, it’s better to be safe
rather than sorry.

If you want to transmit the payment instructions to your bank, go to
the Banking menu, select Online Banking, and then click on the
“Send” button. This will prompt the software to ask for the PIN
number (which you should enter in the right field.

9. Connect the check amount to the right account (expense or asset). If
this check is particularly directed at a specific expense or purchase
of assets, you should click on the “Expenses” tab. The software will
then prompt a process that will allow you to identify the account
and the amount the check will pay for.



If you don’t want to make things complicated with the Expenses
tab, you can also use the memo option to offer a memo description
of that line of expense.

Also, keep in mind that if your check is paying for multiple types of
expenses, you should add different lines in the Expense tab for each
of these. Furthermore, if you want to use this check to buy an asset,
the Expense tab will not automatically show an expense account,
but an asset one.

10. Enter a description of the items your check will buy. The software
will show you different elements that you might want to describe
here.

11. Once you have described the check and the reason you are writing
this check, you can either click the “Save & Close” button or the
“Save & New” one, depending on what you want to do. The first
button will save the check and close the window, while the latter
one will save the check and bring you back to the Write Checks
window so that you can start it all over again. There is also the
option of not saving the check at all (case in which you should use
the “Clear” button).

12. If you want to print the check, simply click on the “Print” button. If
you want to print multiple checks at once, record all of them and
click on the little downwards arrow next to the “Print” button. From
there, you can select “Print Batch” , which will prompt you with a
list of checks you want to print.

Of course, there are many other cash and account management tasks you
can use QuickBooks for, but the reason we elaborated the checks part a
little more is because it is one of the most commonly used features in this
accounting software.



Other things you can do in this area with QuickBooks include the
following:

●        You can make bank deposits (by going to Banking and then
clicking on “Deposits” to follow the process)

●       You can transfer money between different accounts

●       You can use the Register menu to work with checks, deposits, and
account transfers. This window will look similar to a normal paper
register you use in a bank to record different checks or deposits, for
example.

●       You can reconcile a bank account

As you have probably learned by now, QuickBooks is quite intuitive, which
makes it more than useful for a wide range of people and businesses. Even
if this is your first time touching an accounting software, chances are that,
once you learn the basics, you will find QuickBooks to be very user-
friendly and easy to use.

Paying Employees and Suppliers
Without the employees that work in your company, there would be no
business - the production will stop and the very essence of what you
provide as a business on the market would cease to exist.

Paying employees and suppliers is a very important part of the bookkeeper
and accountant’s job - and as such, QuickBooks will allow you to do it from
their system directly, in a way that is as easy and as automated as possible.

There are three main options when it comes to paying employees:
●       Standard DIY Payroll
●       Enhanced Payroll
●       Assisted Payroll



We will discuss the DIY option more, as it tends to be more suitable for
small to medium businesses precisely because it doesn’t charge a lot for
payroll processing (although you will have to do quite a large part of the
work yourself in this case). Plus, the other two options will place most of
the work in the hands of the employees at QuickBooks, so it doesn’t make
much sense to explain here what they will do for you. If you have the
financial resources to do this and if you want to free up time for yourself or
your bookkeeper, definitely go for the latter two options. If not, however,
we are more than certain that you will manage the DIY path as well.

The Enhanced Payroll will enable Intuit (the company that makes
QuickBooks) to run your payroll tasks and provide all the information you
need to your QuickBooks data file.

The Assisted Payroll, on the other hand, will behave like external payroll
services (such as Paychex, for example).

Going back to the DIY route, you will have to go to the Employees menu,
click on “Payroll”, then on “Order Payroll Service”. This will prompt
QuickBooks to display the “Payroll Setup Web Page”.

From here you will first have to select the payroll option (Standard, in case
you want to take the DIY route). Please do keep in mind that this route
means that you have to understand federal and local taxes related to payroll
and that you will do the actual work yourself. What QuickBooks will help
you with here is to ensure that your work is standardized for all payrolls and
that it feeds into the data collection system behind the software. Aside from
this, this payroll option is as old-school as it gets.

Once you have selected the payroll option, you will be taken to a web page
where you should fill in the information QuickBooks requires: business
name, business address, the firm’s employer identification number, and
credit card information (used by Intuit to bill you for the payroll service).



Once you do this, you will simply have to place your order by clicking on
the button. You will then move through the signup process, and you will
just have to follow the instructions on screen to proceed further.

The entire process will ask you important questions, some of which include
how you pay your employees, and so on. Our advice is to make sure you
read all instructions very carefully because it will be very important from
now on. It does take a bit of time to attentively move through everything,
but it is best to spend this time now, rather than notice any kind of mistakes
later.

Once you have set up the information for the payroll, you will have to set
up the employees in the system. This will be done via a web page
QuickBooks will prompt where you can add your employees. To add new
employees once the signup and setup process is done, go to the Employees
menu, then click on “Employee Center”, and then on the “New Employee”
button. This will lead you to a new window, which is especially dedicated
to adding new employees in the system.

Once you get this new window, go to the Personal tab and describe the
employee. Here, you will be required to enter some pretty basic information
such as their names, middle initials, and so on. If you want to add more
information about the employee (such as their bank account in case you are
paying them via direct deposit), you will simply have to add this
information in the tab called “Additional Info”. This will offer you a Define
Field button to name the new fields that will collect different types of
information about your employee.

The next tab, the Payroll and Compensation one, is used to describe the
ways in which the employee’s salary is calculated. Use the “Earnings” field
to enter the payroll item. If you want to identify the specific pay period, you
can use the Pay Period drop-down in the software. If there are different



classes of payment for your employees, you can also use the Class drop-
down.

The Taxes button is quite important because it will lead you to a dialog box
that allows you to enter what kind of taxes the employee pays. If you want
to find out an employee’s filing status, their number of allowances, and
other bits of information about them, you can use the Federal tab.

If the employee is eligible for certain tax-related benefits, such as Medicare,
Social Security, or earned income credit, be sure to check the appropriate
“Subject To” checkboxes as well. Do keep in mind that not everyone might
be eligible or subjected to these benefits, so it is quite important to discuss
these matters with a tax advisor.

The next Tab in this window is the “State” tab, which is used when you
want to describe state taxes. This tab will vary a lot from one state to
another and it will display differently in the software.

Last, but not least, the “Other” tab will allow you to describe and store any
kind of local tax information you may need to store. For instance, you
might want to store city income tax information about your employees
when this is the case.

You might also want to consider the “Sick/ Vacation” button in this window,
which is pretty self-explanatory. Clicking this button will prompt a new
dialog box, which will allow you to specify exactly how sick or vacation
days reflect on each payroll according to the payroll period. For instance,
you can use this section to enter the number of vacation hours someone can
have and how they are calculated when it comes to the payroll.

Furthermore, the Accrual Period drop-down will allow you to specify how
these sick or vacation days are accrued (e.g. how many hours of vacation
time an employee can have with each paycheck).



In addition to these bits of information, the Standard Payroll route will also
prompt you to schedule your payroll runs. This process will ask you to
describe in detail how you run your payroll (every month? every week?).

Once you have set up the entire payroll procedure in QuickBooks, you can
use it to actually pay employees. This is quite easy, as you will just have to
go to the Employees tab, click on “Pay Employees”, and then on
“Scheduled Payroll”. Since you can create multiple payrolls, you will be
prompted to select the scheduled payroll you want to run (just click on it
from the list that will show up there and follow the instructions on screen,
making sure to double-check each section of the window and what
information you need to enter there).

Last, but not least, keep in mind that you can also manage payroll liabilities
from your account (such as, for example, amounts of money you have to
withhold from your employees’ paychecks). Tax deductions are a pretty
common example here. To pay these liabilities, just go to Employees and
then click on Payroll Taxes and Liabilities, and then on Pay Schedule
Liabilities. Then, follow the form on screen to proceed further with this.





Chapter 3
 



Accounting with Quickbooks

As mentioned before, there is quite the quintessential difference between
the work of an accountant and the work of a bookkeeper. QuickBooks is a
good aid in both situations, as it can help you both do basic financial
tracking and perform more advanced things, such as creating financial
statements and reports, planning a budget, or calculating the cost based on
activity.

This chapter is dedicated to helping you learn more about how you can use
QuickBooks as an accountant, at least at a basic level. Far from aiming to
make this an accounting course, what we want to show you is how to
perform basic accounting tasks using QuickBooks software.

As a bookkeeping software, QuickBooks provides you with every single
feature you may want - and if you deal with your firm’s accounting, you
will find that you too have a lot of benefits to reap from using this
accounting software.

More specifically, QuickBooks will allow you to easily record journal
entries you can then use to create reports and financial statements - and, if it
falls within your range of tasks, to run analyses based on these statements
as well.

In fact, whenever a financial action is taken, QuickBook will automatically
make a journal entry for that. For example, if someone in the company
writes a check, an automatic journal entry will be created for that as well.

There are, however, times when you might have to create a journal entry
even though there was no economic activity per se to associate it with. For
example, you might want to record depreciation or to record the fact that
you have disposed of certain assets.



To make a journal entry in QuickBooks, simply go to Company and click
on Make Journal Entries. This will display a new window (as per the usual
QuickBook way of working) and it will allow you to create the journal
entry. There will be several boxes you need to fill in, such as the date box or
the entry number box, and you will have to fill them in with your journal
entry information.

Once the basic information has been provided, use the General Journal
Entry to record the actual entry by filling in the columns with the
appropriate details. You can use the memo column to enter information
about the type of debit or credit you are using in that particular entry, or any
other “extra” that will help you better manage everything further on.

Before we dive into the specific sections of doing accounting tasks with
QuickBook, we would also want to remind you that there is a special menu
for Accounting & Taxes. To access it, you will have to go to Reports, and
then click on Accountant & Taxes. This is a really golden menu to have at
your disposal because it comes with a series of commands that are quite
useful for accountants. Some of them include:

●        Adjusted trial balance (which will create a trial balance as of a
specific date, and which will show adjusted journal entries as
highlighted).

●        General ledger (which lists the accounts that are recorded in your
Chart of Accounts and then allows you to change the account
according to the month or the year)

●        Transaction Details by Account (which will create a report
containing the transactions that interact with a specific account)

●        Adjusting Journal Entries (which will create a report with all the
entries that have been marked as adjusting)



●        Audit Trail (which will provide you with a list of the transactions
made according to the person who made the transactions, so that
you can identify changes that shouldn’t have been there and who
made those changes as well)

●        Income Tax Preparation (which will provide you with the lines of
which tax forms accounts are being reported)

These are just some of the examples - basically, whatever report you might
need, QuickBooks will provide it to you in just two clicks. Last, but
definitely not least, you can also get an accountant’s copy of the data files,
which you can use for your own reports and analyses as well.

We will dedicate the rest of this chapter to helping you learn, more in-depth,
how to create different financial statements and reports in QuickBooks, how
to use this tool for your budget planning and, ultimately, how to calculate
costs based on activity and how to set up projects to help you in your
endeavors. If you do not handle more advanced accounting tasks in your
company, the following sections may not be of interest to you. If, however,
you are an accountant, you will definitely find them useful.

Let’s roll!

Financial Statements and Reports
As shown in the beginning of this chapter, creating reports in QuickBooks
is quite easy (basically, all you have to do is to operate the Reports menu in
your software). At the same time, it is quite important to keep in mind that
no matter how great a software may be, it is only as good as the data that is
fed into it. As such, you want to make sure that all the information absorbed
by the software is correct.

There are more than 100 types of reports you can find in QuickBooks at the
easy access of a button. Aside from creating the reports, you will also have
the option to modify reports and perform other actions with them.



For instance, if you want to modify a report, you will have to click on the
eponymous button. This will prompt a dialog box that will allow you to
customize in detail the different areas of the report.

Furthermore, other actions you can do with the reports in your QuickBooks
include the following:

●       Memorize Report (which will allow you to memorize or save report
creation settings so that you can easily use them at a later date).

●       Print the report (pretty self-explanatory)

●       Email it (likewise)

●        Export it (in different formats in case you need the reports to be
included elsewhere)

●       Hide the header

●       Collapse

●        Refresh (which will refresh the data in a report according to the
latest information the system has received)

Of all the features, though, the ability to modify a report will be truly
priceless because it will allow you to customize reports according to your
specific needs. This is not only about making your life and your job easier,
but also making the life and job of the person who receives the report a little
easier too.

To modify the report, you have to click the button that says this. As
mentioned before, this will bring forward a dialog box that allows you to
make the changes you need in your report. These changes can be about its
appearance, they can be about its layout, and they can be about the
information it summarizes as well.



This dialog box looks pretty much like every other dialog box in
QuickBooks and as such, if you have learned to navigate this software up to
now, it is very likely that you will intuitively know what to do with the
dialog box in the Modify Report section as well.

This dialog box will show a series of tabs, one of which is the Display tab
which allows you to change the interval date, the columns, and the report
basis. The internal boxes will be filled in with the mm/dd/yyyy format.

You will also see some report basis options buttons, to select if you want to
report on the accrual basis or cash basis (this will be largely dictated by
your chosen set of accounting principles and/or standards). While these
buttons can virtually help you switch between the two accounting bases,
there are further intricacies that prevent you from simply switching them on
and off as you please. QuickBooks is not the kind of software that can deal
with all of this information on its own, so if you ever have to change
between accrual based and cash based accounting, you will have to think of
the ramifications of doing this.

What is this button for, in the end, then? They will simply help you switch
between statements that are cash-centric and statements that are based in the
accrual system. You will still do your accounting the way you did it until
now, but this button allows you to extract data in a different format in case
it is needed for reporting.

In addition to the Display tab, this window will also provide you with a
filter tab. This tab is extremely interesting and useful for you as an
accountant and we definitely recommend you use it whenever you need.

This tab will allow you to set up filters that you can use with your reports so
that you can select the information that will be summarized there. To use
this tab, you will first have to select the field on which you want to use it
and then select your filtering rules (e.g. you can filter based on the
information in the account or any other criterion).



Some of the other filtering choices you have here are to filter the
information based on income or expense accounts, ordinary income or
expense accounts, ordinary income and COGS, and so on.

Budget Planning
In layman's world, budgeting is that horrible thing that prevents people
from buying new pairs of shoes and video games.

In the world of accounting, budget planning is a lot more difficult. In fact
there are entire books written on just this and while we do not plan to
compete with these sources, it is worth mentioning some of the most
important types of budgeting you can use:

●       Top line budgeting, which means that you will take the budget you
had last year or last month (if you do your budgeting on a monthly
basis) and use it as a basis for this year’s or this month’s budget.
Since inflation has to be taken into consideration, a top line budget
will have to adjust accordingly. Likewise, if the business has not
grown, if it has shrunk, or if it is in recession, the numbers will have
to be adjusted accordingly as well.

Many specialists are not fans of top line budgeting because it seems
to work in the past, rather than the future. There are some benefits
to picking this option, though - such as the fact that it is easy and
that it is based on real facts that you already have plenty of
information on.

●       Zero based budgeting, which is pretty much the opposite of top line
budgeting. If top line budgeting deals with past numbers and adjusts
them to present situations, the zero based budgeting option will
work from the bottom up. Basically, it will start with elements such
as individual revenue, liability, or the equity accounts of an owner.
The most important advantage of this type of budgeting is that it
usually fixes previously budgeted amounts. Furthermore, this



budgeting method is largely helped by mere common sense and
simple arithmetic, which can prove how large a budget the business
can allow for certain items.

On the other hand, zero based budgeting is only as good as the
information upon which it is built. For example, if you used 1,000
stacks of white paper last year and you do not expect the business to
grow in that sense this year (or you plan on removing paper this
year and taking the eco-friendly path), you might estimate that you
need 1,000 stacks of white paper this year as well. However, if that
number is just an approximation and a lot of the paper was wrongly
used and your efforts of going green will prove to be useful, you
will have created a budget that is too large for your paper needs this
year.

●        Benchmarking, which is not as frequently used, but can be an
option. This budgeting method compares your numbers
(preliminary and actual numbers) to the same indicators in
businesses of a similar size in the same industry as yours. This
method can be extremely efficient and it can get your budget very
close to your real needs, but getting your hands on this type of
market information can sometimes be extremely difficult (if not
downright impossible in some cases).

The best way to get this type of information is by consulting your local
library, industry associations, and so on.

Depending on which type of budgeting you choose, you might have to enter
different data in your QuickBooks budget. Overall, this function works like
pretty much everything else in QuickBooks and if you have learned how to
operate at least two of the features we have described so far in the book,
there is a very high chance you can operate the budgeting one as well.



To set up a budget in QuickBooks, go to the Company menu, select
“Planning and Budgeting”, and then click on “Set Up Budgets”. This will
prompt a new window, which you will use to record the numbers you
expect for each account (on both the revenue and expense sides), for each
month of the year you are budgeting.

Next, you should select “Create New Budget”, which will prompt a new
dialogue box. Once this happens, you will have to select the fiscal year and
move to choose between Profit and Loss or Balance Sheet, depending on
what type of budget you have in mind.

The main difference between the two is that in the case of the first, you will
budget the amount of revenue and/or expense for the month ahead. In the
case of balance sheets, however, you will basically budget the ending
account balance.

Don’t forget to choose profit and loss criteria to consider for the budget as
well. You also have the option to choose “No Additional Criteria” if you
don’t need any.

Once you have set all of this up, you will have to decide if you want to
create the budget from scratch or to create it based on previous data. For the
first option, click on “Create Budget from Scratch” (surprising, right?). For
the second option, click on “Create Budget from Previous Year’s Actual
Data”.

Once done, click Finish. Your budget will be all set up and all you have to
do is to fill it in with the right information.

Before we move on to the next section of this chapter, we would also want
to take a bit of time to make some notes about the entire budgeting process.
Keep these tips in mind:

●       There is no point in budgeting if you are not following your budget
plan too. Just because you have a budget somewhere, on paper, in a



spreadsheet, or in QuickBooks, it doesn’t mean that it will just
automatically come to life. You need to put in the effort to make
sure you follow the plan.

●       Not everyone finds value in budgeting. That’s OK. If you have tried
it and haven’t found it genuinely helps you, it’s OK not to budget. It
is, of course, recommended, and most businesses do find it a
valuable tool, but if you have learned that it doesn’t help you, then
don’t do it. There are ways to manage your business without 
budget as well. They might not be the easiest ways or the most
common ones, but they exist.

●        You can use your budget to track the activity of those people in
your company whose jobs are easy to quantify (such as sales
representatives, for example).

All in all, QuickBooks cannot work miracles for you or your budget - but it
can definitely help you make everything feel a lot more organized and
easier to track. So, if you need a budget (and you most probably do need
one), then go ahead and add it to your QuickBooks - it can be truly useful!

Costs Based on Activity
Activity-based costing is also known as ABC and it is one of the more
recent currents in accounting - probably one of the best as well. Basically,
what ABC does is offer businesses better ways to do their profit estimation.
As you may imagine, this is quite important.

One of the main issues many businesses face is related to the fact that their
overhead expenses do not connect to the products or services.
Consequently, these businesses will not be able to determine, with accuracy,
which of their products bring in profit and which of them don’t.

ABC comes as a solution to all this by allowing companies (and their
accountants) to track the overhead costs. You can, of course, calculate the



production costs (i.e. how much all the items comprising your products
cost). However, you cannot calculate the operation costs correctly.

In ABC, you create a product line income statement to be able to measure
the overhead cost and how it connects with each product/service you sell.
To create this product line, you will have to first bring together all the items
connected to the operation of the business. For instance, if you have a street
food cart, you will have to include here the rent, the supplies, wages you
pay, and so on. The key lies in observing which of these operation costs
relate to which products. For example, if you sell simple nachos and extra
cheese nachos, you might find that customers who buy the extra cheese
nachos use more napkins (and as such, more of your napkin supply should
be connected to the extra cheese nachos).

To further understand how ABC works, you should also be familiar with
some terminology used by accountants who are accustomed to this method.
The two most important ones are:

●        cost driver, which is, basically, any kind of activity you may run
within your business (such as machine setups)

●       cost driver rate (which you can find out by taking the cost pool total
and dividing it by each cost driver - this will help you calculate the
overhead/indirect costs connected to a specific activity of your
business)

Remember that, for ABC to work, you have to make sure you divide
activities into their smallest units. If necessary, calculate how much effort
and time an employee needs to perform a certain action vs how much they
need to perform a different action. For instance, in the nachos example
above, your employee may take two more steps to pour the extra cheese on
the nachos - which means that, if you sell 200 servings of extra cheese
nachos, they will take 400 more steps to serve this product. If they make
1,000 steps in total to sell both simple nachos and extra cheese nachos, and



for simple nachos they use a total of 200 steps, this means that the extra
cheese nachos represent 60% of the overhead cost.

This example might sound absurd, but the more granular you can go, the
easier it will be to calculate which of your products is bringing in that sweet
cash and which are not.

If you want to use ABC in a small company, it is important to keep in mind
the following:

●        The more products and the more overhead you have, the more
useful ABC becomes. If you do not have much overhead, you might
not find great use or benefits in using ABC, so you should think
things through before you proceed on this path.

●        If your business is in the custom manufacturing industry (i.e. you
create specific orders for your customers), you won’t need ABC.
You can use the simple job costing method to calculate the
association between costs and actual profits for the products you
sell.

●       ABC can be extremely simple or ultra complex, depending on how
far you want to go with it, as well as how your business is
structured. In essence, however, ABC can be kept simple and still
provide you with the main advantage it promises: better cost-profit
allocation.

To set up an ABC system, you should follow these steps:

1. Analyze your overhead costs and see if you have enough to even
start thinking of implementing ABC.

2. Identify which is the big overhead cost in your company. You can
go more in detail with the smaller overheads in your business later



on, but for starters, you want to tackle the biggest one because doing
this will bring you the biggest benefits.

3. Split that overhead cost into driving activities. Again, the more
granular you can be here, the more accurate your math will be.

4. Track and trace the activities to the products and how much they go
into each product.

Essentially, this is it. You can now connect different product overhead costs
with the profitability and make (or suggest) changes that would increase the
profitability for those products or for the entire company.

How to Use ABC in QuickBooks
Knowing how to use ABC is great, but how do you implement it in
QuickBooks (which is, after all, this book’s central topic?).

Well, to use ABC in QuickBooks, you will have to turn on something called
“Class Tracking”. To do this, you must first go to the “Edit” menu and click
on Preferences.

This will display (as you are probably getting used to by now) a new dialog
box. Click on the icon that says “Accounting” (you will find it in the list
box on the left side of the dialog box). Go to the “Company Preferences”
tab and tick the box that says “Class Tracking”. If you want the software to
remind you to use the classes, tick the “Prompt to Assign Classes” box as
well. Click on the “OK” button and you’re all set up!

To be able to actually use Classes, you will also have to set up a class for
each of the products and/or services you sell or what to analyze the
profitability of. If you sell two products (such as simple nachos and extra
cheese nachos), you will just have to set up two classes, for each of the
products.



To set up a class, you can simply enter the name in one of the boxes you use
to record invoices or make journal entries, but you can also go to the List
Menu and click on “Class List”, which will prompt a new window. From
there, you should click on the “Class’ button at the bottom and pick “New”
from the menu that will be displayed. Just enter your new class and describe
it as per the information that is required of you on this screen.

Now, you can use your classes as per the ABC model and enter data in your
QuickBooks system to use it afterwards for analyses. For instance, if you
have identified revenue that pertains to a specific class, you can go to the
Create Invoice window and click on the Class box when you invoice.

If you want to retrieve ABC reports to analyze, you must first allocate
overhead to product and service lines (as much as you can). To do this, you
will have to prepare a profit and loss statement filtered by class (there is no
“ABC” option in QuickBooks per se, but this report will basically show you
want you need). To do this, you have to simply go to your Reports menu,
click on “Company & Financial”, and then on “Profit & Loss by Class”.

Remember, ABC can be amazingly useful - but it is not for everyone (not in
the sense that it is difficult, but in the sense that sometimes it may simply
not make much sense to implement such a method).

Project Set Up
Because it helps with the better organization of a business, many of the
businesses today are built on a project-based system. This will reflect not
only in how the production “line” happens and the different cultural and
work ethic-related aspects of the business, but in its accounting as well.

QuickBooks will allow you to set up different projects in the software, so
that you can better track the spendings and the profitability of each project
in particular (and make appropriate decisions based on this analysis as well.



If you want to set up different jobs in QuickBooks, you will have to go to
the Customers menu and click on “Customer Center”, which will display
the eponymous window.

Here, you will see a list of your customers. To add a job for each of them,
click on the Add Job menu and a new window with the same name will be
displayed. To set it up, use the Job Name box and give this job a name (be
careful with naming and use a standardized naming method so that you can
keep track of everything).

Quickbook will also allow you to add different types of optional bits of
information - such as the address info, the additional info, and the payment
info, for example.

The Job Info tab in this window will allow you to identify the job type and
the job status, and it will also allow you to enter the start date, the projected
end date, and the actual end date as well. If you see a job that is inactive and
want to remove it from the Customer Center window, you can check the
box that says “Job Is Inactive”.

Once you have set up your jobs or projects in QuickBook, you can start
tracking the costs associated with each of them. To do this, simply enter the
name of the customer and the name of the job or project in the box saying
“Customer:Job” whenever you perform a financial action (e.g. when you
create an invoice, you will see this box in the “Create Invoices” window).
When you fill in that box, the invoice will be automatically associated with
the project you have chosen.

The Create Invoices window is not the only one that provides the
Customer:Job box option - pretty much every other window that allows you
to record income and expenses will provide you with this option, actually,
including QuickBooks options you use to track time, for example.



Also, keep in mind that, during the QuickBooks setup, you have the option
of telling the software that you will want to create job estimates in the
future. You can use these to invoice them as well. To access the job
estimates option, click on the Customers menu, and then on “Create
Estimates”. This window is quite similar to that of the “Create Invoices”
one, so there is not much to discuss or explain here (if you have learned
how to use this software for basic tasks, you will know how to use it in the
Create Estimates window as well). You can then use these estimates and
associate them with jobs/ projects you have set up in QuickBooks as well.

Overall, QuickBooks can be considered to be quite intuitive. If you know
your accounting and/or bookkeeping and if you know how to navigate the
different menus and windows of this software, you will know how to use it.

Hopefully though, Chapter 2 and Chapter 3 of this book have helped you
gain a more in-depth understanding of  how QuickBooks works and how to
use it the smart way.

In the next chapters, we will discuss advanced financial expertise matters
that can be dealt with in QuickBooks, as well as some extras you might find
useful (and, in fact, you should find useful no matter what type of
accounting or bookkeeping job you perform on a daily basis).





Chapter 4
 



Advanced Quickbooks

Despite being the go-to choice for a very wide range of business types and
specifically for small and medium sized businesses, QuickBooks is not even
by far a “beginner” in the art of dealing with business numbers.

In fact, this is a pretty powerful software, one that can be used not just for
the automation of certain accounting and bookkeeping processes, but also
for expert financial analysis, creating business plans, and seeing beyond the
numbers to make better decisions for the future.

There are two main sections we want to tackle here: financial management
(and how QuickBooks can help you with it) and business plans (and, again,
how this software can help with them).

We do warn you that these are pretty advanced actions for accountants in
general, and that they might go beyond the expertise of a beginner. As such,
we advise you to skip to the last chapter if you do not necessarily feel that
you are too advanced in the art of accounting.

If, however, you feel that you can manage this, we can definitely
recommend reading on. The information ahead will surely help you from
every point of view!

Before we proceed further, we would like to take a little bit more of your
time and explain that it doesn’t really matter how large or small your
business may be - advanced accountancy will definitely help it. Some
people live under the impression that only large, multinational companies
need financial planning, but the truth is that from the small bakery around
the corner to the corporations of the world, everyone could use a little more
insight from their numbers.



As such, this chapter is not about large businesses - it is about growing
businesses in an intelligent, data-based way. Keep in mind that the tips here
are not about using QuickBooks alone, but about making the most out of all
the statements and reports it can help you create.

Let’s dive in!

Financial Management
There are many ways to look at financial management. For the purpose of
this chapter, however, we will take a closer look at ratio analysis, economic
value added, and capital budgeting - two concepts that lie at the basis of
modern financial management and which, we believe, should be familiar to
anyone working in finances.

Ratio Analysis
Ratio analysis is a financial management technique that encourages
financial experts to compare internal statements with internal and external
information and benchmarks that will help them better understand the
numbers and draw conclusions that will eventually lead to the development
of the company they work for.

Ratio analysis is quite simple to understand once you learn the basics, and it
can provide even someone who is not that much into “numbers” with the
option of truly understanding the financial statements and what they mean
beyond the pure math.

There are some disadvantages when it comes to using ratio analysis as well,
and some of the most important ones include the following:

●       The ratios you get are always correlated to the quality of the input.
When your QuickBooks accounting records are inaccurate, the
ratios you calculate using these numbers will be inaccurate as well.
This enforces the importance of keeping accounting records as
clean and correct as humanly (and software-y) possible.



●        All of these ratios are relevant when you compare them to your
numbers and/or those of your competitors. You have to dive in with
these numbers and ratios to extract meaningful business decisions
and lessons for the future. Accessing the information of other
competing companies may not be easy, but there are still quite a lot
of things you can do (such as check industry reports and statistics
that will give you a better idea of where your business lies in the
context).

There are many types of ratios an accountant or layman can look at for a
better understanding of the financial statements lying in front of their eyes.
The most important ones are listed below, but keep in mind that the list is
not exhaustive and we strongly encourage you to search for formulae that
fit your business’ needs (or the needs of the businesses you serve with your
financial expertise, if that is the case).

Here are the most important ratios you can calculate based on the numbers
QuickBooks will give you:

1. The Gross Profit ratio. This can be calculated by dividing the gross
profit by the net sales. This will help you determine how much
actual, gross profit your sales have generated. In general, gross
profit will be equal with the net sales amount minus the cost of
sales.

2. The Return on Sales Ratio. This ratio can be calculated by dividing
the net income by the net sales. Sometimes, this ratio is referred to
as the “net profit margin” and it shows the percentage of income
that has been derived from sales. The higher the Return on Sales is,
the better a business is doing.

3. The Return on Assets Ratio. This can be calculated by dividing the
net income by the average total sales. It is a measure of ROI and it



is generally used in evaluating the efficiency of the management in
using assets to create income.

4. The Return on Stockholders Equity. This ratio is valid for
companies that have stockholders in them, and it is calculated by
dividing the net income by the average stockholder’s equity. What it
does is basically measure the percentage of income that has derived
from every stock owner’s equity.

5. The Current Ratio. This ratio is calculated by dividing the current
assets to current liabilities. What it does is measure how able a
company is to pay its short-term obligations using existing assets
(marketable securities, inventory, or cash, for example).

6. The Acid Test Ratio. This is calculated by dividing the quick assets
to the current liabilities. It tracks the ability of a business to pay
short-term obligations by using quick assets (very liquid types of
assets, such as cash, current receivables, and so on).

7. The Cash Ratio. This is calculated by dividing the sum between the
cash and marketable securities to current liabilities. Its purpose is to
measure how capable a company is to pay its liabilities using cash
and marketable securities specifically.

8. The Receivable Turnover Ratio. This is calculated by dividing the
net credit sales by the average accounts receivable. The main
purpose of this formula is to help you learn how many times in a
year your company will collect its open accounts. The higher the
rate is in this case, the better it will be for the company.

9. The Days Sales Outstanding Ratio. You calculate this by dividing
the number of days in a year by the receivable turnover. This ratio
measures the average number of days a company will take before it



collects its receivables. Some accountants use 360 days here, others
use 365.

10. The Inventory Turnover Ratio. This ratio is calculated by dividing
the cost of sales by the average inventory. This number will show
you how many times an inventory has been sold and replaced.

11. The Days Inventory Outstanding Ratio. This is calculated by
dividing the number of days in a year (360) by the inventory
turnover. The number you will get is the number of days your
inventory is in the warehouse (or the number of days from the
moment you purchase the products in your inventory to the moment
you sell them).

12. The Accounts Payable Turnover Ratio. This ratio is calculated by
dividing the number of net credit purchases by the number of
average accounts payable. This will give you the number of times
your business is paying its accounts payable during a given period
of time. The lower this ratio, the better (because it means that you
can delay payments as much as you can and use your cash flow for
productive goals).

13. The Days Payable Outstanding. This ratio is calculated by dividing
the number of days in a year (360) by the number representing the
accounts payable turnover. The ratio you will get measures how
many days you spend before paying your suppliers the obligations
they are due. The longer this period is, the better it is (because just
as in the case of the accounts payable turnover ratio, it means that
you can hold onto your money for more productive purposes).

14. The Total Asset Turnover Ratio. You will calculate this by dividing
the net sales by the average total assets. This number measures how
efficient your company is when it comes to generating sales using
its assets.



15. The Debt Ratio. This is calculated by dividing the number of total
liabilities with the number of total assets. What this number
measures is how much of the company's assets are financed by
debt. 

16. The Equity Ratio. This ratio is calculated by dividing the total
equity by total assets. The number you will get here is the portion of
the assets that has been funded by equity (e.g. the company’s profits
or the owner’s contributions).

17. The Debt-Equity Ratio. As the name suggests, this ratio is
calculated by dividing the total liabilities by total equity. This will
give you a better idea of the capital structure of a company, because
if the ratio is more than 1, it means that the company is leveraged,
while if it is less than one, it means that it is conservative.

18. The Earnings per Share Ratio. This is calculated by dividing the
difference between the net income and preferred dividends and the
average common shares that are outstanding. This number will
show how much share of common stock is earned.

19. The Price-Earnings Ratio. You will calculate this by dividing the
market price per share by the earnings per share. This will help you
determine if your stock is over appreciated or underappreciated.

These are just some of the ratios you could calculate based on QuickBook
reports. Hopefully, they will help you go more in-depth with your analysis
of the data provided by these reports. Beyond the numbers, you have a
treasure trove of information that will allow you to make better business
decisions in a variety of respects, so it is quite important to look after this
information.

As mentioned at the beginning of this section, this type of analysis can be
tremendously helpful for a wide variety of businesses, large or small,



regardless of their industry and regardless of what type of products they
might sell.

Economic Value Added Analysis
Accounting is a pretty logical activity (it is based on numbers, after all, isn’t
it?).

And yet, every now and again, there are fallacies in the logic of accounting
that you need to be aware of. They are things that might seem quite
straightforward in essence, but once you go beyond the surface, you
discover that they are much more complex in nature.

For example, if you look at your QuickBooks income statements, you might
see a profit. And yet, your business might not be making much money. This
is a pretty odd occurrence, but it has been proven mathematically. More
importantly, it has been tackled by a method called Economic Value Added
Analysis (which was first elaborated by Stern Value Management)
(Daraban, 2017).

Economic Value Added analysis is a way by which you can determine if
your company is actually making money or if, in the worst case scenario, it
would be better off to sell it out and either get a job (the saddest scenario) or
reinvest the money you get from selling the business (in a new one or in
something else, like the stock market, for example).

Before you proceed with the Economic Value Analysis, there are certain
things you should set in order (to make sure that your analysis will be
correct from the very beginning). The most important aspects to consider
are the following:

●        Make sure the numbers upon which you build this analysis are all
correct and tidy. As mentioned before in other cases, the quality of
the output is largely due to the quality of the input data. For
instance, consider if the income statement describes your profit and



if you can actually sell your business based on what this income
statement says.

●       How good is your cost of capital percentage? You might find it very
difficult to come up with a number for this, but you can generally
rely on estimate values based on the market or the type of business
you are running. For example, it is a generally accepted fact that a
small business should generally produce returns of 20-25%
annually. You might also want to know that even the most
successful companies produce capital return percentages that range
between 35 and 45%. This will give you a good idea of where you
should (or want to) lie. Based on these percentages, you will be able
to calculate different versions of your EVA (Economic Value
Added).

●        Is this business bringing you (the owner/entrepreneur) more than
just economic value? Let’s face it: the vast majority of small
business owners are not in it just for the money. They are in it
because they love the job, the independence, the power they have to
create jobs, and so on.

●       Have you experienced fluctuations in your business growth? If so,
it would be healthier for you to look at more than just one year’s
profits. These numbers can change a lot from one year to another
(and this is generally true for most small businesses), so you can’t
let yourself be put down by one bad year (which might be
influenced by a myriad of factors, from your health to the market
power).

●        Is your business facing any kind of special situation? EVA works
wonderfully in a lot of cases, but there are situations when it might
not do much - such as, for example, when businesses are at their
very incipient stage (they are still considered start-ups, and not even



small businesses per se), or when businesses are growing at a very
fast pace. In these cases, it is rather impossible to figure out the
actual economic profit of these businesses.

●       EVA is, more than anything, a business management tool. It should
give you a good idea of how to run your business (or, if you are an
accountant, what kind of advice to give to your boss with this
regard). It is not necessarily an official statement-worthy kind of
calculation, but a thinking tool that will allow you to “munch” on
the true profitability of your business.

●        In general, EVA is used to analyze businesses in their entirety
(mostly because this tool is largely used by small and medium sized
businesses, but not only). However, the same calculation can be
applied to a larger environment and it can help you determine the
true profitability of a specific business unit, of your management
system, or of a specific product line.

Overall, the Economic Value Added analysis will allow you to split your
business into its profitable activities (i.e. the activities that should be
emphasized on).

Keep in mind that calculating the Economic Value Added can be quite
confusing. To calculate EVA, you have to calculate the difference between
the rate of return on assets and the cost of capital. Then, you have to
multiply this difference by the net amount you have invested in the
business.

Some other factors you might want to keep in mind with regards to
calculating EVA include the following:

●        You will have to remove any kind of unusual income items from
the net income. In general, “unusual income items” can be defined
as any items that are not connected to the ongoing operations.



●        When drawing the net investment number, keep in mind that this
should be the net book value for all the fixed assets (and you will
have to use straight-line depreciation calculations for this).

●        If you need research and development, the expenses connected to
this should be considered as part of the investment.

●        Remember to include the fair value of your leased assets when
calculating the investment figure.

If you are not an accounting or financial expert and the calculation of EVA
confuses you, you shouldn’t panic. Get someone to help you, especially if
you believe that doing this calculation will help you.

What does all of this have to do with QuickBooks? Well, thanks to
QuickBooks, it will just be easier to draw all the information you need to
make a correct EVA calculation. Once you have set it up correctly and
assuming that all economic activities are correctly recorded in QuickBooks,
it will be easy to simply extract the information and proceed with the EVA
formula.

As mentioned in the beginning, when it comes to advanced accounting and
financial expertise, QuickBooks will prove of invaluable help precisely
because it will provide you with all the reports you need to perform
advanced analyses.

Capital Budgeting
One of the main challenges in any kind of business is to allocate money to
the range of activities run by that business. Sometimes, you might find
yourself having a lot of great ideas to push your business forward - but
without capital, it can be quite difficult to do this.

Capital budgeting is a technique that helps accountants and business owners
filter these ideas and prioritize investments and new directions according to
how profitable and how beneficial they can be for the business.



The main core idea behind capital budgeting is that you are to look at
capital investments in a healthy and financially savvy way. There are three
main factors you should analyze when running a capital budgeting analysis,
and we will discuss them as follows, in the order of their importance.

●        The first element you should analyze when running a capital
budgeting analysis is the return on investment. In other words, how
much money a potential capital investment can bring into your
business should be your number one concern. Yes, painting the
walls of an office in pretty colors might be excellent for the
employee morale and for their productivity, but if you have other
ideas on your list that can give quantifiable results, it would
probably be best to prioritize on those.

●        The second thing you want to look at when it comes to capital
budgeting is time - not necessarily the time it takes to bring that
item into your business, but the time it takes for that investment to
actually bring you profit. In economic terms, this time comes under
the name of “maturity”. For example, if you have a coffee shop and
buy a new coffee making machine that makes twice as many
espressos as your old one, chances are that its price will soon start
to pay off and you will start making more profit with it. By
comparison, buying new mugs might be a smaller investment, but
you will never be able to measure their actual impact on how much
coffee you sell. The more you tie your money to investments (time-
wise), the more difficult it will be for your business to ensure a
proper cash flow and an expected level of profitability at the end of
the year.

●       Last, but definitely not least, you want to analyze your risk as well.
What is the risk that your new purchase will not perform as
intended, that it might need repair, or that it might cause trouble in
other parts of your business? What is the risk that your investment



will simply not work with your business and that your buyers won’t
see benefits in using it? You cannot calculate this with precision,
but you can estimate the wide range of things that could go wrong
with your investment. Then, you can quantify them by assigning
them different “grades” and see whether or not an investment is too
risky for you at the moment.

Intuitively, everyone does capital budgeting (or at least they do when they
want to be aware of their finances). For example, if you are buying a new
car for your family, you will instinctively analyze all the points we
mentioned above. You will analyze how much return this purchase will give
you (e.g. spending less time on your way to work, being able to go on
vacations more often, and so on). You will analyze how this will pay off
and when, and, ultimately, you will analyze if there are risks associated with
this purchase.

Capital budgeting can be an incredibly powerful tool, and QuickBooks can
help you calculate the return on investment with a lot more accuracy
precisely because this software will have been “fed” with all the financial
data your company holds.

While you might not always find capital budgeting to be worth the time,
going with your instincts when it comes to investments is, in general, not a
very healthy business strategy. You might be tired, biased, or simply
blinded by the potentiality of high gains (and ignore the risks and the time it
would take for this investment to reach maturity).

As such, we recommend that, whenever possible, you should rely on data
and calculations, rather than “gut instinct”. Numbers cannot lie (provided
that they have been correctly inputted, of course) - but instincts can very
often fail to deliver on their promises.

Business Plans



To an outsider’s untrained eye, business plans are nothing  but a
conglomeration of numbers and ideas that are frequently left to gather dust
by the end of the year.

Having a business plan is, however, essential to any business’ success.
Regardless of whether you started yesterday or if you are already the third
generation in owning a company, having a business plan will provide you
with the clarity you need in order to aim for your goals.

Even more, it will provide potential lenders and investors with a more in-
depth look at what this business of yours does, what it plans to do, and why
they should trust you and your business with their money.

Creating a business plan is very frequently not as easy as it may sound,
because it’s almost never about simply tossing a couple of numbers on a
piece of paper or PowerPoint presentation, and it is almost always about
pulling together all the “forces” in your company to create a plan that is
both feasible and daring at the same time.

This section of our fourth chapter will discuss some of the basic business
planning techniques you should know. Same as in the case of financial
management, these tools and techniques are not directly connected to
QuickBooks - but using a reliable accounting software will definitely help
you pull better, more accurate numbers into your planning, so that you can
create a roadmap that is true to what is actually happening in your business.

The main concepts we will discuss here are forecasts, writing business
plans, and running profit and volume analyses - all of which are part of the
larger subject of planning ahead so that you can play according to your
own rules (OK, that might not be a very good name for this topic, but the
point is that planning is important and these techniques will help you create
a better, more reliable, more feasible, and more adequate plan for your
business onwards).



Let’s dive in!

Creating Forecasts
As much as we’d love to see that happening (for the purpose of
entertainment), we can definitely not rely on magic globes and tarot cards
when it comes to business.

Creating a business plan forecast is about a lot of things - or, better said,
about a lot of reports and statements you need to be familiar with. More
specifically, these are the statements you should consider for your business
plan forecast:

●        A financial statement (which is usually a collection of documents
that include an income statement, a balance sheet, and a cash flow
statement):

-          The income statement will give details about the losses and the
profits of a business over a given period of time. For instance,
you can create an income statement for a month, a year, or
more.

-          The balance sheet lists the assets and the liabilities a business
has over a given period of time. Usually, the balance sheet
timing is connected to the income statement timing in the sense
that they are created for the same period of time.

-          The cash flow statement will show the cash going in and out of
a business over a specific period of time.

●        Financial ratios. We have already discussed some of these in the
Ratio Analysis section of this chapter, but not all of them are needed
for business forecasting. In fact, the ratios you will need fall into
two main categories:

-          common size ratios, which allow you to compare assets,
liabilities, owner equity, revenues, and so on (and you can make



these comparisons at a point in time or over a period of time, as
a trend)

-          Intrastatement/interstatement ratios, which allow you to factor
in the fact that certain amounts cannot be interpreted alone, but
that they must be analyzed in a context given by other financial
factors and events.

As a general rule of thumb, you might want to compare these ratios with
industry trends and statistics, because this is when they gain the most value
(and help you determine true insights into how to grow your business).

Once you have these statements and ratios in order, we advise you to either
create a business plan forecast Excel sheet (or Google Sheet document) or
to download one. Simply Googling “free business plan workbook template”
or “free business plan spreadsheet template” should give you plenty of
results.

Each business has its own needs, so if you know your way around Excel
and if you know what you are looking for, you can also create your own
spreadsheet. The key here is to make sure that you include all input fields
that will allow you to draw forecasting conclusions on some of the most
important areas of the business:

●       profitability

●       revenue

●       client acquisition costs

●       client retention

… and so on.

You decide where you want the business to grow and what direction it
should go in. This forecast plan should act as a guideline to help you reach
palpable goals (e.g. being able to hire 20 more workers next year,
improving the company revenue by 20%, and so on).



QuickBooks will help you in this effort by providing you with the correct
and accurate numbers you need to make your forecasting both accurate and
palpably realistic.

Writing a Business Plan
Business plans are frequently more complex than simple spreadsheets. In
fact, a proper business plan should very often include an actual story behind
it - because beyond the numbers, many investors and/or lenders might be
looking at this too.

Of course, it shouldn’t include a fairytale, but a story of how you plan to
grow, where you want to take this business, and what impact it will have on
the market and in the community.

A good business plan can really open your doors, but in order to create one,
you must remember that you need to include both numbers and persuasion
in the entire “story” you create around your business plan. The numbers
should be truthful, realistic, and achievable, while the persuasion should be
placed in a context that makes you less of a sales person and more of a
visionary.

First of all, you should understand the fact that when people talk about a
“business plan”, they might be referring to one of the following:

●       Strategic plan (which shows the overall strategy of a business)

●        Venture plans (which shows how an entrepreneur will promote
his/her venture to potential investors)

●       White paper plan (which is usually quite extensive and includes all
the details about the business opportunity, including opportunities,
risks, and so on).

When you want to build a strategic plan, you should keep in mind the
following:



●        There are three main types of strategies you can choose: a cost-
based one, a differentiation-based one, and a focus-based one. The
type of strategy you choose will dictate your plan, as well as the
steps you take to ensure that you breathe life into that plan.

●       You have to clearly define all aspects of your strategy. Contrary to
popular belief, strategy is not a “thing” you build overnight, on your
lap. It brings together numerous elements, including your past
business reports, market research, and a bunch of other things that
are essential to defining a strategy that can be actually followed too.

●        Discipline is of the utmost importance when you build a strategic
plan, and it most definitely is extremely important when you follow
it as well. As such, strategic plans tend to be a little more strict and,
in consequence, many companies might not want to settle for this
type of plan because it limits their perspective and opportunities.

When you have to create a venture plan, it is important to keep in mind that
writing a venture plan is quite different than writing a white paper plan or a
strategic plan. In essence, this plan will have to answer five main questions:

-          Is this venture or product actually feasible? This is especially
important to answer when your idea is quite new and it has not
been proven yet. In some cases, you might have to first create
the prototype product to show it (and to prove that it is feasible).
If that is not possible, you might have to bring together a team
of experts that have worked in the same industry and for the
same type of products in the past.

-          Is there a market demand for the product? We’d all love to
build products because we really want them, but just because
you, your mom, and your neighbor find your idea lovely, it
doesn’t actually mean that there is a market demand for it. As
such, it is quite important to test the market, see where it might



have gaps in it, and see how your product will fit into the entire
scenario. One of the best ways to prove that there is indeed a
demand for your product is by conducting market research.
Another way is by showing that people are already buying a
product that is similar to yours (and that yours will be better).

-          Can you make a profit with that product? This question might
be stingy, but the purpose of a business is, as we have
mentioned in the beginning of this book, to make money. Sure,
creating jobs and making the world a better place are
byproducts of that, but in essence, if a business doesn’t make
profit, it cannot move on. To prove that your product can make
a profit, show a comparison between the actual cost of
manufacturing/making that product and the planned selling
price.

-          Will the investors be interested in the venture? Believe it or
not, simply because something is forecast to make profit it
doesn’t automatically mean that investors will be interested in
it. Your venture needs to fit their scope and it needs to make
enough profit to meet their own goals.

-          Can you and the existing management run the venture? You
need to show the investors that you are trustworthy enough to
run this company. Even if the product is almost certain to make
crazy profit and even if you meet all the other points described
here, if the company is not properly managed, there is a high
chance that this will impact its efficiency. As such, investors are
quite wary when it comes to how they analyze a potential
business’ management team.

As for white paper plans, they are, by far, the most comprehensive type of
business plan you will ever have to write. There are many things to keep in



mind here and we strongly encourage you to do proper research on this
topic specifically if you want to write this type of business plan. If we had
to narrow it down to a bunch of tips, however, here they are:

●        White papers are frequently perceived as a compromise solution
between a strategic plan and avoiding having to make the hard
decisions associated with that strategic plan. At the same time
though, you will most frequently need to have some sort of strategic
plan to include in your white paper plan - so while you might not
have to make all the decisions associated with a strategic plan, you
will still have to build it and incorporate it into the big plan.

●        The best news about writing a white paper business plan is that
QuickBooks can actually help you with this (and quite
tremendously). If you go to the “Company” menu, and click on
“Planning & Budgeting”, you will find that there is a “Use Business
Plan Tool” option you can use. Clicking on this will prompt a
wizard that will help you go through the basic steps of creating a
white paper business plan. The template is quite intuitive in itself
and it will help you bring together the most important bits of
information that need to be included in this type of business plan.

●       If you choose not to use the wizard provided by QuickBooks, keep
in mind that your white paper will have to follow a pretty straight-
forward structure that includes:

-          an introduction (not longer than a paragraph to give your
readers a very brief idea of what this is all about)

-          the main problem or challenge (in the case of a business plan
white paper, this is usually related to why you have to or want
to grow, expand, or change your business)

-          the solution (describing how you plan to tackle the problem)



-          the benefits (what you expect to get out of this entire endeavor,
with numbers and financial forecasts included here)

-          the conclusion (wrapping it all up in a few words, so that
readers know the essentials they need to take home)

●        Remember that your business plan has to be adapted to your
audience and that you really need to make sure that everything,
from language, to the type of information you offer, is convincing
enough for them.

●       Market research is extremely important in the case of a white paper
business plan too, precisely because it will allow you to place your
(new) product within a context and prove that it is going to be
appreciated by the market. As mentioned in the case of venture
business plans, the best way to do this is by showing actual numbers
about the market and where you would fit in it according to the plan
at hand.

●        Include a competitor analysis as well. By this point, in 2020, it is
quite difficult to find a product so new and innovative that it has
zero competition and that it doesn’t “meet” with any kind of
competitors at least in one point. As such, you have no excuse to
avoid including a competitor analysis. The more detailed you are
about this, the more likely it is that your business plan will be
convincing.

●       All the numbers you present in your white paper business plan have
to be convincing and correct at the same time. There is no point in
lying or in extracting only the information that suits your needs. Not
only are the risks of doing this tremendous, but it will also make
readers lose trust in you (and gaining back that trust will be near to
impossible). If you want to know just how bad “manufactured”
reports and plans can go, look at Volkswagen’s emissions scandal



and its aftermath: in less than two weeks after the scandal outburst,
the company lost approximately 40% of its value (Jung, 2019). You
definitely do not want that for your business, right?

●       Be positive. Even when numbers are bad, a positive outlook and a
proper plan to fix things can make all the difference in the world.

All in all, writing a business plan might prove to be more of a challenge
than many people believe. Aside from the numerical and accounting part
most business plans have to include in them, there is also a human side of
things that will help you make your business plan a successful one: one that
convinces and attracts investors and lenders, and simply makes people
believe in you and your product.

That human side is sometimes the hardest part to deal with because it
involves, more than numbers, the ability to get through your listeners and
not only make them listen to what you have to say, but also convince them.

In many ways, writing a business plan is an art that brings together all the
elements of a business: numbers, marketing, and a strong entrepreneurial
spirit!

Running a Profit and Volume Analysis
As the last part of our fourth chapter, we want to circle back to matters that
are a bit less business per se and a bit more accounting.

Namely, we want to talk a little about an advanced accounting method
called “Profit and Volume Analysis” (and sometimes referred to as “profit-
volume-cost analysis”). This is a pretty powerful tool you can use to
estimate how your company’s profits will change according to the sales
volume and the points of sales revenue levels that bring in zero profits
(called breakeven points).

This analysis will help you prove that even a small change in the sales
volume you are experiencing can produce massive changes in terms of



profitability. For example, this indicator is quite helpful in seasonal
businesses (such as businesses that are connected to the travel industry,
where a hotel can show extreme fluctuations in profitability).

To calculate the profit-volume-cost analysis, you will have to bring together
three main chunks of information:

●       a sales revenue estimate

●       your company’s gross margin percentage

●       your company’s fixed costs

In general, all this information is quite easy to acquire. The sales revenue
estimate represents, in fact, how much money you need to keep your
business open. Moreover, the gross margin percentage can be easily
calculated by simply extracting the labor and material costs from the price
of the products you are selling, and then by dividing this by the product sale
cost.

As for the fixed costs, they represent the totality of the costs associated with
assets and expenses that do not change according to your sales revenue. For
example, you could say that your rent is a fixed cost - no matter how much
you make in a month, your business will still have to pay rent for the space
it uses for its operations.

The profit and volume analysis can be extremely useful in management
accounting, but it does have some downsides as well, and it is quite
important for you to be fully aware of them:

●       All the assumptions you make are valid only to a specific range of
sales revenue. For instance, if you calculate your variable and fixed
costs for a business that sells 500 items of a product every month, if
you scale up to 1,000, your assumptions will not be valid anymore
because there might be extra bits of information that come into play



(such as new pieces of equipment you need for the scale-up, for
example).

●        You cannot say about anything that it is a fixed cost in the long
term. For example, to stay in tune with the example we gave above,
you cannot say that your rent will be fixed at a specific sum of
money forever. Depending on how the market changes or how you
renegotiate your contract with your landlord, your rent may change.
And the same applies to all so-called fixed costs.

●        There are also no variable costs in the very short term either. For
instance, if your employees finish their daily quota at noon, you
cannot actually send them home. As such, you cannot estimate a
variable cost for a very short amount of time.

Overall, though, if you move past these downsides, you will reap plenty of
benefits from using the profit and volume analysis. As always, QuickBooks
will be there to provide you with the data you need (and as always, you
have to start with the assumption that the data has been fed into the system
correctly and accurately).

All in all, QuickBooks can be a great help when running advanced
accounting analyses and applying advanced accounting and management
techniques. With a tool this powerful in your hands, all you have to do is
apply the right formulae and write down the right business plans - and once
that is done, your business will be ready to grow and flourish.

Regardless of whether you are a business owner or an expert accountant
who does this for other businesses, you are sure to find QuickBooks to be
an indispensable ally in your “dance” with numbers, business decisions, and
growth factors.





Chapter 5
 



The Quickbook Extras

Thank you for coming this far in the book! If you have reached this point, it
means that you have found it useful, and we cannot be anything but
thankful for that. After moving through some of the bookkeeping,
accounting, and financial accounting expertise tasks QuickBook can help
you with, we are now reaching the final pages of this book.

The last chapter of our volume is dedicated to helping you learn all the
QuickBooks extras: the tips and tricks you will make use of sooner or later,
the things you need to know about adjusting your QuickBooks software to
suit your needs, how to administer QuickBooks and keep it as clean and
tidy as possible and, finally, a few words on data protection and its
importance in the current context.

Hopefully, this chapter will complement all the knowledge you have been
collecting so far and circle back to the idea that QuickBooks may seem like
a basic tool, but is, in fact, a powerful data aggregation and analysis tool
that can help you not only keep your numbers in a straight line, but also
grow your business exponentially.

So, without further ado, let’s jump right into the three main topics we want
to approach at the end of this book!

QuickBooks Adjustments 
The default version of QuickBooks was built on the plug and play model -
you install it and you simply start to use it. However, this version tends to
lack certain features that are a bit more advanced and as such, there might
be certain adjustments you have to make to your QuickBooks before you
start to actually work with it.



Making these adjustments is pretty easy and straightforward, and we have
even tackled some of them in the previous chapters. Basically, these
adjustments will allow you to access more advanced features of
QuickBooks so that you can do your job better (which is, in itself, the entire
purpose of using an accounting software, right?).

When you install the QuickBooks software, you will have to go through a
so-called “EasyStep Interview”, in which QuickBooks will require some
information from you. This interview is pretty extensive, so you should be
prepared to have a lot of data on you and to provide it to QuickBooks.

Once that is done, the next natural step is to populate your QuickBooks
with lists. This software will allow you to create lists of pretty much
everything you might need for your bookkeeping and accounting tasks:

●       the chart of accounts
●       items
●       payroll items
●       classes
●       customers
●       vendors
●       employees
●       profile

Most of these have already been discussed throughout the book at one point
or another, and they are quite straightforward. The way to create a list of
any kind is by first accessing the “Lists” menu from the top of the window
and then go to the type of list you want to create or edit.

Adding lists might not be the most interesting thing in the world to do, but
it is necessary, so we suggest you get this out of the way first so that you
can start working with the software as soon as possible.



Once you have done this, you can move on to the more entertaining stuff:
the fine-tuning details that will help you make the most out of QuickBooks
and the features it offers.

Following, we will list some of the basics behind the adjustments you might
want to make in your QuickBooks. Keep in mind that this is not the “long
version”, but a brief introduction in the fine-tunings you can make in this
software to ease your job and make yourself more efficient as a bookkeeper
or accountant.

You can change your preferences from the very beginning, during the
EasyStep interview, or, if you want to change your preferences at a later
date, you should access the Edit menu and click on “Preferences”.

In general, changing your preferences in QuickBooks is extremely easy -
but it is important to know what you are looking for because this software
provides a lot of options when it comes to adjusting preferences (and, as
such, it’s pretty easy to get lost).

In short, these are some of the basic preferences you can adjust in
QuickBooks:

●        Your company accounting preferences (such as a specific account
number you can choose to use for certain transactions by simply
ticking a box or, as discussed earlier, whether or not you want to use
classes).

●       Your billing preferences (such as specifying that bills are due after a
certain number of days, for example)

●        Your checking preferences (such as which account should be
suggested by the software when you are in certain windows)

●       Your desktop view (if you want to see only one window at a time or
multiple of them, overlapped)



●       Your finance charge calculation rates (such as what charges should
be applied to overdue invoices)

●        General preferences (such as to get a beep when you record a
transaction or to open drop-down lists automatically when you
begin to type something).

In addition to these preferences, there are many others that are quite
important for you to adjust because they will have a very big influence on 
how you do your work onwards (and they might even have legal
implications).

For example, you will have to adjust how your sales are taxed. You cannot
add personal preferences here, but you can add company preferences. This
section has a bunch of options for you, such as allowing QuickBooks to add
a sales tax to your documents if you check the “Do You Charge Sales Tax?”
radio button.

Furthermore, the “Default Sales Tax Code” box will allow you to enter the
code you want QuickBooks to use for taxable and non-taxable sales. You
can adjust this even more and you can add your own taxable and non
taxable sales codes to use when you perform certain actions.

Another element you might want to adjust from the very beginning is the
1099 tax information. Naturally, there are no personal preferences here, but
you can set up company preferences. These preferences will allow you to
inform QuickBooks when you have to file your 1099 forms. The software
will also allow you to identify the maximum amounts for the different types
of income that would be normally be taxed via the 1099 tax form.

Keep in mind that these threshold amounts differ according to where you
live and what type of business you work for/own, so you might want to
check with IRS before you set this preference in QuickBooks. You
definitely want this one to be accurate!



Other preferences you can adjust in QuickBooks include the following as
well:

●       purchase and vendor preferences
●       how you are reminded about certain things
●       how your reports and your graphs look
●       how you are controlling time tracking
●       how you are controlling different jobs and estimates

There is an endless world of opportunities when it comes to the adjustments
you can make in QuickBooks. Every business is different and part of the
reason that QuickBooks is so popular is precisely because it is easy to
customize it to your business’ specific needs.

You can always go back and change your preferences in QuickBooks, but
do keep in mind that some of these changes might not be applied
retroactively. Make sure to check and double-check everything to be
absolutely certain that even after a preference change, your QuickBooks
data will still be correct and accurate!

QuickBooks Administration
In a world of data flowing from everywhere and to everywhere, holding on
to your financial data and ensuring that it is clean and accurate is absolutely
crucial for the success of your business. As such, making sure that your
QuickBooks is properly maintained is about more than just ensuring its
functionality, but about ensuring the very functionality of your business
itself.

It is extremely important for you to understand that, most times, accounting
data is considered to be confidential. You don’t want everyone to know how
much money you have in each of your accounts, how much you owe, how
much you are owed, or how much profit your business is making.



As such, one of the very first and most important issues you need to tackle
when it comes to QuickBooks administration is ensuring the continued
confidentiality of the information this system holds about your business.

Maintaining the security of your QuickBooks information is bifold: on the
one hand you will have to handle it from the end of QuickBooks, and on the
other hand, you will have to make sure that your computer’s Operating
System is up to date.

When it comes to protecting data security from QuickBooks, one of the first
and foremost important things you will have to do is assign a password to
data files in the system. You will be prompted to do this when you set up
your QuickBooks, but you can also do it later on by going to the Company
menu and clicking on “Change Your Password”.

Quite obviously (we hope), your password should be intricate enough not to
be guessed by anyone who might want to break into your data files. As
such, it shouldn’t be your name, your date of birth, or anything that can be
found in a dictionary, really.

Believe it or not, in 2019, the most popular passwords were “qwerty”,
“123456789”, and “123456” (Picheta, 2019). It might sound funny, but it’s
statistically accurate. Needless to say, your password needs to be more
complex and more difficult to guess than these examples.

Once you have set up a password, you will be prompted to log in using it
every time you open the QuickBooks data file.

Do keep in mind that you can set up multiple passwords in QuickBooks,
depending on how many users are using it. Furthermore, you can always
add new users to QuickBooks, and you can even limit what they can and
cannot do. For example, the owner of a business or the CFO will be able to
use all the features in QuickBooks, but a new bookkeeping clerk might only
be limited to certain features.



Last, but definitely not least, do turn on your Audit Trails feature. This will
allow you to see exactly what changes have been implemented, by whom,
and when. This feature is precious not because you mustn’t trust your team
or place blame as soon as something bad happens, but because sometimes,
honest mistakes are made - and knowing how they happened will help you
avoid them in the future.

This is pretty much it with maintaining your data security via QuickBooks.
When it comes to your operating system, on the other hand, you don’t have
to do much. Basically, all you have to do is make sure you:

●        are using an OS that is still receiving security updates (e.g.
Windows XP doesn’t receive security updates from Microsoft
anymore)

●       run your security updates

●       install an antivirus

●       use a password for your OS login

●        in extreme situations, you might also want to consider using a
Kensington lock (a lock made especially for laptops, to avoid
having them stolen)

●        practice general online security (e.g. not clicking on shady links
you receive online, even when they appear to come from someone
who is your friend and whom you know, or even when they appear
to come from your banking services provider).

In addition to digital security measures everyone should take (when using
QuickBooks and in pretty much every other situation), there are some
further actions you should take to ensure that your QuickBooks is properly
maintained. The most important such actions include the following:



●        Always compare physical inventory with accounting inventory. If
products get stolen from your inventory, for example, your
accounting system will not know how to pick up the new
information. As such, as tedious as this job may sound, checking the
physical inventory and comparing it with what you have on (digital)
paper is quite necessary.

●        Reconcile your bank accounts. You don’t want to believe your
employees are stealing by using checks in your company’s name,
but the best way to make sure this isn’t happening is by reconciling
your bank accounts and double-checking what has been going on in
them.

●       Train employees to use QuickBooks and to know it inside and out.
Even if they don’t have access to all the data and all the features, if
they have to work with financial information, they will have to use
QuickBooks from hereon. There’s no point in having this software
if your people can’t use it - so even if it might take a bit of time
investment, it is more than worth it to train your team in using
QuickBooks at its various degrees of difficulty. This is one of the
single best ways to make sure your data is kept clean and tidy and
that your employees or your team are not making mistakes when
doing financial actions via your accounting software.

●       Learn to look at QuickBooks as more than just a tool to invoice and
make payments. As mentioned before, this software can become an
invaluable help on your way to business growth. Make the most out
of it!

Once set up, QuickBooks is pretty easy to maintain - and, when needed, to
adjust as well. As we have said before, the hardest part is getting used to the
way in which this software functions, but once you are accustomed to it,
you will find it fairly easy to perform different actions in QuickBooks.



Data Protection and Its Importance
Although this is not entirely related to QuickBooks, as much as it is related
to what QuickBooks does (collect and perform actions with some of the
most important and delicate bits of information your business holds: your
financial data), we feel that dedicating a piece of this last chapter to data
protection and its importance is quite useful.

As we were saying in the previous section, your QuickBooks data is, in its
vast majority, confidential. This means that, if it gets in the wrong hands, it
could mean the demise of your business from multiple points of view.

A malevolent eye “looking” into your QuickBooks data is as disastrous as
seeing your entire company burn down to the ground. Not only will these
eyes be able to use this data against you, but they might be able to use your
customers’, your vendors’, and your suppliers’ data as well.

We don’t need to tell you this, but that’s a lawsuit waiting to happen.

You might think breaking into a computer is a really difficult affair, and that
your business is not large enough to be the target of a cyberattack. But that
is a completely wrong way to put it.

EVERYONE is a target of cyberattacks. From the personal computer you
watch movies on to the computer you use at home, to the phone you hold in
your pocket, and pretty much any other device you might have that is
connected to the Internet, you are permanently in touch with something that
could be a gateway for cybercriminals.

In 2018, the entire cybercrime industry generated no less than $1.5 trillion
(by conservative estimates). Moreover, a staggering 85% of the companies
interviewed experienced a cyberattack (Crane, 2019).

These stats might be shocking, but cybercrime is everywhere you turn your
head: in your email inbox, on social media, in apps you love to use and
have no idea that have been hacked.



Staying safe is pretty difficult, but not impossible. Aside from a proper
security tool installed on your computer, there are also measures you can
take to protect yourself and your company from the harsh effects of
cyberattacks:

●       strong passwords (as shown in the previous section as well)

●        not clicking on links even when they appear to be from a
trustworthy institution

●       not connecting to public wi-fi hotspots without limiting the type of
information these networks can access

●        not installing shady software of any kind and only getting your
programs from trustworthy sources

●       disabling bluetooth connectivity when you are in public places

●       disabling the auto-connect feature (unless you are at home)

●       only entering personal data in HTTPS formatted websites (you can
check the URL to see if they have this mark of security)

●       not sharing your location in general

Even the smallest leak can lead to an avalanche of problems - and what may
be even more staggering than that is that most of the time, people are
unconsciously walking into traps. Sharing your dog’s name on social media
and allowing everyone to see this information can be a breaking point.
Sharing your birth date can be a breaking point. Sharing any kind of
information can be a breaking point.

In addition to keeping yourself and your devices secure, it is also important
to make sure that you keep your team’s devices secure as well. As such, it
would be recommended to train them in the “art” of cybersecurity as well: a
couple of hours every few months can make a world of difference when



people are made aware of how many dangers there are out there in the
wilderness of the world wide web.

Before we move on, we would also want to emphasize the fact that data
security has grown to be even more important. With the Cambridge
Analytica scandal Facebook was involved in in 2018 (Wikipedia, 2020) and
with GDPR taking effect in the same year, data protection has been brought
to a whole new level.

GDPR (the General Data Protection Regulation) is a set of legislative
measures taken by the European Union to protect the data of its citizens.
Mainly, whoever is located in Europe is rightfully protected by the law to
have access to all the data different companies store about them, to give
their consent over whether or not this data is stored and used for further
purposes, and to ask for the deletion of said data as well. Even if you don’t
do business in Europe, there is still a pretty big chance that you might have
a vendor, supplier, or customer in Europe who is subjected to GDPR - and
as such, you have to abide by these rules as well.

Even more, with all the data scandals that have been taking the world by
storm as of late, it is very likely that the USA will implement a GDPR-like
regulation soon as well. It only makes sense to protect people’s right to not
have their data stored and used for purposes they are not aware of, so be
prepared to see it happening!

In addition to the cybercrime issue, people are very frequently under the
impression that digital data cannot die. It can’t, technically, because it will
always exist somewhere, in the black void of cyberspace. But it can
definitely disappear completely out of your sight, never to be recovered
again.

As such, to protect the accuracy and security of the data you hold in
QuickBooks, it would be best if you followed some simple tips:



●       Backing up your QuickBooks files (which you can do by accessing
the File menu and clicking on “Save Copy” or on “Back Up”). Keep
in mind that you can also set different preferences when it comes to
how QuickBooks should back up your data (such as how often it
should be done, adding timestamps, and limiting the number of
backups you can do)

●        Knowing how to restore QuickBooks files (by accessing the File
menu and clicking on “Open or Restore”)

●       Know how to clean up your data files and what happens during this
process:

-          the software will save an archive copy of your company
file

-          it will remove old transactions

-          it will summarize old transactions

-          it will clear the audit trail

To access this feature, you simply have to go to the File menu, click on
“Utilities”, and then on “Clean Up Company Data” From here, QuickBooks
will prompt a new window, from whence you can make your clean up
selections and choose your preferences on how this should happen.

Yes, maintaining your data and keeping it clean and secure is of absolute
importance. Regardless of whether you are an expert accountant, an
entrepreneur, or a new accounting clerk, it is essential to make sure that the
information stored and used by QuickBooks will always be private and
secure - precisely because the risks of not doing this bring with them
serious repercussions.

Nobody is too small or too big to do this - so make sure that your entire
team is aware of the data protection importance and why they should



practice it!

BONUS: Advanced QuickBooks Tips
In addition to the adjustment, administration, and data protection tips we
have offered to you in this chapter, we would also like to use the very last
pages to provide you with some “extra” tips that will help you work with
QuickBooks at its finest (and thus, make your life easier and your job more
efficient).

Here are some of the tips you might want to keep in mind:

●       Don’t be afraid to ask for help. This might sound like a silly piece
of advice, but hear us out. Learning something new is always
difficult, and one of the biggest mistakes people make is not asking
questions when they need to. Given that QuickBooks is about your
company’s financial information and statements, making mistakes
can have very serious repercussions on the business’ future (legal
and otherwise). As such, it is far better to ask questions when you
are in doubt - and fortunately, QuickBooks provides you with two
options when it comes to this:

-          Using ProAdvisor, a feature included in the QuickBooks Intuit
Package that connects you with a local accountant who knows
the legislation and all the location-specific tips and tricks you
might need to ask about. This person can help you set up
QuickBooks correctly from the very beginning, and they can
even provide you with information on tax requirements,
business structure, and so on.

-          Contacting agents. If your question is related to using
QuickBooks in general, don’t be afraid to contact their support
agents. They will be happy to help you out!



●        Take your time. Seriously, you can’t learn anything this complex
overnight, so take your time to invest in the basics of QuickBooks
and how you can use it best. Practice, read, and, as mentioned at the
first point in this list, ask questions whenever you feel like it. These
things can set you up for success!

●        The correct business information matters. This is not the kind of
setup you can make in a rush and enter gibberish information. Our
advice is to take QuickBooks setup very seriously because it will
make your life a lot easier, as you will be able to start using it right
away. As such, it is important to make sure that you enter the
correct company information - including, but not limited to, your
business structure, your tax ID number, your reporting forms, and
your calendars for reporting as well.

●        Use the right customer, employee, and vendor details. This goes
without saying, but you should definitely double and triple check
that each bit of contact and financial details you input about your
employees, customers, and vendors is completely correct when it
reaches the system. You can, of course, edit this information later
on, but in general, you want to avoid sending anything to the wrong
address or the wrong person precisely because the type of data you
exchange to your customers, employees, and vendors via
QuickBooks is confidential.

●        Reconcile, reconcile, reconcile! You have no idea what a massive
impact this can have on your business! Constantly reconciling your
accounts will allow you to check and double check that all
information is correct and that it adds up - and, when it doesn’t, it
will help you determine where something might have gone wrong.

●        Always make a backup. Ideally, you want to create an automatic
schedule for this because it can be a real time saver and a real



lifesaver as well. Backing up all the information will allow you to
recover it in case you lose access to QuickBooks, in case a file
doesn’t save correctly at some point, and in case you simply delete
or change something accidentally.

●        You can save money by printing your checks from this software.
Generally speaking, banks will charge you a fee for printing checks,
but if you want to avoid that, you can print them in QuickBooks. In
an ideal world, you might want to give up entirely on printing
checks (and documents in general), as this is a more eco-friendly
option. However, there are many situations that might require you
to print an actual paper document (or check, in this case) - and when
that happens, the best route you can take is, well, the least
expensive one.

●        You can pay your bills using QuickBooks. As shown in previous
chapters, you can connect your QuickBooks to your online banking
option. This will save you a lot of time and it will allow you to
make sure that you have a consistent, standardized procedure when
it comes to paying bills.

●       If you are using a newer version of QuickBooks, don’t be afraid to
customize its layout. Different businesses have different needs - and
having those “essentials” displayed in a way that makes it easier for
you to operate QuickBooks is quite important. To change your
layout, you have to access the Edit menu, click on “Preferences”,
and then on “Desktop View”. From there, you can choose whatever
options suit you best.

●        Use the Memorized Transactions feature. When you can automate
regular transactions, you are making them safer and you are saving
yourself time and effort. To be able to use this feature, you will first
have to activate it. The way to do this is by going to the Lists menu,



clicking on “Memorized Transaction List”, then on “Memorized
Transaction”, and then on “New Group”. This feature works best
for recurring payments or invoices you might be sending every
month. Not only do you eliminate the odds that you make an error
when making these transactions, but you also save yourself time by
simply making them automatic.

●        If you use freelancers or contractors in your business, it is quite
important to remember to set them up under the 1099 tax form. This
will allow you to sort payment and sales taxes to these specific
contractors and, as such, it will help you eliminate all the anxiety
associated with year-end 1099 forms.

●       The spell check in QuickBooks can be helpful because you do want
your invoices and information to be grammatically correct (it really
does help with your reputation). However, the same feature can turn
into a nuisance, particularly when you are dealing with different
company names that are not necessarily “grammatically correct”
and might trigger the spellchecker. As such, you should know that
you can turn off this nuisance by going to the Edit menu and
clicking on “Preferences”, then on “Speller”, and then by
unchecking the box that says “Always Check Spelling”.

●       If you want to find out what happened to a transaction (for instance,
how certain invoices and credit memos are related to certain
payments), you simply have to go to the Reports menu and click on
“Transaction History”. This will prompt you with the list of events
related to a transaction.

●        Not all businesses that use QuickBooks sell physical items. As
such, if you are in the “other” category and your services or
products “happen” online, you might want to consider linking your
email to your accounting software. This way, you will send invoices



automatically directly to customers, and you can also email reports
when you want to.

●        QuickBooks functions on the double entry bookkeeping method
(which we have discussed at the beginning of this book). If you
want to view the double entry of a transaction, you will have to go
to the Reports menu, then click on “Transaction Journal”. This will
prompt the window in which you can check if an entry is properly
posted.

●        You can also merge similar accounts as well. This can be a useful
feature when you realize that your lists contain information that
pertains virtually to the same accounts.

●       You can chat with your teammates directly in QuickBooks. This is
quite time saving because it will allow you to discuss QuickBooks-
related issues directly from the software. To use this feature, go to
the Company menu, and then click on “Chat With a Coworker”.
Keep in mind that the coworkers you want to chat with have to be
added as users in QuickBooks first (so you will not be able to talk to
someone who is not entered in the system).

No matter how you look at it, QuickBooks is a massively impressive piece
of software, and it can definitely change your life for the best. If you are a
business owner and you want to handle your own bookkeeping,
QuickBooks will help. If you are an accountant for a company, QuickBooks
will help. And if you are a representative of an entire team of financial and
business experts who handle advanced financial and business-related tasks,
QuickBooks will help.

Indeed, the main target market for this software is represented by smaller
businesses, but that doesn’t mean that QuickBooks is completely unusable
in a larger company. Pretty much anything you might want an accounting



software to do will be included in the list of features offered by
QuickBooks.

There are, of course, downsides to using QuickBooks as well. For instance,
it won’t help you with industry-specific features (like features connected to
the eCommerce industry, for example). Furthermore, it will not be able to
provide you with non-accounting reports. Last, but not least, because it was
initially geared at the small business market, it has a pretty tough limitation
of how many users can be added to an account.

Overall, though, the intuitive nature and the generous range of features
make QuickBooks a popular choice - one you have learned how to use
throughout this entire book!





Conclusion

New things can be quite scary.

Urban mythology has it that when one of the first short movies was
screened in a cinema, people panicked seeing a full, life-sized train heading
their direction from the massive movie screen in front of them (Wikipedia,
2020). We don’t know if that was true or not, but we do know that the story
is a pretty good parable of just how terrifying new technology and getting
accustomed to it can be.

Do you remember the first time you put your hands on a computer mouse
and just how unnatural it felt to move the cursor on the screen?

Or the first time you started to type on a smartphone’s screen?

How about the first time you drove a car with a manual transmission?

Indeed, there is a sense of panic and even terror we all experience in front
of new things. Some like the feeling. Some loathe it. But everyone
experiences it to a degree, precisely because thousands and thousands of
years of evolution have “wired” us to be pretty circumspect when it comes
to novelty and to love the stability of what we already have.

If it weren’t for people who actually love the feeling of “a new thing”, we
wouldn’t have gotten very far. The fire wouldn’t have happened, and
neither would the plantation of potatoes in Europe. We wouldn’t have
discovered the Earth is, well, not flat, nor would we have discovered that
there is an entire new world across the “Pond”.

We wouldn’t have made the first computers, the first video games, the first
digital cameras. We wouldn’t have invented low-cost air travel, nor would
we have gotten on the Moon.



You see, human beings are pretty paradoxical when it comes to novelty. On
the one hand we fear it (don’t change something that’s working, says an old
adage). On the other hand, we are dependent on it because change ensures
our further evolution and, at some point, it will influence our very survival
as a species.

The world has never been static, and nor should we.

The fact that you are here, closing the very last pages of this book on
QuickBooks, proves that you are open to change and that you are ready to
step into a world where bookkeeping and accounting are plain and simply
easier.

Software applications have dramatically changed the way we live and the
way we do business. Without that first Microsoft OS, we would have still
struggled in operating systems that are painful (or we would have all been
Apple fans because there would’ve been no other option).

QuickBooks was founded in 1992, and ever since then, it has consistently
revolutionized the world of accounting software. It might not be the
prettiest software in the world, we’ll give you that, but it does its job
excellently and it is easy to use by a wide range of people (from those who
have nothing in common with the general field of accounting to those who
have been doing it for decades).

Learning how to use QuickBooks comes with its curve, we have to be
honest about that. This is largely due not to the way in which the system
was built, but to the complexity and the wide range of features it comes
with.

There are very few things QuickBooks cannot do, and for a piece of
software that was intended at the small and medium sized business market,
it really does go above and beyond. In fact, aside from the lack of certain
features (such as not being able to add a larger number of users to the same



account), QuickBooks does pretty much everything a corporate accounting
software would do. That is massively impressive, especially considering the
pricing gap between this software and applications that are geared at very
large companies.

Going back to learning QuickBooks, it is important for you to take all this
information with patience. You cannot learn how to use it overnight -
because if you think of it, you didn’t learn how to use the computer mouse
overnight, and you did not learn basic accounting overnight either.

It takes a bit of time to get accustomed to the oddities, the ins and outs of
this ultra-popular accounting software. But as we were saying it throughout
the book, once you have learned the basics, mastering the rest is all about
practice. The more you “play” with the software, the more familiar it
becomes and thus, the easier it will be for you to operate it.

This book was not meant to be exhaustive in any way. There are many other
features we could have discussed in detail, but the purpose of this volume
was not so much to create an anthology of how to use QuickBooks, as much
as it was to provide you with the basic “MO” of this software and how to
navigate it.

Indeed, starting QuickBooks for the first time might come as a shock,
precisely due to the sheer size of the software and the intricate setup
process. But if you think of it, you should actually be thankful for the entire
shock of seeing QuickBooks for the first time. By providing you with a
complex setup system, they are literally setting you up for success from the
very beginning, ensuring that you enter the necessary data to get yourself
started with their software.

If it weren’t for this setup process, you would probably wander in doubt and
confusion and not know exactly where to start or what to do first to make
sure that your company’s financial data is safely stored in your software.



Before we close this book, we would also want to take a moment and
congratulate you for getting this far. Accounting is no easy job, no matter
how much you handle, no matter what tasks you handle, and no matter how
many companies you have worked with so far.

It is, in fact, a demanding job - one that, as mentioned at the beginning of
this book, lies at the very core of what a business is all about. No matter
where in your career you are right now and no matter what your main
profession may be, you will find that accounting can be confusing and
irritating, but also incredibly rewarding when you finally see everything
settling down.

As an accountant or bookkeeper, or as an entrepreneur who is still handling
such tasks for your small business, these numbers are your very
professional essence. They are the numbers that pay salaries and the
numbers that make an entire company feel proud. They are the numbers that
eventually help businesses make better decisions. They are the numbers that
connect the purpose of the business with its profitability goals.

QuickBooks is incredibly easy to use and it provides you with a very, very
generous range of options. For a fraction of the price of a bigger software
program, QuickBooks offers you customization options and a very long list
of tasks you can perform with it.

Life is just easier when you have the right tools by your side, no matter who
you are and what you do for a living - and as an accountant or bookkeeper,
you will definitely experience the same as well.

There is a world of options when it comes to software, but when you want
to settle for that which seems to have settled in the hearts of so many,
QuickBooks will always be a good choice. It will always be the choice that
helps you remain at the core of the business you work with and at the core
of the decisions made within the company.

Yes, accounting isn’t easy. But when you have the right tools and know how
to operate them intelligently, your work life can be so much quieter, so



much more accomplished, and so much more efficient!

No more days when you have to stay at work until 9 pm because you have
to manually transfer reports, no more endless spreadsheets that never make
any sense to anyone outside of the company or outside of the management
circle in the company. The more we advance in technology and science, the
easier it is to make people’s lives easier.

And both QuickBooks and the book at hand are all about that: making your
life easier too.

Thank you for having chosen to read our book and thank you for getting
this far. While we do know accounting and bookkeeping are not always the
sexiest topics, we do hope that we have provided you with genuinely useful
information, from the GAAP and what they actually mean for the
accounting world, to how you can use QuickBooks to ensure data
protection, as well as to help your company grow by performing advanced
financial analysis on the numbers you already have.

There is a world of Big Data opening right in front of our eyes - and
software like QuickBooks is bound to be a part of it, a part of the future, a
part of how we choose to handle our money, our economy, and our
entrepreneurship from now on.

According to Yuval Noah Harari, the world of tomorrow is closely linked to
the data we have been collecting over decades and decades of digitalization.
In his vision, we are looking at a future where all the data will be free-
flowing through cyberspace, allowing machines and artificial intelligence to
use it for future predictions (and adequate solutions as well) (Harari, 2015).

We don’t know if we should like the future painted by Harari. While there
are definite benefits when it comes to the idea of free flowing data, there are
obvious disadvantages as well (such as, for example, what happens if an ill-
intentioned someone lays hands on the machine learning algorithm and
alters the programing to their own advantage?).



Whichever side you want to be on when it comes to the future of data, one
thing is for certain: you do want to be ready. You want to make sure that
your company data is safely stored and processed in systems that are
capable of handling the influx of information and provide you with
insightful reports on what your business should do next.

This is precisely why learning how to use QuickBooks is larger than simply
digitizing your accounting and bookkeeping efforts and moving them past
the basic spreadsheets we’re all so used to. Yes, this is an effort to make
your life easier today, as much as it is an effort to make your life easier
tomorrow.

Consciously or not, stepping up to QuickBooks represents the kind of new
beginning all businesses will have to experience sooner or later. It’s already
hard to imagine life without a proper accounting software, and it’s pretty
hard to imagine an accounting software market where QuickBooks doesn’t
exist. With the wide range of benefits it offers, it’s pretty hard to imagine
why you would settle on any other similar software too.

Regardless of what your motivation behind choosing QuickBooks may be,
regardless of how brand new the entire concept may be to you and
regardless of how much of a novice you are in the art of accounting, we do
hope our book has proven a useful addition to your learning process.

We started off slowly, by introducing you to basic accounting principles.
Whether you noticed or not, they are all somewhat integrated in the way
QuickBooks functions - and they lay at the foundation of why QuickBooks
should be used as well. From the fact that a system like this ensures
absolute transparency to the fact that a good accounting software will help
you stay on track with all your reports, QuickBooks is, by and large, one of
the most GAAP and IFRS-friendly software applications you could use.

We then moved to basic bookkeeping tasks. As you have noticed, they all
follow a pretty straightforward pattern: you have to go to the designated
menu, click on something, and then make adjustments in the window that



will be prompted up. Regardless of whether you are sending an invoice or
making a payment, the steps will be more or less the same (with the
exception of the specificities involved in each of these financial actions, of
course).

QuickBooks is so much more than a software you can use for invoices and
payments, though. It can be used for advanced accounting tasks as well,
which is precisely what we tackled in the third chapter of our book. While
the connection between advanced accounting tasks and QuickBooks may
not seem direct, you should consider the fact that all the reports this
software generates automatically make your life infinitely easier. No more
data compilations, no more missing zeroes, no more struggling to create
endless spreadsheets - the system will do it all for you, so that you can
move on with your job and be really good at it.

Advanced management accounting is about more than financial statements
and reports as well. It is about creating plans that will help the business
actually grow and flourish - and this is precisely the subject we wanted to
approach in the fourth chapter of our book. From building business plans
that are comprehensive and persuasive, there is a world of business tasks
where QuickBooks can prove to be an invaluable ally.

Last, but definitely not least, we used our fifth chapter to circle back to the
basics of the software and help you with tips related to the adjustments you
might have to make before you start working in it, to how you should
administer it, to why data protection is so important (and how to achieve it),
and, finally, to advanced tips that will make QuickBooks an even better
addition to your life.

It doesn’t matter who you are or where you are. If you want to be able to
handle your company’s financial data with accuracy and in the easiest way
possible, accounting software is the way to do it.

Hopefully, the book at hand has helped you learn how to use one of the best
and most popular accounting software options out there. But even more



than that, we hope that our book has helped you think out of the box and
understand the real power such software can harness and the ways in which
you can incorporate it into your business growth processes!

Are you fully ready to step into a world where your financial data is the
underlying fuel for growth, beyond the cash flow? Into a world where your
reports speak for themselves and you can speak in their name in front of
business boards and investor groups? Into a world where you can actually
achieve all your dreams by using your wits, your ideas, your business
acumen, and software you can actually rely on?

Yes, there is a learning curve to QuickBooks, just like those first people
learned that there is a learning curve to watching movies. But novelty will
always settle in place - and this “newness” of QuickBooks in your life will
soon become one of the best decisions you have ever made for your
business!

Be brave and face the “machine” with a massive smile on your face,
knowing full-heartedly that you can control it however you want and make
it provide you with all the information you need!

We wish you all the best of luck in your future endeavors and hope we have
genuinely helped you with our book!
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Introduction

In this book, we are going to explain all the advanced techniques, methods,
and tools in QuickBooks that will allow you to easily manage and handle all
your financial records of your company in the most astounding manner. We
are going to go over various methods and ways that are not only going to
make your day to day work easier to handle, but it will also allow you to
generate and retrieve all the desired information which you demand.

We will start by explaining the technique which you can adopt to save your
company files from data corruption and loss of data while making our way
to the advanced inventory management and valuation methods. Along with
that, we will also explain the various utilities that you can use to make your
business’s operational work handled within just a couple of seconds.
Afterward, we will navigate to the most crucial area of the business
operation that will involve advanced cash management and cash flow,
maintaining techniques with the advanced sales management system.

In which we will look into the crucial ways of handling the cash and
keeping our cash reserves secured in correspondence with our revenue and
debtors. Later on, we will navigate to the other section of the cash
management and cash flow maintenance with the purchase system, where
we will elaborate on the most advanced techniques and methods to reduce
our payment costs and to keep a perfect track of the supplier balances.

We will also look over to the various ways to generate advanced reports and
utilizing the advanced reports with various combined reports and self-
created reports in QuickBooks. The concluding chapters of this book will
cover the common payroll issues and payroll problems, which can be easily
solved with the new advanced techniques while also explaining the
automatic method of having your fixed assets managed easily.





Chapter 1
 



Getting Started with 
QuickBooks Customization

Are you tired of using your outdated accounting software and looking for a
way to change it? Are you looking for a way to transfer your old company
files into QuickBooks to resume your work from there? Are you looking for
a way to customize QuickBooks just as you desire?

Many users find it difficult to understand how they can set up their
company in QuickBooks if they wish to migrate from their existing
accounting software. On the other hand, the QuickBooks users wish to
create a new company file from their old company files. However, the risk
of losing your precious data while transferring company files could be
devastating.

You may feel like you want to set up your company on QuickBooks without
having to compromise any of the old data. At the same, you may also wish
to create a unique user interface that is best suited to your needs.
QuickBooks is astounding digital accounting software that provides a
diverse range of benefits to you and its users. That’s why, in this chapter, we
will go over the following important topics:

•         Preparing your new company files from old data

•         Customizing QuickBooks to your needs

Is it Best That I Start All Over Again?
If you are an old QuickBooks user and are finding out that your existing
company data files are starting to take up a lot of space, then the best
solution to avoid such types of issues is by creating a new company file.
The reason could be that due to the previous data, there isn’t much disk
space or simply your company files carry data corruption viruses or glitches



in them. Making a new company file can be a time-consuming process, and
you will have to pass the transactions all over again, so to tackle this
particular issue, QuickBooks has provided an alternative solution to your
problems.

But before we start, you should stop for one second and realize whether
starting a new company file would be beneficial. A lot of times, setting up a
new company file doesn’t solve a specific issue. For instance, a payroll
processing glitch that doesn’t properly clear off the payrolls that have been
paid previously. In such cases, you should consult from the customer
support of QuickBooks to get a better picture of your problem.

Another thing that you should focus on is whether you can set up your new
company files after or at the end of the current financial year because
starting such type of process in the middle of the current financial year
could result in loss of data. The impact of this action of yours can result in
devastating consequences. The ideal time to start such a task is after or at
the year-end.

Archiving and Condensing your Data
The first feature that comes up is archiving and condensing your data. This
feature of QuickBooks allows you to make your previous data and previous
information inaccessible entirely. This is done by completely deleting your
previous data of the current company file. This makes sure that none of the
previous data, reports, and other transactions except the preference settings
and lists can be opened again.

It is important to note that you must keep a backup of the entire company
file before starting the process of condensing your data. This will help you
in retrieving any previous data which you require at any time. To remove
the data and the transactions, follow these steps:

1. From the menu, firstly, you will have to navigate to the File. Then
select Utilities -> Condense data option.



2. Find the Remove the transaction option in the condense data
window and click it.

3. Select whether you wish to remove all the data until a specific date
or completely remove all the data.

4. Afterward, Choose Next -> Begin condense.

Once this process is finished, you will receive additional space that
QuickBooks will provide you relating to your company data files. However,
QuickBooks only archives and condenses those transactions which have
been closed or cleared. For instance, if a customer has a receivable balance,
it is an open transaction. Once the customer pays his outstanding dues, it is
a closed transaction.

Lists and other settings that have been made personally by you will not be
removed during the entire archiving process.

Migrating from Another software
It is also possible that you might already use accounting software and wish
to transfer your data files from there to QuickBooks. For this, QuickBooks
mostly offers the basic setup features which allow you to make a new
company file to start all over again. However, the advanced set up provides
much more dedicated control to you so that you can design the interface as
per your desires.

You will need first to extract the closing trial balance, the general ledger,
the balance sheet, and the profit and loss statement from your previous
accounting software. The reason for this is because you will need to create
the opening journal entries for your company. To do so, you will have to
follow the steps mentioned below:

1. Select the option File-> New Company.



2. Once that is done, you will be provided with the options of Express
Start, Detailed Start, and other options. Choose the Detailed
start.

3. After you have selected, QuickBooks will begin the normal course
of procedure where it will ask from you the Company information,
industry, and other information regarding your company. Fill all the
required fields and the important information in the window. 

4. After you complete the company information and press enter to
navigate to the next window, QuickBooks set up wizard will ask for
customer details, product/service details, Bank accounts, etc. in the
subsequent window.

5. Add all your desired information in the defined fields and rows.

6. Once you are done, find Finish/ Start Working at the bottom and
click on it.  

QuickBooks will automatically open the user interface where you will have
to interact with the software- after you are done with the steps mentioned
above. The next step involves adding all the balances and including them in
the QuickBooks for the current year. For this:

1. Prepare and complete the entire list of the Chart of Accounts, which
is present in List-> Chart of Accounts. Make sure that your new
chart of accounts for QuickBooks is completely similar to your
previous company data files. You can match them line by line with
the name of the accounts mentioned in the extracted trial balance.  

2. Create an additional account named as Adjusting Equity or
Opening Equity. Opening equity can be used as a suspense account
to hold the opening balances of the account ledgers. Note that
QuickBooks automatically creates the Opening Equity account



once you enter the opening balances from the Chart of Accounts
edit page for certain accounts.  

3. Pass the Journal Entries for all the accounts excluding the actual
equity account balance, trade payables/trade creditors, trade
receivables/trade debtors, and fixed assets. 

4. Make sure that the net difference in the combined journal entry is
targeted to Opening Equity, which you can adjust later on. 

For bank balance and other cash items, QuickBooks will ask for the
opening balance at the start when the detailed setup process is underway.
For trade receivables and trade payables, you have two options either
include all the invoices of each trade receivable and trade payable by the
use of the home screen cycle. Alternatively, you can include all the values
and the amounts as a journal entry for the entire account ledgers without the
invoices.

For fixed assets, there are again two options available in QuickBooks -  you
can add all the fixed assets with their written down value from the Fixed
Asset Manager tool, which is present in Company -> Manage Fixed
Assets, or you can pass the Journal entries. Another way is by adding these
fixed assets in the Fixed Asset List. The end result has to be the same
because they all have to balance out the adjusting Opening Equity account.

Once this is done, the adjusting Opening Equity account will have a zero
value, and your opening balance sheet will reflect the exact figures as
reported in the balance sheet extracted from your previous software.

Common Issues during Set Up
You might experience the common issues when migrating your company
files to QuickBooks. The reason is that you won’t be able to balance out the
chart of accounts properly. When adding the balances, you might think that



the task has been performed accurately, but due to the advanced mechanism
of QuickBooks- all entries do get balanced but in the wrong accounts. 

This proves to be a minor issue for you as it doesn’t allow you to easily
trace up any missed entry or error in case the trial is perfectly balanced-
especially if you are operating your business on a larger scale or the
management of your personal finances is a bit complex. So here are a few
tips to keep in mind:

•         If you feel that you will ensure a more controlled line of operations
after you switch to QuickBooks, then try to pass the Journal Entries
in the combined form rather than splitting it into multiple journal
entries. This will reduce the errors of risk as all the entries of a
particular account will be clubbed in one main group.

•         Since the new QuickBooks has more advanced features, it is best
recommended that you provide the opening balance at the time
when you are preparing your Chart of Accounts in QuickBooks.
This will automatically pass the other entry in the Opening Equity
account created as default by QuickBooks.

•         Accounts receivable and accounts payable account types won’t
provide you with the option of entering the opening balances at the
time when the Chart of Accounts are being prepared. Therefore, it is
recommended that opening balances of individual accounts are
added through the Customer Center and the Vendor Center,
respectively.

•         Make sure that you reconcile all the balances at the end of your
work. Normally, people tend to avoid that and would start using the
software. Reconciliation can be done with the balance sheet or the
trial balance both.

Personal Customization of QuickBooks



QuickBooks is already equipped with the pre-defined default features that
allow QuickBooks to function normally with the overall general users. But
it doesn’t mean that QuickBooks prohibits you and its users from making
the various changes in its settings. The default settings are present in the
software to make sure that people who are using QuickBooks for the first
time don’t find themselves trapped in countless problems or errors.

This facilitation of QuickBooks provides its user with huge flexibility that
makes it a credible software to use. The settings features can be easily
customized according to your particular requirements.

1). QuickBooks Preferences 
Preferences are the general things which you may observe on the
QuickBooks Interface. The default preferences, which are already active
when you download QuickBooks, include beeping a small noise or sound
when a transaction has been entered, automatically placing decimal points
in transactions, using the latest dates or last date entered for subsequent
transaction posting, etc.

The preference window includes two tabs; My Preferences and Company
Preferences. You can manually edit both these tabs. QuickBooks makes
this process completely easy to understand and enables you to become
familiar with your particular desire. You can access this window by:

i. Selecting Edit -> Preferences from the top menu bar.

ii. Navigate yourself to the desired tab.

iii. Once changes are made, press enter to save the changes. 

2). Personalized Icon Bars
Icon bar allows us to easily access the most common tasks which we have
to perform daily. Icon bars are normally best for those different types of
users who frequently navigate and access the software to make certain
changes. These people could be the accounts or finance department officers



of the business. They constantly make edits and changes on the same
company files present in QuickBooks. The icon bar works great in
combination with the security, and the roles feature given to these officers. 

Icon bar can help us in navigating the common tasks or can help us in
segregating the icons based on the roles defined for each user of the
business and its files. The common icons which are present in the Icon bar
include almost all of the company’s operational activities such as the
customer icon that allows us to access the various details regarding the
customer lists, their overdue balances and their outstanding amounts, etc. 

The Vendor icon allows us to extract the vendor details, create the various
job-to-vendor reports, and highlight the significant vendor transactions, etc.
Other icons, which include Bank, Payroll, Reports, Home, and
Accountant, provide all the different quick accesses to your different
needs. To customize the icon bar:

i. Navigate to the View - > Customize Icon Bar option on the top
menu bar.

ii. Select the desired Icons which you want to display on the Icon Bar.

iii. Press Enter or click Ok, once you are done.

You can also change the position of the Icon Bar to be displayed either on
the top side, left side, or even on the right side. This allows you to organize
the interface more easily and perform your tasks swiftly. 

3). Adding Custom Fields and Reports
Custom fields allow you to create your own database records by adding
various fields in the data tables. QuickBooks offers an advanced integrated
system that ensures that your accounting data is fully centralized with your
custom database requirements.



In the business environment, you may find it difficult to maintain redundant
copies of every client's information. Not only would you have to include the
list on your specially designed software, but you would also have to add the
list separately in your accounting software. That’s why this feature of
QuickBooks is especially beneficial for service industries and contractors.

QuickBooks allows you to create a limited amount of custom fields that you
can define on the basis of the input data type. Input data type means the
data that you will preferably enter- either as a text, a number, or in any other
format. This benefits you in creating a more streamlined system where the
entire history of the client, vendor, or other employees is automatically
available with just a click of a button.

This also allows you to create new customized reports based on the custom
fields that you have defined. To add additional fields:

i. Navigate to the Customer Center, Employee Center, or you can
navigate to the Vendor Center and click on any one of them.

ii. Select the option to create a new customer, employee, or vendor.

iii. Open the Additional Info tab and select Define Fields displayed as
a button.

iv. Create your desired custom fields, and press enter once done. Press
Enter once again to save the changes.

4). Allotting Account Numbers in Chart of Accounts
Most advanced users and experts used a really complex software that would
upload the information of the Chart of Accounts in a series of different
numbers. These series were considered the sequences of various accounts
that defined their order of displaying information in the General Ledger or
the trial balance. It was also majorly used because it allowed the relevant
accounts to be merged under the common group of accounts to which they
relate.



In QuickBooks, this feature can be easily accessed by those advanced users
who prefer to manually set up their accounts in the form of these sequences.
By default, these account numbers will not be displayed, and QuickBooks
will automatically assign the sequence secretly based on the pre-defined
order in its own algorithm.

The reason why advanced users prefer account numbers is that it gives them
the ability to control the group clubbing. This can be done by:

i.        Navigating to Edit -> Preferences from the top of the menu bar.

ii.     Select the Accounting icon from the icon bar.

iii.   Select Company Preferences -> Use account numbers from the
displayed accounting window.

iv.    Press enter to save the changes and resume the work.

If you want to club the accounts together, you can use the sub-account
feature that allows various accounts to be merged under the single category
name or classification.

i. Once you navigate to Lists- > Chart of Accounts, select an account
which you desire to make as a sub-account.

ii. Before you make the sub-account make sure that you have already
created the main account under which your desired sub-account will
be categorized.

iii. Right-click on the account and select Edit to edit the account
information.

iv. Navigate to the Sub-account checkbox and select it.

v. Enter the name of the main account that you desire.

vi. Press enter to save the changes- once you are done. 



This will classify all the accounts in the relevant main heads. This will
allow you to easily generate the reports and classify them based on their
classes. Such reports will provide a much in-depth analysis of the financial
records.

For personal finance management, this classification feature can also
benefit you by allowing you to segregate your main expenses from the
extraordinary expenses. From a business perspective, you can classify all
transactions based on locations or regions.

If you are running a large or small-medium business operation and require
that you receive segregated reports based on the locations and the
departments, then this will allow you to segregate and classify all the
transactions. QuickBooks will automatically create the desired report in an
instant. 

Pro Tips when Setting Up the QuickBooks Interface
You must be fully aware once you are setting up your QuickBooks
Interface. However, this chapter is aimed at the advanced methods to ensure
a more user-friendly interface while maintaining all the key principles to the
accounting itself. Here are some of the pro tips which you should keep in
mind:

1. Properly create and define roles when setting up the QuickBooks to
ensure the safety of the company data files.

2. If other users are accessing your company files, make sure that you
keep an eye on the audit trail and observe any changes being made
by other users. The audit trail feature is present in the Reports ->
Accountant & Taxes -> Audit Trail. 

3. Once you have created the lists and entered the other crucial
information in QuickBooks- lock the lists and the set up so that
other users can’t access it or change the lists. 



4. Extensively navigate the Preferences to know about the different
settings features that are present. If you are operating in other
currencies as well, then turn on the multi-currency feature to pass
Journal entries in foreign currencies as well.

5. Don’t forget to turn on the payroll and other features. It is essential
that you add the list of employees first and then turn on the payroll
features. You can access either the online version or the manual
function (this will be explained in the later chapter).

6. If you are creating a new QuickBooks company file from the
existing one or archiving the previous company files- make sure that
you have saved a backup copy in a different place before archiving
your company files. This way, you can access and restore the
previous company files at any time.

It is important to note that you won’t be able to access the recent or current
company files once you open the previous company files. So it’s best to
always keep a backup copy of the current company file as well before
accessing the previous company files.





Chapter 2
 



Inventory & Items Management

The inventory and item management system in QuickBooks is far more
advanced and far more integrated than you can ever expect. The inventory
management system doesn’t simply record and maintain the inventory, but
it can go way beyond the common use. For service industries, inventories
aren’t the main streams of income. Rather, they rely on rendering of
different services, which are classified as items- there is an item list that
controls all the items and billing mechanisms.

So if we are to classify the main sources of revenue based on the industry,
we would have a manufacturing or trading industry that relates to goods and
a service industry that relates to items or services. In this chapter, we will
focus entirely on the advanced inventory and item management techniques,
which will provide you with the expert knowledge on using QuickBooks.

1). Advance Inventory Management Methods
Managing inventory can be a difficult task, especially when you are
handling more than one type of item in your inventory. The main goal of
inventory management isn’t simply to enter the bills of suppliers in the
system, but rather a streamlined and integrated mechanism of inventory
management is also needed.

You will find that QuickBooks provides a fully centralized system to
manage your inventory with its different features. These features and these
management techniques are found in the enterprise version of QuickBooks,
so make sure that you have it installed.

a). Inventory Management at multiple locations 
If you are running a small-medium business operation or even a large
business operation- chances are you will have multiple inventories at



multiple geographical regions. These regions could be different cities,
different states, or even different countries. In such cases, it becomes an
extremely difficult task to understand the amount of inventory you have at
different locations and the value of the stock, which is present at hand.

The only solution in this type of case is by physically counting the stock
and performing valuation methods to estimate the proper cost of inventory.
No doubt, this technique is used by the management of different companies
and businesses at the year-ends or even the period-ends to compare their
physical records with the records mentioned in their systems.

However, the case that we are elaborating here is that you want to know the
cost and quantity of the inventory at any time. The few reasons why you
would find benefit in this method is that:

•         You will have full control over the procurement and the inventory
dispatch system that will allow you to dispatch inventory from one
main location (head office) to the various branches/ locations.

•         This will allow you to trace any inconsistency which is found in the
inventory management at the branches.

•         Most branches tend to order more inventory from their head office
for fraudulent activities. Through audit and inventory reports, you
will be able to analyze whether the branches require the stock or
not.

•         As the system is interlinked with almost all other operational
activities, the chances of the asset misplacement or theft can be
easily avoided or tracked.

So the first step to using the multi-site inventory feature involves enabling
it:

i. Navigate and then select Edit-> Preferences -> Items &
Inventory.



ii. The Items & Inventory window will be displayed and then select
the Company Preferences tab.

iii. In the middle of the window, you will see an option Advanced
Inventory Settings; Click on this option.

iv. Once you click on this option, find the Multiple Inventory
Locations tab and make sure that the Multiple Inventory Sites
checkbox has a tick on it.

v. Also, make sure that the row, shelf, and bin option is also ticked in
the tab.

vi. Press enter to save the changes made or left-click on OK.

After turning the multiple location feature “on,” you will notice that on
Home -> My Company (located in the top right side)-> Inventory
Activities- a new feature which is Transfer Inventory will be displayed
there. You can also build a new location for your inventory, which can be
received from the supplier directly to that location or send that inventory to
the customer from the new location.

This can be easily done by adding the new location description in the Build
Assemblies option. Select the Activities tab in the lower bottom side of the



Build Assemblies window and include your new site location from the
“New” option.

Once you are done with this, you will be able to perform multiple actions
smoothly.

•         You will be able to receive the inventory from the supplier at the
desired location. Once the bill is entered, you can assign the
location or site to the inventory and direct your supplier to deliver
the inventory to that place. You can also assign a new location at the
time when the bill is being entered. 

•         Not only that, but you will also be able to sell the inventory to the
customers, which are mentioned in your customer lists from the
desired inventory location. By changing the location from the top of
the Sales Order, you will be able to sell the inventory from the
desired location.

•         You can also transfer the inventory from one location to the other
by selecting the inventory from the place you want to transfer and
selecting the place to which the inventory is being transferred.
Navigate to Home window-> My Company-> Inventory
activities-> transfer inventory to perform such action easily.

•         In addition to this, you can also generate various reports such as the
sale of inventory by location, Quantity of inventory present at hand,
valuation of inventory by location, and other reports which will be
generated based on the inventory locations.

b). Allotting the Serial Numbers to the Inventory
Most users define the inventory items on the basis of a serial number or a
lot number. The serial number uniquely identifies a particular item in the
inventory. By using this method, you will be able to track and identify all
the items which are present in your inventory categories by their unique
serial numbers.



If you are running a large retail store in which there are over thousands of
customers and have over a thousand different items on your shelves, then
you will find that this feature is really interesting and handy. This will
provide you with outstanding facilitation when a customer finds a faulty
product or would like to claim their warranty on the product or would like
to exchange it with another one.

The most common issue which retail store owners face is when they ask
their customers for their receipts, and in major cases, the customer doesn’t
have a receipt, which makes it extra hard to verify that they purchased the
goods from your store. Luckily, the serial numbers will allow you to keep a
complete track of the items which are sold.

Again the first crucial step involves activating this feature on QuickBooks.
It is very important to note that all these advanced features are only present
in the Enterprise version of QuickBooks, which have such full access.
Follow the steps mentioned below:

i. Go over to the Edit section of the menu bar on the top.

ii. Click on Edit -> Preferences -> Items & Inventory to access the
Items & Inventory Window.

iii. Select the Company Preferences tab and navigate your way to the
Advanced Inventory Settings.

iv. Find the Serial Number tab and enable the Lot or Serial Number
checkbox by clicking on it.



v. Click on the other checkboxes as you desire in the tab.

vi. Once you are done, press enter to save the changes to your company
files.

The other options which will be present in the tab will include different
warnings and different popups, which will be displayed if any of the criteria
are met. You define these criteria but QuickBooks already has pre-defined
options that will facilitate you. For instance,

•         Displaying a warning if the serial number section of the inventory
is blank.

•         Displaying the warning sign if the serial number is already used for
another item of inventory.

•         A warning sign will be displayed in case the serial number doesn’t
exist in the system. This is typically helpful at the time of warranty
claims or refunds.

Once you are finished with all the desired settings, you will find different
hidden features unlocked in QuickBooks, which will allow you to add the
serial numbers or the lot numbers which you desire. You must remember
that the serial numbers have to be unique and must not resemble a series
that is already used before.



The best way to ensure that you are using unique serial numbers is by
creating an additional excel document where you store the entire data of the
serial numbers. You could manually make these serial numbers or they can
be the bar code serial numbers.

As some retailers purchase certain items from their suppliers, they tend to
use the same serial number which the suppliers have used. This technique
can be helpful if you don’t want to waste your time creating serial numbers
for your inventory, but as a large retailer, you will find that many of the
suppliers don’t use any serial numbers. So it’s best to create your own serial
numbers and lot numbers.

You will find lots of different uses for this feature, as it will streamline your
entire inventory management.

•         This will allow you to identify the entire inventory and its entire
movement. Thus, when someone tries to claim a refund or warranty
from you regarding a particular item, you will easily be able to find
that in your accounting system.

•         You can also track the item on the basis of the serial number, which
will allow you to find the name of the customer and the person to
whom you sold the item. 

•         This feature is super beneficial in case someone comes up to claim
the item for its warranty. You can simply search for the serial
number in the system and find the entire movement regarding that
particular item. By this technique, you will also be able to find the
supplier from whom you bought the items from.

You can access the search tool by clicking on the Report section on the
menu bar and then navigating to Inventory-> Transaction List by Serial
Number. From there, simply enter the serial number and the inventory type,
which will display all the transactions related to that serial number.



•         You will also be able to transfer the inventory from one location to
the other location, but this time it can be done by using serial
numbers that are allotted to the inventory.

•         You can also navigate to the Reports section of the menu bar and
use the new reports such as valuation of stock by serial number or
location wise inventory by serial number.

Now these entire features are defined for the serial numbers that are present
in QuickBooks. However, the other feature which is present is the Lot
number. All the actions and all the procedures for the Lot numbers are
exactly the same, but this time in the Serial/Lot Number tab, you will have
to enable the Lot Number checkbox.

This time instead of accessing the reports by serial number, you will be able
to access the reports by Lot numbers and enter your entire data by utilizing
Lot numbers defined by you. The sales and the purchases will now be done
in the form of Lot numbers. For the wholesale businesses, where the items
are always sold in lots, for them, this feature is best suitable and adaptable
for them. 

You must be fully aware of the type of business that you are running in
order to manage your inventory. For personal management, inventory won’t
play any contributing part, but if you provide some particular service, then
you should navigate to the Items and services section of this chapter.

c). Bar Coding your Inventory
Manually typing and creating the serial numbers or lot numbers at the time
when you are selling your product to the customer can take up a lot of your
time. This is especially true when the customer is trying to buy a lot of
items, and more customers are waiting in the line.

Another issue with the serial numbers for retail businesses and the lot
numbers for wholesale businesses is that it can consume a large portion of
your time in simply punching the numbers in the accounting system.



Sometimes, you will also be adding the wrong numbers in the system
accidentally, which will cause another item to appear on the list.

Barcoding is majorly used in the large retail business to avoid such types of
mishaps. Not only that, your employees or workers can also face a great
amount of tension when they have to manually add the serial or lot number
of each particular item. QuickBooks provides complete control and an
automatic mechanism through the use of barcodes, which makes the entire
process easy to perform without any pressure.

Before you start to use this feature, you need to first create the barcodes for
your products. Otherwise, let QuickBooks automatically generate the
barcodes for your products to make your work easier. 

i. Go to Files -> Preferences -> Items & Inventory.

ii. From there, select the Advanced Settings option for inventory.

iii. Navigate yourself to the Barcodes tab and tick the Enable barcode
checkbox.

iv. Once enabled, press enter twice to save changes into the company
file.

The Barcodes tab also has the option of the wizard, which allows your
QuickBooks to import or copy the barcodes which are present in a different
field and place them into the desired one. As mentioned earlier that in case
you don’t have any barcodes, then QuickBooks will facilitate you in that
task.

If you want to add the barcodes for each of the desired inventory items from
your excel sheets, then you can:

i. Go to Lists -> Add/Edit Multiple List Entries.

ii. Select the Inventory option, which is present in the search bar.



iii. Once QuickBooks displays the inventories by list, you can add or
simply paste all the bar codes from your excel sheet.

iv. Press enter or exit the window by clicking on the Save changes
button to save all the changes which have been made.

After you are completely finished with the desired changes, QuickBooks
will automatically provide you with all the functions and features which are
interlinked to the barcodes.

•         You will easily be able to purchase the items from your vendors by
simply scanning the barcodes on the products with the barcode
scanning functionality of the QuickBooks. If you happen to scan a
single item multiple times, the quantity will automatically increase
after each scan in the invoice bill of the vendor. This will allow you
to maintain the record of the inventory without having to enter the
codes for each particular item manually.

If you scan another item, QuickBooks will add the new item in a different
line of the invoice bill to ease up the process and to process the final
amount of the bill.

•         The same case applies when you are selling your products to the
customers. Each time the bar codes scans the item, it will
automatically generate an invoice in which it will calculate each
item at its retail selling price. You can also scan the serial number
by using the same bar code scanner.

•         Not only that, but this also eases up the process of transferring the
items or products to different sites of the business. Once you have
selected the destination from where your products are going to be
transferred, you can scan the items to create the list of products that
will be transferred to the other site.

•         By using this feature, QuickBooks makes it easy to manage the
business operations from anywhere and keep the entire set up



centralized and integrated.

•         You can also customize the various reports and include the images
of the barcodes in the price lists. This can help you in recreating the
barcodes for items that don’t have barcodes, or their barcodes can’t
be scanned easily.

•         In addition to this, you can also generate different reports based on
the barcodes such as sales by barcodes or inventory details by
barcodes, etc.

This feature can be used and merged with the multiple inventory location
features and the serial/lot numbers feature. By using all these features in
combination, you will easily be able to manage and handle your records
regarding inventory.

All these features are necessary in order to make the inventory management
process easy and simple. It is very important that your inventory is managed
and maintained perfectly. These features keep a check and balance on each
inventory movement.

Crucial Key Points on Inventory Management
Due to the advanced mechanisms which QuickBooks has introduced, you
might face some issues when maintaining the record for the inventory,
especially in case of inventory management.

•         You must always perform a periodic or yearly stock count for the
inventory, which is present at your different locations or sites. This
stock count should be done physically while being present at that
place. The reason is that sometimes some entries will be missed
from the system, which will cause differences in the physical stock
present at hand and the stock being reported on the system.

•         You must perform the reconciliation of the entire stock to know the
actual position of the quantity at hand and the quantity mentioned
on the sheets.



•         Keep in mind that a good inventory management software isn’t the
solution to protecting your inventory. A good practice which most
businesses follow is that they ensure a complete control
environment to protect the inventory. This includes hiring a guard,
placing a tagged security machine, security cameras, etc.

•         You must also count the cash in the register against the invoices
issued, reconciling the cash at hand and the cash which is received
from customers. This way, you will also be certain that the
inventory has been sold on their selling prices.

2). Advance Inventory Valuation and Grouping Techniques
QuickBooks segregates the two phases of the Inventory system as Inventory
management and inventory valuation techniques. Quite often, people aren’t
aware of the differences between the two phases. Both phases are
interlinked to the main common accounting system, but inventory
management typically reports on the inventory movements, whereas the
inventory valuation techniques are different from inventory management.

Inventory valuation comprises all the techniques which help in costing the
inventory along with any valuation adjustment of the particular inventory.
In advanced concepts and techniques, you will understand how the
valuation methods cause significant changes in the profitability of your
company.

Since you will be first learning how to access and use the valuation tools
and features- we will later get into the details regarding changes in
profitability.

FIFO Valuation
FIFO is a valuation technique or method which is designed to use the actual
costs of inventory. FIFO basically means “FIRST IN FIRST OUT” that any
item which is bought first or purchased first shall be sold first. Most



advanced users and experts follow the FIFO valuation methods, where the
items are present in a limited quantity and can be separately identifiable.

You must know that items have to be separately identifiable and can be
valued reasonably for FIFO actually to give accurate inventory valuations.
In QuickBooks, this function allows you to set your entire inventory
valuation record and management record on the basis of this method. You
must note that valuation techniques always work together with the
inventory management techniques because valuation provides the cost basis
for the inventory that is being managed.

The first thing which you will have to do is first enable the FIFO valuation
method in QuickBooks so that you can perform the valuation of your
products.

i. Navigate and select Files -> Preferences -> Items & Inventory.

ii. After clicking on the advanced settings option, navigate to the
FIFO tab, which is present in the advanced settings window.

iii. Tick the checkbox, which says Use FIFO, and then select the
starting date from when you want FIFO valuation on your
inventory.

iv. Press enter twice to save the changes and to return back to the
QuickBooks interface.

If you are just setting up the advance interface on QuickBooks and have not
previously used QuickBooks, then every item which you will add will be
automatically be considered under the FIFO valuation method. However, if
you have recently decided to convert from your existing method to FIFO on
your current company files, then some of your reports will be affected.

The common reports which will be affected by this change include the
statement of financial position or balance sheet, the inventory valuation



sheet, and the profit and loss statement, which includes particularly the cost
of goods sold. The valuation and the amount of the figures reported in each
statement will be changed as per the FIFO valuation.

You will notice that one the basis of the FIFO method is that all your
inventory, which is bought first, will be sold first, but the average cost will
remain the same. The main difference by this method will be that
significant value items that are bought later on will be present for a little
while longer on the sheets and systems as the old stock will first get cleared
from your inventory list.

However, QuickBooks still shows the average value of each inventory item
regardless of which method you use. But at the time of compiling up the
reports, the method which you would have enabled in settings will be
followed automatically by QuickBooks. By default, the average inventory
valuation methods are used to calculate the profits, but once FIFO valuation
is enabled, all reports will be generated on the basis of FIFO.

Adjusting the Values of your Inventory
Sometimes, your inventory will face certain damages that will cause the
item to be partially damaged or completely damaged and beyond repair. In
these types of circumstances, QuickBooks allows you and its users to make
the inventory adjustments very easily so that your accounting records are
up-to-date.

These adjustments can be done based on the value of the remaining
inventory or the quantity of the inventory. The main causes of these
adjustments are always highlighted after the stock count, which you or the
management will perform.

i. Navigate to the Home icon on the Icon Bar and select it.

ii. Go to the Company section, which is present on the top right side
of the Home window.



iii. Select Inventory Activities-> Adjust Quantity/Value on Hand.

iv. Enter the type of adjustment you want to make into the inventory
sheet and select the inventory which you want to adjust.

v. After adjusting either the quantity or the value of inventory, press
enter to save the changes to your company file.

You must remember that after you adjust your inventory in your accounts, a
double entry will be passed automatically by QuickBooks. This will
incorporate any type of change and pass the Journal entry based on the
variable change. For instance, if you change the inventory quantity and
reduce it, then QuickBooks will automatically consider that a loss has
occurred and will pass the Journal entry for it.

However, if you report an increase in the value of the Inventory, then
QuickBooks will consider this a gain for the company. You will have to
make sure that your inventory valuation techniques correlate to inventory
adjustments that you will incorporate. Otherwise, your financials will
become disturbed by net profitability.

The inventory adjustments will automatically perform its tasks based on the
current valuation method and the inventory management technique. So you
don’t have to worry about the inconsistency that can occur based on such
types of adjustments.

Assembling the Inventory
Most of the companies around the world divide their portion of the work
into multiple segments. Some of them purchase the raw material to
manufacture a certain item for another finished product. Some of them
assemble these particular units altogether and sell them into the market. In
contrast, others buy the end products in bulk from the assembling units and
sell them to dealerships or retailers.



In these cases, sometimes the inventory is in the final form of the product,
which is being sold in the market while sometimes the inventory has to be
assembled with other parts in order to function properly. In either case, you
will find that QuickBooks incorporates these particular needs of its users in
advanced functionality features.

The assembly tool for inventory is a great bonus for you, especially if you
are assembling your inventory into the finished goods. These assembly
features have certain beneficial elements.

•         It combines the various items and their costs to merge them into a
single final product.

•         It also allows you to charge the costs such as salaries and wages,
which are directly attributable to the product being charged to the
finished goods.

•         You can also add certain overhead charges or non-inventory
services into the assembling process.

This provides you with ample benefits to combine each variable and
calculate the final cost of the finished product. Along with that, with
services and other overheads being included in the cost of assembly, it will
provide you an accurate figure of the final cost of the product.

You can access this tool by:

i. Clicking on the Inventory Activities present in the Company
section of the Home window.

ii. Select the option of Build Assemblies.

iii. Select the item which you want to assemble and enter the quantity
of the finished goods that you want to receive.

iv. Once you have entered the desired quantity to build, press enter to
Build & Close.



You can also turn on the reminder in case you are running low on the stock
by selecting Company-> Reminder. You can also create your own list of
goods and items that are required by you to be assembled in the final
product. Select the Add New option in the Build Assemblies window to
create your own finished good item.

Are there cases when the Inventory Assembly tool won’t be beneficial?
There is a minor downside to this feature that it is not fairly recommended
for those large manufacturing units which have multiple stages of
completion for the final product. These are typically those goods that are a
part of mass production. 

The reason behind this is because, in the course of normal production, there
are bound to be some normal losses or gains. These losses or gains can’t be
easily adjusted amongst the entire batch of final products produced. Thus,
the margin of losses or gains become harder to adjust as the value or the
quantity of the assembled goods or assembled lot can’t be measured per
unit.

There is an alternative solution to this problem. If you have proper control
of the inventory that is being used in the assembly and the cost per hour of
labors and overheads is clearly identified, then you can calculate the costs
of the finished goods at the end of the day as a whole lot.

However, in a system where everything is constantly in fast action and the
JIT (Just in time) inventory delivery system is followed, then this feature
would not benefit you. Rather, it will cause distortions in your operational
activities. 

It is crucial for you to properly analyze your own system to assess whether
such tools will or will not benefit you.

Pro Tips on Handling your Inventory Records 



Advanced inventory features, tools, and techniques of QuickBooks may
seem really interesting and to the point, but you have to remember to
constantly observe the impacts of your inventory on your reporting criteria.

•         If you are running a retail business, then you should use the FIFO
valuation technique with your barcode and multi-scanning features.
Most of the time, this valuation technique helps in understanding
the newly updated costs of your products, which will allow you to
maintain your profit margins accurately.

If you use the weighted average method for your inventory, then it will
cause the recent hikes in prices to be averaged out with products bought by
you earlier. This will create a huge impact on the profit and loss statement
as this will increase the cost of goods sold and decrease the profits.

•         If your business activities involve selling petroleum or water or any
other liquid items solely, then you should use the default weighted
average method with the inventory adjusted techniques. The reason
is that such inventory and items like these tend to work in
correspondence with the market prices. Thus, it will ensure better
management with a lower cost of sales.

FIFO valuation methods won’t be beneficial in such cases as it will be hard
to keep track of the inventory which is being bought and sold first. For
instance, oil tankers contain mixed oil in their containment units, and in
case you will receive your inventory back from customers, you won’t be
able to differentiate the inventory based on FIFO.

•         Inventory assemblies work in direct correlation with the FIFO
valuation method. So a better cost analysis would be on the basis of
the FIFO valuation rather than the weighted average valuation
method. This will allow you to analyze the exact appropriate cost,
which is being charged to the finished products.



Normally businesses tend to use the weighted average method, but it
doesn’t benefit when there is an abnormal price hike or when there are a lot
of normal losses or normal gains in the entire production.

Thus, you must be fully aware of the tools and techniques that you will
apply for your inventory management, valuation, and adjustment. Each tool
and technique serves the optimal use when it is worked in correspondence
with the other tool, technique, or method.

Advanced Lists for Services
Many businesses don’t rely on the goods or products to earn their incomes
by selling it in the market. These types of businesses provide services to
keep their business operations running. You may also find that your
business might provide some type of service. For instance, you might sell
an air conditioner while at the same time provide the maintenance service
for the same air conditioner which you sold.

The other case could be that you are providing some type of consultancy
service or a booking service to your customer. Either way, you will have to
set up a different advanced mechanism to handle your services and ensure
that all your services are billed timely. The proper use of advanced
invoicing and billing mechanisms will be explained in a later chapter.

Using billing rate lists for advanced setup
The most common use of advanced billing rate lists is found in legal
consultancy firms or software and marketing companies. The billing rate
lists provide the rates of how your customer will be charged depending
upon the type of person from whom they seek advisory.

Normally in law firms, there are partners, managers, and even apprentices
who give legal opinions and advice to their clients. Now it is very clear that
the cost of legal consultancy from a trainee or apprentice would be less than
the cost of the partner of the firm. Meaning every single person in the firm



would have a different billing rate, which will be charged to the client if
they seek consultancy.

Not only that, but the same trainee could also provide different aspects or
different types of consultancy. For instance, for an opinion in a legal matter,
the trainee might charge $20 or $30, while if the same trainee provides
corporate consultancy, the cost can be $40 to $50.

In cases such as these, a proper billing rate list must be created to ensure
that the client is charged appropriately and not excessively for any service.

i. Select the List -> Billing rate lists from the menu bar.

ii. Go to the option of activities and select new ones.

iii. There you will see a fixed rate option or a custom rate option.
Select your desired option or the custom option in case you want to
add different billing rates for different services.

iv. Press enter once to save the changes.

v. Navigate to the Vendor center in the Vendor option of the menu
bar.

vi. Select your desired vendor/ trainee/ apprentice/ manager/partner.

vii. Navigate to the payment tab and add the billing rate level which
you desire.

viii. Press enter to save changes.

Once this is done, you will be able to add the time of the related vendors in
the timesheet, which can be done manually or automatically. This will allow
the costs of the vendors to be charged directly at the time the customer is
invoiced. QuickBooks will create separate records for the separate
employees who will perform such services for their clients.





Chapter 3
 



Advanced Cash Flow 
Management with Sales

A business is primarily in operation due to its ability to earn revenue with
each passing month. No doubt, this allows the business to expand, grow,
and create goodwill for its activities. In general, every business has one
motive, which is to increase its sales to increase its profits. This is the
common methodology that is used by many businesses to either tap into the
untouched market or increase their existing market shares in different
regions.

The essential component is cash, which drives or motivates the business to
expand its activities and create itself into a giant corporation. You may find
that some businesses have huge revenue turnovers every year, but the
margin which is trickled down to them is almost nothing in the end

The reason behind this is that such businesses don’t analyze their cash
earnings on every sale. Some businesses have great cash earning on every
sale that is for every sale of $50- they would earn $10 or $5. Such type of
cash earnings on such margins gives the business the ability to boost into
the market and gain more market shares.

In the end, you must know that it all comes down to the relative pricing and
the price levels which every business sets to ensure that its margins are
secured. For some businesses, fixed price rates on every item give them the
ability to manage their operations while ensuring steady cash flow.

Starting with Estimate Projections
One of the prime activities that large businesses perform is making the
necessary projections and estimates about a job or a contract before
accepting it. You must also know that the key to ensuring a good cash flow



balance is by understanding the amount of cash that you will receive as a
result of that transaction.

This involves different types of factors such as costs, overheads and any
additional cost, etc. which you will have to incur to complete an order or a
job. Estimates also allow you to set up the margins and the rates necessary
for you to manage other costs. These other costs include administrative
expenses, marketing and distribution expenses, etc.

QuickBooks allows you to easily set up the estimates while also giving the
beneficial feature of comparing the estimate with the actual costs and the
actual revenues. Not only that, but QuickBooks also provides the best
mechanism for assessment of your estimates based on the costs or selling
prices charged previously.

To set up an estimate regarding a job:

i. Find the Estimate icon which is present on Home.

ii. Select the appropriate job or the customer from the list.

iii. In the table below, include all the relevant costs or the item lists for
the particular customer or job.

iv. Press enter to save & close the window.

Once the client or customer accepts the estimated bill, you can start to
charge the client on the basis of the mutual agreement. The client will be
charged each time when you will issue an invoice, which is the source
document for them to accept and make you the payments.

The Sophisticated Way of Invoicing
Large enterprises follow a strict pattern to ensure that every business
activity is done by means of a defined policy. These types of practices allow
the businesses to become large independent entities that can perform their
tasks in a completely controlled environment. These types of practices



create best-sophisticated methods in dealing with a problem or an
abnormality.

However, it doesn’t mean that the small-medium sized businesses or even
the entrepreneurs shouldn’t follow such practices. The advanced use of
every function is reliant on a better ability to integrate itself in the control
environment. No doubt, certain elements of the businesses can’t be fully
integrated with a control system, but major activities can be done so in
modern practices.

The same case applies for invoicing. Most businesses invoice their
customers without prior creation of a bill that shows their estimated cost
and their estimated revenue on a project. Whereas, large entities follow this
pattern of invoicing where they first send their quotation to their customers
for them to accept.

QuickBooks allows you to easily create the invoices from the estimated
bills which have been generated. The invoicing cycle elaborates on a
pattern followed in QuickBooks, where it completely describes the process
with the help of the flowchart on the home page.

i. Navigate to the Home page and select Create invoice.

ii. Find the Customer or Job in the search list and use the arrow keys
to move up and down the drop-down list. Press tab on the keyboard
to select your desired customer or job.

iii. Click on the estimate that you desire to invoice present in the
Available Estimate window.

iv. Press enter to invoice based on the estimate.

If you are a contracting business and follow the invoicing method based on
the percentage of completion or progress completion technique, then you
should use some of the field information at the time of invoicing.



i. Firstly select the Progress Invoice option to enter your desired
percentage of completion of the job.

ii. Click on any one of the options which are present and fill the details
to complete the invoice.

iii. Press enter once you are done to invoice.

This advanced method of invoicing provides you with better cash flow
management during the projects, which allow you to check the progress
along the way. Not only that, but it also allows you to compare the estimate
with the actual project costs to evaluate where it has been incurred. 

With the use of estimation and invoicing method, you will be to:

•         Precisely understand the phase in which your project has reached.

•         Manage your cash flows on the basis of the invoices sent to the
customer.

•         Re-evaluate the credit risks involved with particular customers
regarding payment terms.

•         Re-assess the timely completion and delivery of the project to the
customer.

This will reduce your work by allowing you to easily manage all the
complex tasks and keeping a full track of how your projects or jobs are
being performed.

Eliminating Redundancies with Sales Orders and Invoices
You will notice that as the size of your operations will increase, more and
more issues will start to present themselves over time. The biggest problem
which businesses face is the supply of redundant inventory or goods to the
customer. Although it seems easy to be solved yet, it has a far bigger
complication on a large scale or even a medium-sized entity.



For instance, the customer has demanded certain goods to be dispatched to
them over a period of time under the defined terms of a contractual
agreement. Your logistics department sends out certain goods to that
customer based on the sales order that is defined as per the contract. If there
is no proper track of which inventory or goods have been sent out to the
customer, it can lead to the following issues:

•         You will end up sending more goods to the customer that is not
needed by them.

•         You will lose out on more cash as there will be less stock present in
the inventory.

•         This will cause a gap between the demand and supply chain of your
business operations, which will result in you losing goodwill.

To counter this particular issue, QuickBooks provides the full track on
which goods have been sent to the customer based on the partial delivery.
This, in turn, allows you to easily understand the number of goods that have
been sent to the customer. This tracking mechanism is done on the basis of
the sales order.

If the sales order has been fully satisfied, then one final invoice is created.
But if there are multiple partial deliveries- it can also be invoiced based on
the partial deliveries at the time.

i. Navigate to the Home-> Sales Order icon present on the Home
page.

ii. Select a particular customer or a particular job against the sales
order to be created.

iii. Create the sales order and fill the information regarding the order.

iv. Once the goods are delivered at every phase of the partial delivery,
enter the amount of the goods that are delivered in the sales order.



v. Press enter to save the changes.

This will automatically update the invoice and allow you to invoice the
customer based on the goods partially delivered. You will have to select the
same customer or job in the invoice creating window, and QuickBooks will
automatically fill out the details along with the goods sent to the customer.

You will be able to fully control and access the goods dispatch system to
reduce the risk of a customer being oversupplied. Thus, it will also ensure
that the invoicing and the billing cycle will work effectively with the
distribution system in full integration within the system. By maintaining a
fair record and documentation of the goods delivered, there will be no
redundancies in the operations.

If there are multiple sales orders of a particular customer, it can all be
combined into one single invoice as well. All you will have to do is select
any of the desired multiple sales orders to be merged into a single invoice.
This will create a combined invoice with the final total that will be due by
your customer.

Benefits of Reviewing Sales Order
Sometimes, you may be too busy to notice that some of the sales orders
concerning a particular customer are not fully completed. For instance, you
received multiple sales orders from multiple customers, and you supplied
one particular customer with partial delivery of the goods because of the
low level of stocks present at your warehouse.

In such cases, you could potentially put your goodwill and your reputation
at stake because if the customer becomes unsatisfied with such actions, they
might not order again from your business. Thus, it endangers your
credibility in the market.

However, you can easily avoid that by reviewing your open sales orders
from time after time to know which customer didn’t receive any goods or



which customer received the partial goods. The report section of
QuickBooks allows you to easily access such a feature that ensures all your
business activities are performed on a timely basis.

i. Navigate and open Reports -> Sales -> Open Sales order by
Client from the menu bar.

ii. You can also filter and customize the report by clicking on the Sales
Order by Item option in the menu or select Customize Report
option to choose your desired fields and filters.

You can also customize the sales order report in multiple different aspects
to provide you with the level of information that you desire.

This process also allows you to review your cash flow as well on every
sales order. The biggest problem which you might face is cash management,
meaning when it is required to pay and when it is required to receive the
cash. The sales order reports also allow you to analyze the demand
periodically that, if combined with the cash flows per month, could allow
you to reinvest any additional cash or cover up any lack of cash flow.

i. Extract the Open Sales order report by Customer from the
Reports -> Sales menu bar.

ii. Retrieve the report regarding the stock-at-hand as of that particular
date.

iii. Create an excel file with the Sales Order Report and rank each
customer regarding their payment terms, i.e., customers who will
likely pay earliest to be ranked first and so on.

iv. Combine the stock at hand report with the excel file and allocate the
stock to each particular open sales orders of the ranked customer
starting from the first.



This way, you will be able to analyze whether you would have ample stocks
to manage the orders, or you would have to order more stocks to fulfill the
demands. Not only that, if you see from the report that you have an
abundant stock and will receive cash fast as well, then the best way to
manage the excess cash is by investing it in short term bonds or deposits
that offer interest.

This type of advanced analytical analysis will allow you to manage your
finances and sales demand better and in an optimal manner.

Sales and Cost Management Systems
The common problem that you might find is constantly updating the costs
and the prices of each particular item or good. On the other hand, the
second problem is creating different prices for different levels of customers.
For instance, you may want the system to create the sales invoice for your
wholesalers different from the normal retailers, or you may want that
certain customers of yours always receive a beyond market discount for
their long-term loyalty or trust.

So is there a way that you can manage all these problems at the same time?
Is there a way that you can handle such an issue? Well, there is, which is the
Sales and cost management systems. Although you must note that there is
no such type of system in QuickBooks, nor is this a specific tool. It is
basically a combination of many different tools and techniques being used
in an advanced perspective.

The biggest benefits and use of the sales and cost management system are
only found when they are used adequately in coordination. By simply
updating the common cost of all the inventory items, you will be able to
save much more time to gain flexibility in managing your operational
systems.

Not only that, once the costs of your particular item are adjusted, it will also
automatically update the new selling rates of each product. Now, this



process can be followed smoothly and adequately under a defined line of
controls if you can easily adjust the certain markup or the profit level on top
of the updated costs. This can be achieved by two different features. The
first one is the price levels, while the other one is the markup on the cost of
the product. 

The price levels automatically control the costs and the sale price of the
inventory that can either be a fixed percentage of the cost or a variable
percentage depending upon the customer or the particular item. This allows
you to perform enhanced profitability analysis and visualize the actual
profit that is earned from the sale of each inventory item. 

On the contrary, the markup is the profit or finance charge in case of late
payment or a fixed percentage that increases the final cost of the invoice of
the customers.

These price levels will have to be first enabled for you to use them.

i. Navigate to Edits -> Preferences -> Sales & Customers
icon/option to select it. 

ii. Select the Company preferences tab and tick the Use Price Levels
option.

iii. Press enter to save the changes.

Once these price levels are activated, you can easily adjust and use them for
every item or a particular item. Navigate to Lists option in the menu bar,
and after selecting the price levels, you can add them according to your
needs. These price levels are assigned to the customers from the Customer
Center.

Please note that you can still change the rates at the time when you invoice
the customers. So, after you assign the price levels to the various customers,



the invoices will automatically use the rates as prescribed according to the
updated price levels.

Advanced Steps to Keeping Sales Transactions under Control 
So, how can you set up an advanced mechanism to streamline and handle
the operations? Can I combine everything and utilize them simultaneously
as my needs grow? At this point, you might have somewhat similar or
different types of questions that are arising in your mind.

But the common question right now is how advanced does this sales
transaction management system even go. To answer that question, let’s use
an example, suppose your business operations are far more complex than
what it was first anticipated. Due to this very reason, you desire to
implement a steady streamline set of policies and procedures in order to
handle the day to day affairs. 

Of course, the first and foremost issue that will arise will be the
management of sales orders. At one point, you will have to manage
multiple sales orders while, on the other hand, you will have to follow up
on the customers who still haven’t paid. The other common issue will be
managing invoices and preventing inventory supply to those customers that
have crossed their credit limits.

These issues and problems may seem easy to handle, but when these
problems have to be handled in the QuickBooks system, it can become
confusing. On the contrary, you will have to assess whether there are any
bypasses or loopholes, which can cause a disturbance in the normal
processing of QuickBooks.

So, here are some of the advanced techniques to handle your business sales
and finances.

1). Define certain credit risks for the major customers



Start by identifying all the large customers of your business. Large
customers are the key resources for managing your business operations and
guaranteeing sales every month. These are essentially the real long-term
assets for the business to grow and continue to strive in the upcoming
months or years.

Identification of the large customers and the creation of variable credit risks
associated with them allows you to set up a more priority-based work for
them that ensures that they don’t feel dissatisfied with your services or
products. Along with that, it also makes sure that these customers don’t
cause a debt issue for your business.

Make sure that you set up the proper details for these major clients. Major
clients/customers typically contribute about 15% of your total revenues. Set
the appropriate level of the credit limit in Customers -> Customer Center
-> Edit -> Payment Terms from the menu bar. Along with that, set the
payment terms as well whether the customer has the option to avail the
discount allowed.

Along with that, set up the appropriate price levels for these major
customers, such that they are also able to get various benefits from doing
business with you. Setting up the price levels and the credit limits for the
major customers will allow you to create an automated system that
generates their sales orders and invoices on the agreed rates.

2). Create a proper job and estimate it
Now, it is essential that, when you start the project by forming some
estimates or giving out a quotation to your customer, you have all the pre-
defined fields for the customers in order to negotiate with them adequately.

An estimate helps you decide whether supplying goods or services over a
period of time could prove beneficial for the business or not. Major
customers should be given an appropriate estimate bill to ensure that they
accept it and continue to take your goods or services.



Bad negotiations could end you up with losing out on money or result in
unclear terms with the customers. When preparing the estimated bill, ensure
that you also include the overhead costs or other associated costs so that
you can ask the client whether they will reimburse such costs. 

You must also ensure that you have adequately set up the markup in case of
late payment by the customers. Or if you consider the customer in good
financial condition and want to grow long-term business relationships, then
don’t include the markup on late payment.

3). Update the Sales order
The best way to follow the advanced mechanism is by preparing a sales
order each time these major customers make an order for delivery. This
allows you to keep track of both your inventory and your delivery of the
goods to the customer. This has been explained earlier.

You must make sure that the sales orders are created with respect to that
estimate bill so that you can manage the cash flows according to the
estimated bill. At any point, if there is a discrepancy in the sales order, you
can easily reconcile it with the estimated bill to know about any errors or
issues.

This procedure will ensure that your major customer doesn’t complain
about any issue which comes up during the work.

4). Generating invoices
In the invoicing phase, things will be different for major customers. When
the invoice is being created, the information will automatically be filled for
that particular customer. However, if the customer has not paid any of the
previous dues and exceeds the defined credit limit, QuickBooks will create
the invoice but will display a warning sign.

This will ensure a streamlined process and will allow you to confirm from
the customer regarding the outstanding dues and the invoices.



Later on, you can decide here whether you want to continue the inventory
supply to the customer and wait for the customer to clear the dues at a later
date. You can also decide to supply the goods after the previous dues are
paid. In either case, the actual work will come at this stage, where you will
have to take such a decision.

Until now, the entire mechanisms and techniques allowed you to control the
steady flow of income and cash into your business. Of course, it will also be
up to you whether you want to follow a different set of procedures.

These steps ensure that:

•         Your major customers and the key business incomes are evaluated
and monitored automatically.

•         You can control the entire revenue movement cycle and can
compare it with the estimates and expectations.

•         You can handle and manage inventory accordingly based on the
customer demand or the annual demand from all the customers
combined.

5). Tracking performance with the combined reports
You can also create various combined reports from one or more reports. As
explained earlier, combined reports help you in analyzing the problems in a
much clear way. If you want to analyze how the payment due from the
customer is affecting your business operations, then you can extract two
reports.

One report that will give the aging analysis of the customer while the other
report that provides the depletion of cash reserves with each passing month.
Once you combine both these reports together, you will be able to analyze
better the amount of impact in the delay of payment from the customer that
has made on the business operations.



From this method, you will also be able to compare your total cash reserves
with the total receivables at a certain date. There is a way for you to decide
the total amount of receivables that you can allow for your entire customer
list at any point. 

To determine the lower limit of the total receivables, you can compare that
with your payables to your suppliers. If your receivables are more 50%
more than the payables, then it means that it is a good minimum amount to
maintain for your receivables.

To determine the upper limit of your total receivables, you must compare it
with the cash reserves. If your cash reserves are 50% more than the
receivable, it means that in case a customer defaults, you will still be able to
pay back the supplier and order more inventory for later purposes.

You can also track the various performances of the business operations,
such as the profitability and the amount of cost saved from a particular job
or contract. You need to monitor the payments received from the customers
and the invoices sent to them because if they default at any time, it can
cause a severe disturbance in your cash flows and your cash flow
management.

So, make sure that you keep an eye out for such type of major customers.
QuickBooks also offers some combined reports. You can also use the
Budget vs. Actual Report present in the Reports -> Budgets and
Forecasts to analyze how much variance is present from the budgeted
figures and the actual figures. This can help you identify some major flaws
that you might not have accounted for at the time you created a budget.

Budgets are an excellent way to monitor your business performance and
revenue turnover. Not only that, but they also are able to identify various
targets and the probability of achievement of those targets in the short,
medium, and long term. In order to use this, please remember to first create
a budget regarding that customer to compare with the figures later.



6). Setting up security roles
Another way to ensure that there is no collusion in your business operations
is by creating the security roles in QuickBooks and monitoring them from
time to time. Each time when someone will log on to the system, the audit
trail will be created, which will highlight all the changes which are made by
the user.

Audit trails can be accessed from the Reports -> Accountants & Taxes
option on the menu. Audit trail represents the entire track record regarding
every person’s activity on QuickBooks. By using this feature, you can fully
question the person accountable for not following the procedures or being
involved in fraudulent activities.

This way, you can also ensure that fake invoices or fake sales orders are not
generated at any time.

By following these procedures, you ultimately reduce the risks of having
any sort of inconsistency or any sort of error that might occur. Not only
that, but this entire procedure also allows you:

•         To account for any transactions which you may have forgotten to
enter into the system.

•         To perform analysis on the business operations to confirm whether
the business can operate in the upcoming years.

Recovering the Debts from Customers
Sometimes, the customers forget to pay their dues regarding any invoice
that you sent them. Normally, it is hard to keep track of each customer’s
pending invoice. For this very reason, QuickBooks has a feature that lets
you track all the open invoices that have not been paid by the customer.

QuickBooks has a reminder feature as well that is located at the very top
left side of the screen that highlights all the overdue invoices and the
upcoming payments that are needed to be made to the suppliers. This



feature allows you to charge any penalties to your customer for paying late
and keeps you safe from paying any penalties to your suppliers on late
payments.

You can also access all the open invoices from the Reports -> Customers
& Receivables -> Collection report option in the menu bar that will
display the entire list of customers who have not paid their outstanding
dues.

Not only that, but you can also email all these customers a fair notice
regarding their outstanding balances from the Customer Center. After
clicking on the Collection Letters option, you can easily select the
customers to whom you want to send these letters. You can use a pre-built
format of QuickBooks, or you can upload a format of your own in
QuickBooks for highlighting any overdue balances.

These are all default features of QuickBooks, which don’t require any sort
of enabling. However, Collection Center is not activated when you first
start using QuickBooks.

i. Navigate to Edit and select Preferences.

ii. After clicking on Sales & Customers, navigate to the Company
Preferences tab.

iii. Tick the checkbox that says Enable Collection center.



iv. Press enter once to save the changes made.

You can then easily navigate the Collection Center in the Customer
Center. QuickBooks will display all the pending or overdue invoices along
with any other upcoming invoices.

Invoicing all of your Customers at the same Time
One of the best timing saving tools of QuickBooks involves the batch
invoicing tool that facilitates you in creating an invoice for many different
customers at the same time. This allows you to speed up the process of
invoicing your customers and keeping proper track records of the entire
sales revenue.

i. Access the Customer -> Create Batch Invoices option by
navigating to the menu bar.

ii. Add all the customers whom you desire to invoice by selecting them
from the search field.

iii. Press enter to move to the next window.

iv. Add all the items which you wish to invoice your customers on.



v. Press enter twice to create the invoices and let QuickBooks pass the
entry of the transaction.

You can also select to take a print of the batch invoice which was made, or
you can email them to your customers. Before emailing the invoice to your
customers, make sure that their email addresses are added in their
information tabs.

Advanced Use of Reimbursable Costs
In many service industries, some costs that are borne, especially for the
customer’s purposes, are reimbursable. For instance, if a team member of
the audit staff goes to the client for consultancy purposes and charges the
trip to the client’s office on their own office. In such cases, these costs are
meant to be recovered from the customer.

Many customers frequently ask their consultants or their lawyers to visit or
meet them in the office for some advisory or consultancy purposes. Thus,
all costs incurred by the consultant have to be charged to the client in the
final bills. Sometimes, these costs also include the third party who appeared
before the client or customer on behalf of your business.

Thus, you can easily charge these costs to the customer in their invoices by
selecting a particular customer.

i. Navigate to the Enter Bills icon on the main home page and add all
the bills or costs which are related to the customer.

ii. Enter all the bills and their descriptions (if you have already done
this, move on to the next step).

iii. Select the customer’s name in the Customer Job field and tick the
checkbox, which says, “Billable?”

iv. Press enter to save all the bills.



v. Navigate to the Create Invoice icon on the main home page and
select the customer who you are going to invoice.

vi. Once you select the customer, a pop-up window will appear.

vii. Select the option that says, “Select the outstanding billable time
and costs to add to this invoice.”

viii. Add all the costs, time, and expenses that are appearing against the
customer.

ix. Add the Markup amount or percentage if you desire.

x. Press enter to include all the costs

xi. Save & Close the invoice- once you are done.

You can also add the payroll costs to be charged to the customers on their
invoices by clicking on the billable option at the end of the payroll sheet.

This feature allows you to separate all the costs that don’t relate to your
business or have been incurred by your business on behalf of the client.
These reimbursable costs become part of the invoices and are shown as
receivables in your balance sheets.

You can also access all the costs and time not charged to the customer by
navigating to the Reports -> Customers & Receivables -> Unbilled Cost
by Job. By keeping track of all the unbilled costs, you will easily be able to
adjust your financial record.

 

This feature will benefit you by:

•         Segregating incremental cost per job and allowing you to
understand the true cost of your service or product easily.



•         Adjusting the amounts of the invoices to ensure that all the
reimbursable costs and time is charged to the client.

•         Reviewing at every period end regarding any pending unbilled
costs or time that is currently not charged to the client.

Advanced Mechanism for Handling Sales Tax
Certain circumstances apply when you have to include multiple different
sales tax to the customer for the purchase of different items. Normally, the
sales tax information regarding a particular customer is entered at the time
the new customer is added to the list. But that is the general sales tax
information.

The sales tax that we are referring to involves the sales tax on the items
when you purchase them. For instance, you sell steel or cotton to your
customer; there could be a high chance that the tax rate for steel could be
different. On the other hand, the tax rate for cotton could be different. Or if
you are rendering services and selling goods.

Not only that, sometimes, but there are also rates for particular items,
whereas, for some items, there could be a fixed amount that you will have
to pay. So, the best way to handle such circumstances and situations is to
create different sales tax on the single invoice.

 

1. Preparing the items for sales tax

i. Navigate to the List from the menu bar and choose the item
list option.

ii. Right-click on the window to choose the new option.

iii. Choose the Sales tax for the type of item.



iv. Fill up all the required information that will be displayed in
the window.

v. Press enter to save the item and close the window.

vi. Follow these steps again if it is necessary.

2. Preparing an item for sub-total

i. After navigating to the list from the menu and selecting the
new option, choose the item from the drop-down list that says
“Subtotal.”

ii. Fill the required information and press enter to save the item.

3. Charging the multiple sales tax on the invoice

i. Make sure that the rate of tax for the new tax items is zero
percent.

ii. Choose this sales tax at the option present at the end of the
invoice lines.

iii. Include all the items which are taxed at their individually
defined rates to be combined in the invoice.

iv. After selecting each taxable item, include the subtotal item.

v. Charge the desired sales tax underneath the subtotal item to
find the tax on the subtotaled amount.

vi. Include any non-taxable item after the sales tax item to be
added to the invoice.

vii. Press enter to save and close the invoice.

If you charged the incorrect sales tax to your customer or client, then you
can manually delete the invoice and issue a new sales tax invoice. However,



if the payment has been cleared and the customer paid the sales tax, then
you can issue a refund of the excess amount or issue a credit memo, or you
can adjust the excessive amount later from the subsequent invoices of the
customers.

QuickBooks also adjusts the sales tax on the invoices when you issue a
credit memo to the customer. This will allow you and your customer to
report the same to the tax authorities.

i. Choose Customers -> Create Credit Memos/ Refunds from the
menu.

ii. Add the customer name from the drop-down list. (Note: You
won’t be able to issue a credit memo to an unidentified third
party as QuickBooks will require you to include the customer
name).

iii. Include all the items against which you have received the
delivery back from the customer.

iv. Make sure that you add only those items which are taxable in the
fields and add their individual rates of tax.

v. Add the subtotal item to find the subtotaled amount of the items. 

vi. Enter your desired tax rates after the subtotal item.

vii. Press enter to Save & Close the invoice.

Adjusting Advances and Prepayments Against Invoices
In normal business practices, customers are required to deposit an advance
as security in case, when they are ordering a large number of stocks.
Similarly, some businesses require that an advance of a fixed percentage
must be deposited at the start of the work or a job that will be adjusted
against the final invoice.



These practices are majorly followed by service industries that involve
contractors and consultants who demand from their customers to deposit a
fixed amount before they start working on the project.

You may also have to face such a situation where you would have to ask the
customer to deposit an advance before you deliver the goods or render the
services. QuickBooks will easily facilitate you in adjusting such types of
advances that are received from the customers. Not only that, but
QuickBooks also displays all the advances or any sort of adjustments that
are pending against the invoice of a particular customer.

1. Receiving Advance Cash 

i. Navigate and choose the Receive Payments icons on the
Home page.

ii. Select the desired customer along with the amount and the
method of payment of the advance.

iii. At the bottom left side, new options will be displayed stating
the payment as “Overpayment.”

iv. Choose the Leave credits to be used later option to create
the credit for the customer.

v. Press enter to Save and Close.

Once you are done, the customer’s balance will be displayed as a negative
balance on the receivables side. Now, you can easily adjust this advance
with the invoices sent to the customer.

2. Adjusting the advance

i. Choose the Create Invoice icon from the Home page and select
the particular customer whose advance is available.



ii. Once you have created the invoice, select the Apply credits
button.

iii. A new window will pop-up showing the list of advances against
the particular customer.

iv. Choose your desired credit along with the amount which you are
adjusting against the invoice. You can choose either full
adjustment or partial adjustment against the invoice.

v. Press enter to apply the changes.

vi. Press enter once again to Save and close the invoice.

You can access the reports that will show the outstanding balances of the
customers as negative to depict it as an advance. You must remember that
your accounts receivable must not depict a negative balance at the year-end.
Otherwise, the authorities or the auditors can raise significant questions
regarding the outstanding balance.

The best way to make sure that your year-end balances are also adjusted is
by passing an adjusting entry that eliminates the negative balance of the
customer present in accounts receivable and shifts the balance to a liability
account for the same particular customer.

This allows the balances to be adjusted while ensuring that there is no
violation of the accounting standards. You can reclassify or readjust the
balances after the year-end by passing the reversal of the same entry. Once
you are in General Journal, select the option of the reverse transaction and
highlight the transaction that you desire to reverse.

However, you can also perform an alternative technique and procedure that
you create the liability account of the customer from the very start. Once
you receive the payment from the customer, you can simply change the
account to the liability account that you have created for the customer.



In this manner, you won’t have to adjust the balances at the year-end, nor
will you have to worry about violating any standards or law. The rest of the
procedures and steps will be followed in the same manner as described
before, without any changes. But you will have to make sure each time
whether the invoice has to be adjusted against the advance or will it be
adjusted against a different balance later. 

Closing off Balances of Bad Debt Customers
In extremely rare circumstances, you may find out that your customer won’t
be able to pay back your dues as they have filed for bankruptcy. These cases
don’t normally appear in the normal course of business transactions. If you
are a stable profit-making business and found out that one of your small
customers has filed for bankruptcy, it might not affect you a lot.

However, if one of your major customers, that contributes a large portion of
your income in your business- files for bankruptcy, then there can be dire
consequences. The first consequence would be the loss of immense cash
and revenue from the system. When you lose such a customer, it will place
risk on not only the receivable income but also the future incomes that were
expected to be recovered from the customer.

Writing off bad debts for such customers would result in a gigantic loss of
revenue and cash, but the accounting for such type of transaction is still
necessary. There are multiple ways to adjust the bad debts in QuickBooks,
but the most common one that users follow involves the Discount Allowed
option.

By using the discount allowed method, the customer’s outstanding balances
are entirely adjusted against the discount that makes it very easy and
extremely flexible to use. However, this type of method does not account
for the sales tax that was charged on the invoices to the customer.

Hence, the second method, that very few people use, involves the use of
credit memos. Credit memos typically highlight the sales tax adjustment



that is written off directly. But this method involves a lot of multiple
adjustments and a lot of changes because once you issue a credit memo,
you are increasing your inventory.

Let’s say that you lost both the inventory and the revenue from the client; in
such type of case, a credit memo will only adjust the lost revenue and sales
tax, but it won’t adjust the inventory that has now become part of the
business. So, in order to adjust that, another entry will have to be passed in
which the inventory would be adjusted or written off.

You need to note that, even though you may write-off the inventory from
your accounts, you will still be booking an additional loss in the accounts
which is wrong. The moment you write-off the inventory, you are making
the same entry twice. So make sure that when you pass the entry for bad
debts, your cost of sales or purchases isn’t affected by it. This way, the
purchases or inventory can be written off later on.

You must also remember that you will have to reclassify the entry later on
at the year-end to show that the loss of revenue was because of the bad debt.

1. Writing Off Bad debts using the Discount allowed method

i. Navigate to the Receive Payments icon on the home and select
the icon.

ii. Select the desired customer whose balance you want to write off.

iii. Choose the invoice which you want to write off and select the
Discount & Credit option.

iv. Add the entire invoice amount as Discount Allowed.

v. Press enter once you are done to Save and Close.

By doing so, you can also select the bad debt account as the discount
allowed account. In this manner, you won’t have to make any inventory



adjustment nor any reclassification adjustment.

2. Using the Bad debt item for writing off bad debts

This method is a little tricky, but if you are able to perform it in the right
manner, you will be able to adjust all the account balances without any
issue easily. This involves three phases:

•         Creating an item of bad debt that charges the balances directly as an
expense.

•         Preparing the credit memo on the basis of that item.

•         Using the credits in the Receive Payments window.

After going through all the three phases, you will be able to adjust the
account balances of the customers on the basis of their credit memos. Along
with that, the sales taxes on the invoices will be automatically reversed or
adjusted.

a. Creating the bad debt in the item list

i. Navigate and choose Lists -> Item list on the menu bar
at the top.

ii. Right-click anywhere to choose the New option.

iii. Select the Other Charge item in the list and proceed to
fill out the information.

iv. Make sure that you name this item as Bad debt and
choose the bad debt account for it.

v. Press enter to save the changes and create the item.

b. Issuing the credit memo to your bad debt customer

i. After navigating to Refunds & Credits option on the
Home page, select the desired Customer to whom you



are going to issue a bad debt credit memo.

ii. Select the bad debt item in the line and enter the goods
against which you are creating the bad debt.

iii. Enter the amount of bad debt to write-off from the
balance.

iv. Fill the remaining information, such as the tax code and
tax charged earlier, along with any other information on
the credit memo.

v. Once done, choose the Apply to an invoice option to
create the credits.

vi. Press enter to save and close the changes.

c. Auto-apply the credits in receive payments

i. Simply choose the customer from the Receive
Payments icon and apply the credits to adjust the entire
balance automatically.

ii. Once done, press enter to save the transaction.

You must note that these methods are used to adjust the major balances of
those customers who are now bad debts. In case of minor underpayments by
the customer, you can easily adjust the amount from the Receive Payments
window.

Simply enter the amount you received and mark the remaining payment as
Write off if you are sure that the customer won’t pay back the remaining
amount. Once you select the option, QuickBooks will ask for the write-off
account for this balance. Choose your desired account and press enter to
save the changes.





Chapter 4
 



Advanced Cash Flow 
Management with Purchases

In the earlier chapters, we have explained how the inventory is managed
without any direct regard to its impact on cash flow management. Simply
recording the purchases isn’t enough. Just like the sales transaction system,
the purchase system also has some advanced features, tools, and techniques
that might solve your issues or problems.

You will find that the advanced techniques, which we will explain in this
chapter, will target only the particular problem that you might face when
using QuickBooks. Not only that, but we will also provide a step by step
guide in facilitating you on how you can manage those issues.

Most businesses have a complex line of procedures for recording
transactions, and they follow those procedures to understand the advanced
accounting involved in their purchase systems or other systems. Even their
accounting for purchases and payables is quite difficult, but these large
entities are able to manage due to their diverse experience and staff.

In QuickBooks, you will find that there are multiple easy to use and
understandable advanced features that will quickly wind up any of your
pending work.

Starting with Owner and Employee Payments
Sometimes either you (the owner) or the employee will pay for a particular
item that is related to the company or your business. For instance, due to
lack of cash in hand, you decide to pay for your business's particular
expense, or one of your staff decides to pay for the expense to be
reimbursed by the business later on.



These are some common instances that you may face from time to time
when running your business operations. Of course, you have the option of
passing the General entry in the Accountant option of the menu bar, but
passing continuous General entries in such circumstances will disrupt your
financial figures.

Along with that, the same situation but occurring in a different order can
change the impact of how you process the information in QuickBooks.
Suppose that you or your employee took the advance first and then used the
cash to buy for goods or supplies. In this case, a bit different process would
have to be followed.

However, suppose that you or the employee paid for the supplies or goods
first and then asked for the reimbursement. In such a case, the process and
steps to be followed will be different from the one mentioned in the first
case. Thus, you have to be careful regarding the process which you will
follow. Otherwise, this won’t streamline your work and would create
irreconcilable errors that would lead to wrong reporting of the business
affairs and performances.

a. When the employee took the advance first

i. Navigate to the Chart of Accounts item in the menu bar and
create a new head of account as Advance to Employee
categorized as other current asset account type. 

ii. Fill the required information and press enter to save and
create the account.

iii. Navigate and choose the Write Checks icon on the main
home page.

iv. Choose the appropriate account from which payment was
made, and in the account name, select the new account that
you made for advances.



v. Fill the remaining information in the check and press enter to
save the check amount.

vi. Enter the bills for which you or your employee paid in the
Write Checks window by targeting the expense account in
the account name.

vii. In the next line, add the Advance to Employee account and
enter the amount as negative to clear off the balance as zero.

viii. Press enter to save the check and the transaction.

By performing this method, a receivable balance will stand till the time the
employee or you for the relevant expense or the goods- is paid. In this
manner, you won’t face any classification issue. You can also receive the
payment from the same employee if they still have outstanding balance
present with them by navigating and selecting the Receive Payments icon
on the home page.

b. When the employee has to be reimbursed for the expense

i. Navigate and choose List -> Chart of Accounts from the
menu and create a new head of account as Reimbursable
Expenses to Employees or Advances from Employees and
categorize it as other current liability account type.

ii. Enter the adequate information and press enter to Save &
Close.

iii. Navigate to Write Checks icon on the home page and select
it.

iv. Add all the bills which are paid by the employee.

v. In this case, add the Reimbursable Expenses to Employees
account in the next line as a negative balance.



vi. Press enter to Save & Close the transaction.

vii. Re-open the Write checks icon and include the name of the
employee to whom the reimbursable expense is to be paid.

viii. Include the account name in the line and enter the positive
balance, which is to be paid to the employee.

ix. Press enter to Save & Close the transaction.

This method should be used when the employees have to incur expenses
first- to be reimbursed later. Both methods depend upon the policy that you
adopt for your business. If your business adopts the reimbursement policy,
then the second method is best suitable.

You can also write off the balances and the reimbursements, in case the
employee doesn’t take the reimbursements. The best way to deal with this is
by passing a General entry to record the transaction as a gain on your
business side.

You need to remember that when you are selecting the account type for the
employee’s advances, you are categorizing them in their accurate types.
Otherwise, QuickBooks will display a negative balance at the asset or
liability side.

Taking a Peek into Prepayments
In the previous chapter, we have gone over the advances which we received
from our customers. In this section of the chapter, the situation is reversed,
where we make the prepayments to our suppliers or any other third party to
receive certain benefits, services, or goods.

We will first look into the prepaid expenses, and later we will take the
discussion to the prepayments made to vendors or suppliers. Most
businesses have a rigid system that handles these types of prepayments, but



QuickBooks offers great flexibility that ensures that you have a perfect grip
on the task with ease.

Automatic Adjustments for Prepaid Expenses
Prepaid expenses are those particular expenses that are paid in advance for
the benefits to be received in the upcoming time. For instance, the insurance
which we pay every year for reimbursement of certain damages- is a
prepaid expense, as we pay the money at the start to receive the benefit over
the period.

In QuickBooks, there is a cool trick that records these prepaid expenses as
assets and charges them as an expense automatically at each period or
month-end. By simply using the memorize feature, you can allow
QuickBooks to record the expense each month automatically.

1. Prepare a Prepaid Expense as an asset account type in the Chart
of Accounts.

i. Navigate to List -> Chart of Accounts and select the option.

ii. Press Ctrl + N to prepare a new account.

iii. Choose the account type for the prepaid expense as Other
Current Assets.

iv. Fill in the remaining information, and for any selection of the
expense, use the prefix “Prepaid.” This will differentiate the
asset from the actual expense. For instance, Prepaid Salary
or Prepaid Shipment & Cargo.



v. Press enter to Save & Close the new account window.

2. Record or pass the entry for creating the prepaid expense.

i. Navigate to the Write Checks icon on the main home and
select it.

ii. Select the appropriate cash account from where the payment
was made.

iii. In the expenses tab below, choose the Prepaid Salary
account or any other account name which you have selected.

iv. Add the amount of the expense and press enter to save the
transaction.

3. Allow QuickBooks to adjust at each monthly interval
automatically.

i. Find List in the menu and navigate to the Make a General
Entry option to select it.

ii. Add the General entry for the transaction at the month or
period end.



iii. Navigate to the top to find the option of Memorize and
select it.

iv. Once it is selected, set a date for the transaction to be
automatically passed at each month or period-end.

v. Press enter to save the changes and press enter once more to
save the transaction.

Advanced Use of Prepayments made to Vendors
Sometimes, even our vendors or suppliers can ask a security deposit from
us, and the reason behind this is that they also want to ensure that we take
the promised goods or services from them. These deposits or prepayments
are adjusted against the final invoices that we receive from them in the
same manner as we adjust the advances from customers against their final
invoices that we send to our customers.

We will follow the same process as the one mentioned in prepaid expenses
but with a slight change in the procedures at the end. There are two methods
to account for such types of deposits or prepayment.

The first method will adjust the deposit as a negative expense when we
purchase the items from the vendor, while the second method will adjust the
vendor deposit against the invoice that we will receive from the vendor.

We will first look into the first method, where it will be adjusted as a
negative expense. 

1. Prepare the account for vendor deposits & prepayments as
other current assets

i. Find and navigate to List -> Chart of Accounts to select it.

ii. Use Ctrl + N short cut key to open the new account option.



iii. Choose the account type as other current assets and name the
account as you desire. You can name these deposits as
Advances to Vendors or Vendor Deposits & Prepayments
etc.

iv. Fill the remaining information in the window, and once you
are done, press enter to save the changes.

2. Choose the vendor account when payments are made

i. Find and navigate to Write Checks icon on home to select it.

ii. Choose your desired account from which the payment was
made and also add the account name in the Expenses tab
below.

iii. Include the amount along with that fill out the remaining
information and press enter to save the transaction.

3. Adjust the deposits & prepayments

i. Once the expenses are incurred, and the item bill is received,
Re-open the Write Checks page.

ii. Add the expense bill amount in the first line of the Expenses
tab below, while in the second line, add the Vendor Deposit
& Prepayment account and represent it as a negative
adjusting balance.

iii. Fill the remaining information in the window, and once you
are done, press enter to Save & Close.

This first method is used very rarely because sometimes you may not be
able to know the actual amount of deposit of a particular vendor when there
are a lot of vendors. So, a more efficient and streamlined approach to
adjusting the deposit is by using the second method.



1. Target the payment to the vendor's liability account

i. Open the Write Checks page and target the deposits &
prepayments to the vendor’s liability account in the
Expenses tab below.

ii. Fill all the remaining information in the check, and once you
are done, press enter to Save & Close.  

2. Clear the balance by credits

i. Navigate and find the Enter bills icon on the home and select
it.

ii. Add the bill or the invoice which is received from the vendor.

iii. Fill the remaining information as per your desires on the
page.

iv. Press enter to save the bill and pass the transaction.

v. Now open the Pay Bills icon and select the bill or invoice of
the vendor.

vi. Choose the option for Available Credits at the bottom of the
page.

vii. Add the number of credits that are to be adjusted against the
available invoice. Note that these available credits are
basically the deposits and prepayments made to vendors or
suppliers.

viii. Press enter to exit the window and save the amount to be
adjusted against the available invoice.

ix. Fill the remaining information on the page and select the
desired account from which the payment of any outstanding



balance of the invoice has to be paid.

x. Press enter to save the transaction.

3. Pass the General Entry at the year-end to adjust the closing
balances.

i. If there are any outstanding balances in the Creditors
account at the year-end, then open the “Make a General
Entry” page from the Accountant option present in the
menu.

ii. For the entire outstanding balances of the vendors, enter the
journal entry to debit the Vendor’s Deposit & Prepayments
and credit the Creditors account.

iii. After the year-end, reverse the transaction to ensure the
continuity of the same procedure as followed before the year-
end.

Although this method may be hard to follow, it does ensure that there is no
error or mistake when paying the bills. The major focus is on cash flow
management, and to improve this management overpayment, or excessive
adjustment of such accounts mustn't be made. 

By using the first method, the problem arises when we consider that the
vendor deposit account is fully adjusted from the expense, when, in fact, it
hasn’t been completely adjusted. You might not realize in day to day
operations, but at the year-end, when you will reconcile the balances, there
would be a difference. In some cases, the other party claims that the entire
balance has been adjusted when, in fact, it hasn’t been.

So it is up to your standard procedures and policies regarding such cases
that will attribute a change in the system and provide benefit to your cash
flow management and business performances.



Depositing Refunds from Suppliers
Sometimes, the deposits that you will make to your vendors or suppliers
won’t be adjusted against any balance. Rather it would be refunded back to
you at some point later on. There can also be a case that the vendor gives
back the remaining cash amount, that has not been adjusted, back to you.

In both cases, the cash is received from the vendor. However, there would
be a change in the process if there is any available credit that existed against
the vendor. The reason is that the credit is automatically applied when we
receive the invoices from the vendors. If the vendor paid the excess credit
amount as a refund, then the credits must be properly adjusted.

Firstly, we will discuss the method for adjusting the refunds received from
vendors against the deposits when the credit is available.

1. Receive the refund check and deposit it

i. Navigate to the Record Deposit icon on the home page to
select it.

ii. Choose the cash account in which the supplier deposited the
refund.

iii. Make sure that you choose the accurate account for the
supplier in the line below and enter the amount received as a
refund.

iv. Fill the remaining information on the page and press enter to
save the transaction.

2. Adjust the credits against the refunds

i. Find the Pay Bills icon on the home flowchart to select it.

ii. Choose the appropriate supplier from whom the refund was
received.



iii. Navigate to the Set Credits option at the bottom of the page
and click on it.

iv. Choose the credits to apply on the bill and press enter.

v. Fill the remaining details of the page.

vi. Press enter to save the transaction and to pay the bills.

This method fully accounts for the credits which are pending against the
supplier or vendor. Thus, when you receive the refund check, all the
outstanding credits and balances will automatically be accounted for by
QuickBooks.

In the other method, as there is no credit available against the supplier then,
all you will have to do is simply record the amount received as a deposit.
This can be done easily by navigating to the Record Deposits icon present
on the home page. By following this technique, you will be able to manage
your cash payments against the suppliers.

Utilizing the Discounts & Rebates from the Suppliers
When managing the cash flows, one of the major cost-saving elements that
are beneficial for the business is the discounts and rebates received from the
suppliers. It’s a common practice amongst many businesses that the
suppliers offer certain discounts beyond the invoiced amount that if you pay
them in a certain time frame, you will receive a percentage of discount on
the invoice value.

While rebates are the bulk discounts that certain suppliers provide to their
customers when they want to clear out their inventory or stocks. Both these
types of discounts must be fully taken into account when paying bills of
suppliers. The reason is that these rebates and discounts act as exponential
cost-savings for the business that means more cash to save and invest in
other business activities.  



Processing discounts and rebates in QuickBooks is very easy and can be
done in a precise manner. The discounts that are received on the overall
invoice value will be targeted to an account that recognizes discount
received as a gain for the business. On the other hand, the rebates will
adjust the costing of the items at the time when these items are received
from the supplier.

Firstly, we will discuss the discount received from the suppliers.

1. Prepare a “Discount Received” account with the category of
“Other Income.”

i. Select List -> Chart of Accounts from the menu.

ii. Press Ctrl + n or right-click to use the “New” option.

iii. Choose the category as Other Income in the account type.

iv. Select and enter your desired name for the account as either
Discount Received or Gain on Discounts.

v. Fill the remaining information on the New page and press
enter to create the account.

2. Add the bills related to the Invoice

i. Open the Enter Bills page from the home page.

ii. Add all the invoices of the vendor or supplier that is received
from them.

iii. Fill all the remaining information present in page and press
enter once you are done to save the transaction.

3. Target the “Discount Received” account when paying for the
invoices



i. Find the Pay Bills icon on home and select it to open the
page.

ii. Select the supplier or the vendor from the list of outstanding
bills.

iii. Navigate to the Set Discount option and add the Discount
Received account to where the discount will be targeted.

iv. Include the percentage of the amount of discount which the
supplier or the vendor is providing.

v. Press enter to save the change made to the discount option.

vi. Fill the remaining information on the Pay Bills page and also
add the net amount which you are expected to pay.

vii. Choose the cash account from the bottom.

viii. Press enter to save the transaction and pay the selected bills.

This method is used in those cases when the supplier rarely offers a
discount and not in the normal course of business. However, if your vendor
or supplier regularly offers a discount on the early payment of the dues.
Then, a more efficient approach would be to create the Terms in the vendor
center.

You can perform this action by navigating to the Vendor Center and
simply add the Terms in the Payment Settings tab. This will automatically
add the discounts each time when you are paying the bills before the expiry
of the discount tenure. The rest of the steps, as mentioned above, will be
followed in the same manner as described.

You can also keep track of the number of discounts received from the
suppliers by navigating to Reports -> Custom Reports -> Summary from



the menu and selecting it. From there, you can filter all the details as per the
defined fields and options available.

Handling Supplier Rebates
Rebates can be of two types; the simple bulk rebate is given on the mass
purchase of goods from the supplier that can be done by simply adding the
rebate discount from the Payment Settings in the Vendor Center. Once
you pay for the invoices, you can add the rebate discount from the Set
Discount option present in the Pay Bills page.

However, the second type of rebate is far much different from the first type.
These rebates are given by the suppliers to your particular customers each
time they would purchase the item or service from your business. For
instance, your supplier’s terms state that each time you sell the product to
your particular customer, you will transfer the benefit of rebate to your
customer and receive the rebate income from them.

Now, this is a complex mechanism that is explained here, but luckily you
will easily be able to manage this on QuickBooks.

1. Create and Prepare a “Rebate Income” account categorized as
“Income” type

i. Open the Chart of Accounts from the menu.

ii. Select the option for the New account present in the Chart of
Accounts page.

iii. Choose the account type as Income and name the account as
Rebate Income.

iv. Fill the information which is pending on the page.

v. Press enter once you are done to create the account.

2. Prepare an Item named as “Rebated Sales” from the Item List



i. Open the Item List option from the menu.

ii. Choose the option for the New item present in the Item list
page.

iii. Select your desired name for the item, i.e., Rebated Sales or
Sales Rebate.

iv. Add the account in which you recognize your primary sales
revenue.

v. Fill the pending information in the window and include the
standard selling rate as well.

vi. Press enter to save the changes and to create the new item.

3. Prepare a price level for special customers.

i. Navigate to List -> Price Level list from the menu to select
it.

ii. Press Ctrl + n or choose the new option to prepare a new
price level.

iii. Name the price level list as Special Rebate Customers.

iv. Choose the custom option and tick the checkbox of the
Rebated Sales or Sales Rebate item, which you have
created.

v. Add the custom price for the item.

vi. Fill the pending information on the New Price Level List
page and press enter once you are done to save the changes
made. 

4. Link the price level to the special customers

i. Open the Customer Center and choose the customer to
whom you are trying to assign the rebate.



ii. Find the Payment Settings tab and click on it.

iii. Assign the custom-made price level list to the customer.

iv. Press enter to save the changes.

Whenever you create the invoice for these special customers, QuickBooks
will automatically assign them the custom selling rate, i.e., rebate on sale of
goods or services. In this manner, you won’t have to create a separate item
to account for the rebates as losses or discounts.

Now, you will be able to pass on the rebate benefits to the customer without
having QuickBooks to pass any unnecessary discount entry. But it is
important that you also charge the supplier for the rebates which you have
provided to your customers.

5. Prepare the Sales summary to receive cash from supplier

The best way to follow this is by creating an entire summary of the sales
made to these special customers. In this manner, you can create a receivable
against the supplier, or you can create credits against the supplier.

This will depend upon the terms and conditions decided between you and
the supplier.

i. Navigate to the Create Sales Receipts and click on it.

ii. Add or include the amount received from the supplier and fill
the remaining information.

iii. Once you are done, press enter to save the transaction.

In the final step, you can perform an alternative technique that you create
another item from the Item List, which is dedicated to rebate income
received from the supplier. In that manner, you will be able to book a
receivable from that supplier.



1. Create another item named as Supplier/ Vendor Rebate Income
from the List -> Item list.

2. Prepare a new customer that has an identical name to your supplier
from the Customer Center but mark the name with a symbol or an
additional alphabet (For better understanding, we will say the
customer will be named as Vendor-C).

3. Along with that, re-open the price level named as Special Rebate
Customers (Please see the previous example) and navigate to
Custom option to select it.

4. You must remember that both items Rebated Sales (Please refer to
the previous example) and Supplier/Vendor Rebate Income is
ticked in the checkboxes. But both should have different custom
rates.

5. The amount by which you will reduce the custom rate of Rebated
Sales for your customer must be added in the custom rate of
Supplier/Vendor Rebate Income for your Vendor-C.

6. Now finally add this new price level to your Vendor-C from the
Customer Center -> Payment settings tab.

By following this procedure, you will have to create two invoices, one that
will be charged to your customer while, the other which will be charged to
your supplier for recovery against rebates. 

If we take this into the further advanced techniques and methods, you will
also be able to create credits for the supplier, charge sales tax on rebates to
the supplier and even receive further discounts from the suppliers. Make
sure that for each case, you follow the steps as defined in the previous
sections of this chapter and the previous chapters both.

Can I offset my Creditors with my Debtors?



Is there a balance in your trade receivables account that you wish to offset
from your trade payables account? Is there a person who is your debtor and
creditor both? Here are some reasons why this situation can exist:

Your customer supplies different goods to your business operation;
thus, he is also your supplier.

You endorsed a check of the same amount received from the
customer to your supplier. Thus, you receive debts from the third
party while simultaneously paying your supplier for the equal
amount of debt you owed to him.

In these circumstances, your customer is also your supplier, and you will
have to adjust or offset the balances of both accounts. This can be done
easily if you follow the following procedure:

1. Prepare a suspense Cash account named as “Clearing Account.”

i. Navigate to the Chart of Accounts and select the new option
from the Chart of Accounts page.

ii. Choose the account type as Bank and name the account as
Suspense Clearing Account or Endorsement Clearing
Account (You can decide the name according to your desire).



iii. Fill the pending information on the page.

iv. Press enter to Save & Close. 

2. Clear off the dues of receivable in this account.

i. Navigate to the Receive Payments Icon on the home and
select it.

ii. Choose the customer whose balance you are trying to offset.

iii. Add the appropriate amount which you are offsetting against
the trade payables and choose the invoice or invoices as well.

iv. Fill in the pending information and, if there is underpayment
against a particular invoice, then choose the Leave this as an
underpayment option.

v. Press enter to save the transaction.

vi. Open the Record Deposits page and choose the payment
received.



vii. Make sure that you add the Clearing Account to where the
balance will be deposited.

viii. Press enter to save the transaction.

3. Clear off and offset the dues payable in this account.

i. Navigate to the Pay Bills icon and select it.

ii. Choose the supplier whose balance you want to clear off.

iii. Change the payment method to the Clearing Account.

iv. Tick all those Invoice checkboxes in the table against which
you want to adjust the balances.

v. Add the amount which you are offsetting in the Amt. To Pay
column of the table.

vi. Fill the pending information on the page.

vii. Press enter to save the transaction and to pay the selected
bills.

From the given process, we can adjust the entire balances of the suppliers
and the customers, or we can offset partial amounts from each account. You
can offset the balance from one person’s account to another person’s
account as well.

There is, however, a condition when using this technique that you will need
to have a documented response from both parties that they want to adjust
their balances. Otherwise, you will report inaccurate and misleading
figures.

You can also access the reports regarding the offset entries that have been
passed and, you can also review any changes which have been made in
these accounts.
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Pro Payroll Processing Techniques

In this chapter, we will only go over the advanced techniques for payroll
and payroll processing in QuickBooks. The payroll in QuickBooks can be
performed automatically or manually both. The techniques to set up the
payroll isn’t that much difficult as compared to handling a complex
problem.

Most payroll that is handled automatically doesn’t raise any issues or
problems for users like us. But in case you want to go over the limit and
perform manual calculations, then you may face more roadblocks
frequently on payroll issues.

That is why, in this chapter, we will discuss the advanced ways and
techniques to handle the different payroll issues and errors.

The Irreconcilable Difference on Paychecks
The most common issue which is faced in payroll is the irreconcilable
difference that arises in the Paychecks. Normally, when you process a
Paycheck and pay your employees, you realize that you over or underpaid
the employees. When these differences arise, you are unable to understand
where the calculation error started.

The main reason why such differences arise is because of the sequence of
the additions and deductions that are to be made on the Paychecks.
QuickBooks automatically calculates the net pay that is to be paid to the
employees, but if it is managed manually, then there may be errors when
making certain deductions.

1. If you have added multiple accounts that have a fixed amount that is
to be deducted from the Paycheck, then make sure that when you



are paying your employees, these deductions are mentioned at the
top of the list. Afterward, any sort of fixed percentage amount
should appear at the bottom of the list.

For example, if the employee has health insurance that has a fixed amount
deduction, then make sure it is deducted before the 401(k), which has a
fixed percentage of 5%. 

2. Another reason why there may be a difference is that you added a
bonus later on after you paid the Paycheck. This will cause another
issue as the fixed percentage deductions such as Federal
Withholding Taxes, Social Security, etc. will have to be recalculated
for that particular employee. So make sure that you include all
bonuses and all additions before QuickBooks make deductions.

The best way to find out whether there was an error in the calculation is by
performing reconciliation based on the liabilities. You can perform these
reconciliations on all the payroll liability heads to find out if any of the
liabilities are understated.

i. Navigate to the Accountant -> Reconcile option in the top menu
bar.

ii. Choose the payroll liability accounts which you want to
reconcile.

iii. Add the amount according to your calculations and press enter to
locate the discrepancy.

Advanced Manual Payroll with Multi-Currency
Sometimes you might have a different reporting currency other than USD.
In such a case, you might not be able to use the automatic payroll feature
which QuickBooks offers. For this, you will have to set up the manual
payroll to track the time of your employees based on their performance or
jobs.



This type of issue is faced by those users who have to navigate through the
entire payroll just to make the payroll process function. You need to
remember that, once you set up this particular feature, you can’t undo it;
otherwise, it will possibly corrupt your data. Also, you will need to have the
enterprise version of QuickBooks for it to work.

1. Activate the Manual Payroll from preferences.

2. Navigate to the Employees -> Payroll Setup from the menu bar.

3. Begin the payroll set up process and simply tick all the checkboxes
that say, “I don’t offer this in my company.”

4. After you are finished with the setup, exit to the home page.

5. Include any employees in the Employee Center if you have not
added them before.

6. You will notice that on the home page, a few new options will be
added, such as Pay Employees and Pay Liabilities.

7. Open the Pay Employees icon and set up a USD Bank account with
functioning currency like the US Dollar.

8. Press enter to save the changes.

You need to remember that:

1. You can’t remove the USD bank account as it will cause
QuickBooks to glitch, and you won’t be able to process any payrolls
other than by restoring your previous data and starting the entire
work all over again.

2. You must use the exchange rate for your functional currency and
USD as “1”. Otherwise, you won’t be able to process an appropriate
check to adjust the dollar bank account’s negative balance.



3. All your Paychecks will be paid from the dollar account, which you
have created in QuickBooks, so you must remember to adjust it as
well from your actual bank account from where the employees have
been paid from.

This process may seem easy here, but you must be very careful to use this
technique with extreme caution. Otherwise, your company data file may
become corrupted, and you would have to start all over again from your last
backup file.

Most businesses operate in different countries and don’t have functional
currency like the US Dollar. By using this technique in QuickBooks, you
will be able to:

Track time and pay your employees based on the time that is entered
in the timesheets.

Perform automatic calculations for their Paychecks.

Compare the time spent on the job with actual and budgeted hours.

All these functionalities are hidden and can’t be accessed by those who
operate in different countries, but QuickBooks has made it possible for us to
have full access to our payroll processing. You can also add different types
of additions and deductions by naming them according to your needs, but
you will have to ensure that all these deductions and additions are made
properly.

To confirm this, you can use a few dummy figures to verify whether
QuickBooks is processing your additions and deduction accurately or not.
Otherwise, you can pass the general entry to record any of your liabilities.

Once you activate this feature, you can also extract various reports
regarding the employees and payroll, such as Employee Earnings
Summary. You can also track total hours worked by employees on



particular customers or particular jobs. This can access from the Reports ->
Jobs, Time, and Mileage -> Time by Job Summary, which will display
the entire information regarding the time spent by employees on various
jobs.

Advanced Techniques for Tracking Employee Loans
Employee advances and employee loans are one of the major payroll issues
that aren’t handled easily. There are several ways to adjust the advances and
loans taken by the employees. Still, the actual efficient method of adjusting
the loans and advances of employees is through the automatic calculations
performed by the system.

Several factors have to be accounted for when dealing with employee
advances and employee loans.

•         These are non-taxable items that aren’t subject to any tax or any
service fees.

•         These are primarily to be adjusted from the Gross Paycheck amount
before any deduction or any other charges.

•         If these loans are interest-free, then the financial expense that is not
paid by the employees will be considered as income and must be
taken into account when calculating the gross Paycheck.

•         These loans and advances have to be adjusted over a period of time
while ensuring that the tax withheld on these is done properly and
adequately.

In order to understand the working mechanics of this advanced issue, we
will provide a much broader explanation here.

1. Prepare a new Employee Loan account, which has the account type
as Other Current Assets from Lists -> Chart of Accounts option
on the menu bar. Fill all the desired information on the page and
press enter to create the new account. 



2. Write the check to the desired employee to give the loan from the
Write Check icon on the home page. In case the loan is paid
through the Paycheck, include it as a non-taxable addition item, but
if it is paid through a normal check, then choose the Employee
Loan account.

3. Include a payroll item named Loan Repayment for the repayment
of loans by the employee from Lists -> Payroll Item list on the
menu bar. This payroll item will be a deduction item and ensure that
it is non-taxable. Make sure that you add Employee Loan account
to be set as the Liability account in the Add New Payroll Item
window.

4. If there is interest on the loans to the employees, then add another
payroll item named Interest Payments as a deduction item on
Paycheck for the interest on loans. This will be categorized in the
account type as Other Current Assets named as Interest
Receivable in the Chart of Accounts while it will be set as a
liability account in the Add New Payroll item window. 

5. Finally, navigate to the Employee Center and choose the Payroll
info to add Loan Repayment item and Interest Payment item to



the employee. Once you are done, press enter to save the changes
made.

Each time when the interest will be charged to the employee, it will
automatically create a negative balance in the Interest Receivable account.
This account will be created with this name to target the interest received
from the employees.

Once QuickBooks automatically deducts the Interest from the Paycheck, it
will be sent to the interest receivable account. You can then simply adjust
the balance of this account by creating sales receipts from the Create Sales
Receipts icon on the home.

But you must remember to add the accounts and payroll items carefully to
the employees. Along with that, make sure that the loan and the interest are
non-taxable deductions. The interest received from the employee is taxable
to the company, not the employee.

As mentioned earlier, sometimes, the employees will receive interest-free
loans. In such a case, you will have to create another Payroll Item, which
adds the benchmark interest rate and places a track of this expense in the
Interest Receivables account. In this case, make sure that the addition is
taxable.

Once this payroll item is added to the employee, it will automatically
increase the total gross Paycheck amount when it is being calculated, which
will be subject to tax. On the other hand, the Interest Payment payroll item
will deduct the same amount of interest from the Paycheck, which won’t be
subject to tax.  

In this manner, the tax to be withheld will be properly calculated on an
interest-free loan given to the employees.

Pro Tips for Keeping Track of Payroll



Payrolls sometimes can become extremely tricky to handle, especially when
there are too many automatic calculations involved. We have discussed all
the major advanced areas of the payrolls but here are some helpful tricks
and tips to keep in mind when dealing with payrolls like a pro:

1. Make sure that each employee’s payroll item addition, deduction,
and compensation is properly setup. Since most of the calculations
are performed automatically by QuickBooks in both fully automatic
systems and manual systems, so you must focus on tracing back to
the payroll items when there is an error or inconsistency in the
calculations.

2. Track the time of each employee by the customer or by the job. This
will provide better costing for other overheads during the
manufacturing of goods and will give a better cost analysis of the
project for rendering particular services. So ensure that all the time
tracked by the employees is done in correspondence of the relevant
customer or job in which they were assigned.

3. Prepare an additional manual excel sheet to keep track of the actual
amount of payroll liabilities at any point. This will help you
reconcile any differences which arise between the excel sheet and
the total payroll liabilities. Any sort of discrepancy can be easily
traced by this particular method.

4. If you are using a different currency or have multiple currencies as a
functional currency, then for QuickBooks, make sure that you only
use that currency in which your normal trade or normal business
activities take place. Make sure that the payment made to employees
is reported under the US dollar currency to remove any
inconsistency or inefficiency in the process.

5. Make sure that you adequately adjust the US dollar account in case
of manual payroll under multiple currencies. Remember to keep the



foreign exchange rate as 1:1 for both the US dollar and your
reporting currency.
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Managing Workflow with Reports

In this chapter, we will discuss the various types of reports and report
benefits for advanced use. Along with that, we will include all those special
types of reports which are available for different industries. QuickBooks
has a large library that holds different data types and creates different data
fields to benefit us in the reporting phase.

Many businesses have special reporting requirements that are unrelated to
the different types of industries. Every business specializes in a specific
field; thus, they require unique reports for long-term benefit and use.
However, there are a few common reports and reporting requirements that
are found in almost all types of industries.

So in this chapter, we will first go over the common advanced reports which
are needed in all the industries, and then, later on, we will go over the
special reports of each industry.

Advanced Forecasting and Budgeting
As a large business entity, the business needs to create and manage its
budgets. These budgets are used as the prime goals and targets for the
business to understand its growth and performance in the upcoming months
or periods. Essentially, budgets play a huge part in understanding the
necessary allocation of resources.

Budgets are targets to be achieved in the subsequent periods, while
forecasts are estimates to the possibility of achieving such targets. Forecasts
provide a view of the probability that certain goals and targets can or can’t
be achieved. There are certainly other benefits of using budgets and
forecasts which include that:



•         It allows the business to understand its market competitiveness and
total market share.

•         It allows the business to find new ways to innovate and come up
with new strategies.

•         It provides business insight regarding cost-saving and profit
optimization.

•         It motivates and drives the employees and other officers of the
business to take serious actions to allow the business to grow.

•         It ensures the business’s commitment to excellence and upholds its
values.

QuickBooks provides easy and simple tools for budgeting and forecasting
the financial results, which are immensely flexible to use. The budgets in
QuickBooks, by default, are created on the previous year’s financial results.
However, you can change them as well and provide your own figures to be
used in these budgets.

1. Navigate to Reports -> Budgets & Forecasts -> Budget Overview
from the menu.

2. Choose the Create New option to prepare a new budget.



3. Here you can select the desired year and the particular type of
budget that you need.

4. Press enter to move to the next window and fill the pending
information.

5. Choose whether you want to Create Budget from Scratch or create
the budget from last year’s financial results.

6. Press enter to Finish and prepare the budget.

7. Follow the same process for the forecast as well but navigate to
Report -> Budgets & Forecasts -> Forecast Overview to prepare
the new forecast.

If you have not created any budgets or forecasts before, then you can
navigate to the reports section to prepare a new one. Otherwise, if you want
to set up another new budget or forecast, then navigate to Company ->
Planning & Budgeting -> Setup Budgets or Setup Forecast and select the
desired option.

Once your budgets and forecasts are prepared for the desired year, you can
review and check the progress of them with the actual results over the year.
Simply navigate back to Reports -> Budgets & Forecasts -> Budget
Overview or Forecast Overview and choose the appropriate option. This
will provide an overview of the budget that you have prepared with a
month-wise detail along with a full year detail.

If you want to compare the results between the budgeted profit and loss and
actual profit and loss, then navigate to Reports -> Budgets & Forecasts ->
Profit & Loss Budget Performance and select it. This will provide a year-
to-date and a month-wise comparison between the budget and the actual
results, along with the variances between the two.



You can also create a custom report in the page by choosing the Customize
Report option at the top left side. By adding the different fields, you can
have a full analysis of any possible inconsistency between the budget and
the actual performance.

Customizing your Reports
In QuickBooks, many different reports are present by default, but
sometimes you may find that there aren’t any reports which you desire. For
instance, if you want to find out which customer contributed the most part
of your business’s equity, then this type of report won’t be present by
default in QuickBooks.

Now, these types of reports aren’t unique, but they are not commonly used
by different users. Thus, QuickBooks also offers the Custom Reports tool,
which helps you prepare your own desired reports easily.

You can access this by simply navigating to Reports -> Custom Reports -
> Summary and clicking on it. This window will allow you to choose a
different field of data for columns and another field of data for the row. It is
important to note that QuickBooks will display a warning pop-up stating to
choose a different field for any one of the data fields as QuickBooks can’t
provide redundant information for common data in both fields.

This is a very handy and useful tool as it gives valuable insight between the
interlinking information of the different fields. It also gives a much detailed
and organized report regarding the data.

By navigating to Reports -> Custom Reports -> Transaction Detail and
clicking on it, you will be able to access customized transaction detail
reports for any of the accounts in the general ledger. You can also modify
both these types of reports by selecting the different tabs.

Managing and Reporting Specialized Fields



Some businesses, such as law firms and other consultancies industries,
require a few different sets of fields in which they want to add different data
regarding their customers. For instance, the construction industry has
multiple projects in different geographical regions.

Suppose the owners would want that each customer and vendor is classified
according to those projects. This means that, when the vendor supplies to
that project, it is classified into that particular project. If the customer
purchases any land or construction from any project, it is classified into that
particular project.

Another common example is law and tax firms. Most law and tax firms
require additional information regarding their clients, such as the name of
their spouse, tax information, national identity card number, login
passwords to IRS, etc. These fields aren’t commonly found in QuickBooks.

However, QuickBooks allows us to create and define our own fields on top
of the fields already mentioned to enhance the customizations of reports.
You need to remember that these desired fields will only appear once you
customize your reports. These reports won’t be generated by default and
won’t be available as a default option.

You can create Custom Fields by navigating to either the Customer
Center or Vendor Center from the Customers or Vendors, respectively,
present in the menu and by selecting it. From there, you can choose
Additional Info -> Define Fields option to define your own special fields.

The best way to use and retrieve the desired information is by customizing
your reports from the reports which are already opened or available in
QuickBooks. The other way you can access such information is by
choosing Reports -> Custom Reports -> Summary, which will allow you
to define your desired fields.

Grouped Data by Class



Tracking information by class is extremely beneficial and a useful
technique to classify the entire performances of the business into operation
centers. These are mostly useful for those businesses which have multiple
divisions of their business or have multiple project sites scattered in
different geographical regions.

1. Navigate to List -> Class List from the menu and select it.

2. Add your desired class information and create the class lists.

3. Use the Class List to classify each transaction based on the division
or class.

You can create links to these particular classes from the transactions. This
will automatically segregate the data based on class and based on the
transactions, which will provide ease in tracking profitability or
performance per class. 

Grouped Data by Customer Type
Customer type classifies each customer based on the particular service or
goods which they receive from us. This list can also be classified on other
types of customers, whether they are a person or a business entity, a
manufacturer or a retailer, etc. By grouping particular customers based on
their types, it can allow us to easily evaluate the more profitable market and
the major to least market share of our business.

By providing us with the opportunity to assess our business customers, we
can look for more ways of increasing our market share based on these
specific types of customers. Not only that, but we can also retrieve a
detailed report for the type of services or goods which they frequently
receive from us in case we provide more than one type of service or goods.

1. Navigate to the Lists -> Customer & Vendor Profile Lists ->
Customer Type List from the menu and select it.



2. Prepare your custom list for customer types and enter all the
appropriate information.

3. Press enter to save the Customer Type.

4. Navigate to Customers -> Customer Center to select it.

5. Choose the desired customer to edit and include the Customer
Type in the Additional Info tab.

6. Press enter to save the changes.

Once you have added the customer types to all the customers, you can
access the customer type list by navigating to Report -> Customers &
Receivables -> Customer Phone List and selecting it. Choose Customize
Report option on the top left side and include the Customer Type from the
available search list. Press enter to add the desired field in the report.

The new customized report will display all the required information
regarding the customer types. You can also choose to filter the report with
only one particular type of customer, or you can modify the report to add
other fields in correspondence to the type of customer.

By using the customer type field, you can easily filter the entire information
and select the desired fields. For instance, if you require a Retailer
customer type to be displayed with their Phone Numbers and Emails, this
can be done by simply adding all those required fields from the Customize
Report option.

Grouped Data by Job Types
Just like categorizing the customers based on the customer types, you can
also categorize and classify all the customers based on their job types. For
instance, if you have a set of similar jobs with multiple clients, then a better
categorization of each type of customer would be based on the job type.



The job type will provide a much clear understanding of business
performance based on the job type. Along with that, by grouping the
customers based on these particular job types, we can easily assess the more
profitable sector of our business. The job type list can also be used in
combination with the classes to evaluate the profitable sector in each
division or branch of the business.

1. Navigate to List -> Customers & Vendor Profile Lists -> Job
Type List to select it.   

2. Press either Ctrl + n or choose the New option to prepare your
desired types in the list.

3. Choose and enter the desired name for the job type and press enter
to save the Job type.

4. Navigate to Customers -> Customer Center to select the desired
customer for Edit.

5. Include the Job Type of the customer along with the start and end
date of the project from the Job Info tab.

6. Once you are done, press enter to save the changes to the customer.

If you want to access the report, simply navigate to Reports -> Customers
& Receivables -> A/R Aging Summary to select and customize it. Make
sure to add the Job type field in the Customize Report option to display it
on the report.

This will provide you with the A/R Aging Summary based on the Job
types. For instance, if you are looking to find out which debtors of
particular job types have the most debts and are also most likely to become
bad debts, then this report will help you easily evaluate the situation and
understand the corrective measures.



You can also display the sales per job type by navigating to Reports ->
Sales -> Sales by Customer Summary to select and customize it. Just
remember to choose the Job Type filter along with the Job types to display
in the report. It will allow you to assess the major sales sector of your
business from the entire operational activities.

All reports related to sales and receivables can be customized based on
either the Job Type, Customer Type, or even the Class. It gives a whole
new insight into the business’s performing areas and areas where more
attention and more effort is required with respect to the customers. 

Reporting by Graphs
QuickBooks offers a great variety of reports which are best for analyzing
financial records. Sometimes, this information needs to be reported in the
form of graphs, charts or bars, etc. Normally QuickBooks offers very few
graphs in its Reports section of the menu such as Net Worth Graph and
Sales Graph etc.

Now, the biggest hurdle is that many people, such as investors and banks,
are able to understand the profitability or performance quickly by means of
graphs, charts, and bars. These diagrams quickly depict the overall idea
regarding financial results.

So the best way to convert the financial reports of QuickBooks into graphs
is by the use of Excel. Excel has a great variety of charts, graphs, and bars,
which allows us to create many different types of graphs and plot them out
accordingly. Here are the following steps to convert QuickBooks financial
information into Excel Graphs:

1. Navigate and display your desired report, which you want to convert
into a graph.

2. Find the Export button on the top of the report and click it.



3. Pick whether you want to export this report to an existing excel
sheet or a new one.

4. Press enter to Export the report.

5. Once QuickBooks has exported the report to excel, select the entire
report data.

6. Navigate to the Insert tab on excel and pick the graph type which
you want to place.

You also have the option to convert the data into bars or even charts. You
need to remember that when you pick the desired chart or graph, you are
accurately defining the fields in case Excel is unable to determine.
Otherwise, it can disrupt the data figures in the diagram.

Combined Reporting for Excel
One of the unique features of QuickBooks Enterprise Solutions Version is
that it lets you combine all financial results and statements from the
different company files. For instance, you are running many different
companies or businesses and want to know the total combined results for all
the companies. For this, QuickBooks easily provide the solution to us.

However, it is very important to remember that QuickBooks doesn’t
perform consolidation; it simply combines all the results of all the
companies or businesses in a single report. If one or more businesses
provided services or goods to another associated business of yours,
QuickBooks would not eliminate or reduce the sales and cost of sales made
to associated businesses under the reporting standards.

Otherwise, if all the businesses operate independently from one another,
then combining the financial results would provide you with immense
benefits and understanding of the overall profitability, performance, and
cash flow management.



1. From the menu, navigate to Reports -> Combine Reports from
Multiple Companies to select it.

2. Pick Add Files to merge the financial reports of different company
files.

3. Press enter to Open.

4. Follow the steps as many as times as needed to include all the
company files.

5. Pick all the necessary reports which you want to combine and tick
the checkboxes next to them.

6. Make sure that you add all the pending information in the window.

7. Navigate to the Combine Reports in Excel button and click on it.

8. All the selected reports will be displayed in Excel by QuickBooks
automatically.

In this manner, all your desired reports will be available on Excel, and they
will all be placed in different worksheets. Each column of the report will
represent the name of the company file, along with financial results and
financial figures.

Special Reports for Specific Industries
QuickBooks displays all the specific reports for the various industries.
These selection criteria of the specific reports are done by QuickBooks at
the initial stages when we are setting up our company files. QuickBooks
doesn’t only provide the specific reports based on the industries, but it also
sets up the chart of accounts, workflow papers, and the lists that closely
resemble our business’s operational activities.

1). Specific reports for Contractors



This industry specifically includes contracts and projects which are
sometimes long term or short term depending upon the type of business
operation that they run. In the contractor's industry, the major source of
revenue recognition is based on the Percentage Completion Method.

This method recognizes revenue on the basis of work performed by wage
laborers, employees, vendors, and sometimes sub-contractors. Thus, this
type of industry has a high level of estimates involved, which allows it to
recognize revenue based on those estimates. So the specific reports which
QuickBooks provides these types of industries including:

•         Status of work by job (Job-Status)

•         Cost calculation on the job by either vendor or employee (Job-
Costs-by-Vendor or Employee)

•         Completion cost report which provides the estimated cost to
complete

•         Any outstanding bills related to the job (Unpaid-Bills-by-Job)

•         Outstanding bills of the job with respect to vendor (Unpaid-Job-
Bills-By-Vendor)

•         Any particular expenses which aren’t related to any job.

•         Purchase orders not satisfied by vendors (Open-Purchase-Orders-
by-Vendors)

All these reports are automatically present by default once you select the
contractor's industry at the time of set up. You can also combine the various
techniques mentioned above with each type of report to create a completely
new and unique report.

2). Specific reports for Manufacturers and Wholesalers
Manufacturers and wholesalers are two commonly found industries that
produce to sell goods. This type of industry is extremely competitive and
has to keep track of its cost and profit margins in every instance. These



types of industries have to update their price and cost charts along with that
constantly they have to monitor their inventory and item movements.

These types of industries have a high level of risk involved in their
operations, where even the slightest bad management can lead them to a
downfall. Some of the common reports which QuickBooks adds by default
in these types of industries including:

•         Report for the Sales rep and the sales which are made by these sales
reps.

•         Reports that track the sales orders which have not been completed
yet.

•         Reports that track the purchases not received against the purchase
orders.

•         Report that monitors the physical inventory movement and stock
present physically at the warehouses.

•         Managing sales and purchase returns reports. 

•         Reviewing and evaluating any defective inventory or damaged
stock.

There are more than 15 different reports in total that QuickBooks provide to
the manufacturing and wholesale businesses. These reports track the main
core operations of the business, such as the sales system, the purchase
system, and the inventory management and valuation system.

3). Specific reports for Professional Service Industries
The service industry’s reports mostly resemble that of the contractor
industry because of the same important features that are present in both.
However, there is a difference in their chart of accounts and workflow
papers that make the service industry uniquely different from the contractor
category.



It also includes all the special reports that relate to employees, vendors, sub-
contractors, and other officers.
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Advanced Mechanisms 
in Handling Fixed Assets

Business operations aren’t only limited to handling sales, purchases,
payroll, inventory, and cash management techniques. Business operations
also require that many of the fixed assets or the long-term assets are
properly managed from time to time. The reason is that businesses rely on
their long-term assets or fixed assets for stable returns on their revenues.

Almost all types of industries require some fixed assets or capital assets to
boost business operations to enhance business growth. For instance,
manufacturing industries require large scale production units, factories, and
machinery to produce goods on a massive scale. Service industries require
computers and other office equipment to render the services to their clients.

Thus, every business requires some capital assets or fixed assets to help
them run their business operations. That is why it is also important to
manage fixed assets.

In this chapter, we will discuss the advanced tools and techniques for
managing fixed assets. Along with that, we will also discuss some of the
ways to perform automatic management of fixed assets by QuickBooks.

Combining the Associated Accounts
QuickBooks provides a large variety of features from which we can take
multiple benefits. One of the core asset management techniques is keeping
all related accounts to a particular asset in one place. This technique
requires the complete use of the Subaccount feature, which the Chart of
Accounts offers.



You might try to keep each account separated from the other account, but
sometimes you will have to create a full group for one particular head of
account. Suppose if you want to pass the entry for the Provision for
doubtful debts on Debtors account. It is not a good practice to show
Debtors' account on the current asset side while making the Provision for
doubtful debts account a current liability account type.

In accounting terms, Provision for doubtful debts or Accumulated
Depreciation is considered as a negative asset account, meaning a current
asset type, which simply adjusts the assets account balances for any
estimates.

So, if you have created the Debtors account, then it is better to create
another subaccount named as Debtors- Trade Receivables account. At the
same time, create another subaccount of Debtors account named Provision
for doubtful debts as a current asset account type. In this manner, the
Provision for doubtful debts account will carry a negative balance, which
will automatically adjust the entire Debtors account balance when it is
merged with the Debtors- Trade Receivables account.

Similarly, in the same manner, when you have a fixed asset account, then
make sure that the Accumulated Depreciation account is also a fixed asset
account type in QuickBooks. This will ensure that any negative charge that
is present on the Accumulated Depreciation account will automatically
reduce the cost balance account of the same fixed asset.

1. Go to the Chart of Accounts to create a new account for both the
fixed assets and the accumulated depreciation.

2. Pick the desired name for the fixed asset account, i.e., Office
Equipment, to act as the main account and fill the pending
information. Press enter once you are done to create the account.



3. Prepare another fixed asset account with the name Laptops &
Computers and fill the pending information. Afterward, the press
enters to create a fixed asset account.

4. Again prepare another new fixed account with the name
Accumulated Depreciation- Laptops & Com. Fill the pending
information required by QuickBooks, and once you are done, press
enter to save and create the account.

Now each time when you will pass the entry for depreciation, select the
Accumulated Depreciation account to let it carry a negative balance.
Navigate to Reports -> Company & Financial -> Balance Sheet
Standard, you will notice that the depreciation charge will automatically
reduce the main fixed account.

This will provide you with ample benefits in the long run when you dispose
of the asset. In this way, you will know the exact written down value of
your asset before you sell it to another person. Along with that, it will
adequately report the balances in both the liability accounts and the asset
accounts, meaning when you will access the various reports for current
liabilities, you won’t have to adjust or remove the impacts of such types of
accounts.

Keeping your Skills Sharp on the Fixed Asset Manager Tool
The efficient and effective way to manage your fixed assets is by using the
Fixed Asset Manager tool, which QuickBooks offers. From the menu, it
can be accessed from Company -> Manage Fixed Assets option. This tool
allows you to easily add, dispose, or even update your current list of fixed
assets. This tool also offers a variety of diverse features, which makes the
entire fixed asset management process quite simple and extremely flexible.

Automatic Update of the Fixed Asset List



The fixed asset manager tool can automatically update the current list of
fixed assets from QuickBooks. Each time when you will record a fixed
asset in QuickBooks, the fixed asset manager tool won’t be updated, but
once you activate the feature, the tool will instantly update its entire list
based on the option which you have selected.

1. Prepare a new account in the Chart of Accounts with the name of
your desired fixed asset. Along with that, also prepare the
Accumulated Depreciation account for the asset. Remember to
follow the procedure as defined above regarding the combination of
the associated accounts.

2. Add the purchase of your fixed asset and record it in the Write
Checks icon on the home if you have purchased it through cash. If
you haven’t paid for the asset, then record it from the Make
General Journal Entries.

3. Include the asset in the Fixed Asset List by navigating to List ->
Fixed Asset List from the menu to click on the option. Fill all the
information that is present in the list, and once you are done, press
enter to save the Fixed Asset Item in the QuickBooks list. 

4. Open the Fixed Asset Manager tool and select QuickBooks ->
Update Assets from QuickBooks option to update the list.

5. Pick from the following options, which will appear in the window.
Press enter twice to update the list in the Fixed Asset Manager
tool.

Once the Fixed Asset Manager tool updates the list, you can then edit the
fixed assets according to your desires by clicking on them from the
Schedule. You can add all the additional information regarding the asset in
the various descriptions. Make sure to add the accumulated depreciation
account of the fixed assets in the General Ledger Accounts category.



This will ensure that your fixed asset is charged with the depreciation on the
defined tenure of its use. You will also have to select the Depreciation
Expense account in the General Ledger Accounts category to make sure
that depreciation is being charged in the right account.

You can also update your fixed asset list from the Fixed Asset Manager
tool by simply navigating to the QuickBooks from the menu and choosing
the Save Assets to QuickBooks. This will update the fixed asset list
according to the tool.

Creating various depreciation Charges
Sometimes, the depreciation charge on the fixed assets can vary when
different authorities evaluate them. Suppose you purchased a computer,
which is your fixed asset. Now this computer’s value will reduce over time
due to normal wear and tear, i.e., depreciation. This depreciation can be
used by businesses to reduce their overall income tax liability at the yea-
end.

Let’s say that in federal laws and jurisdiction, you would be allowed to
charge the depreciation on your computer over the next five years while you
would be able to charge the depreciation but only for the next two years in
the state laws. On the other hand, your business follows the policy of
charging depreciation on the asset for three years.

This type of situation creates immense irregularities in financial records.
Because this would mean that every year, you would be charging different
depreciation for different types of rules, and, because of this reason,
QuickBooks provides the different columns for the different types of
recovery basis on the fixed assets.

1. Pick the fixed assets to which you want to add the different
depreciation charges from the Schedule in the Fixed Asset
Manager tool.



2. Navigate to the bottom window where you will find different
columns. One will be titled Federal, the other will be titled Book,
and the next one will be titled State and so on. These columns will
vary depending upon the columns which you have initially selected.

3. Pick the appropriate Tax System and the Depreciation Method
from the drop-down lists.

4. Once selected, navigate to the next row named Recovery Period. In
there, you can add different years for each column. These years are
added in the format as (YY/MM).

5. After you are done, exit the tab, and the changes will automatically
be applied.

This will allow you to maintain separate records for each type of column,
and you can access the reports by navigating to Reports from the menu. In
the reports section, you can select the type of depreciation schedule you
want to print either for the federal laws or the normal accounts for your
personal use.



You must remember that QuickBooks will pass the general entry for the
depreciation according to the Book column by default, as seen in the image
above. However, you can still change the depreciation basis at the time the
depreciation is being charged to QuickBooks.

The other depreciation calculated in different columns will only be used for
review and tax purposes only. They will not affect the actual accounts of
your company data files in QuickBooks.

You can also select tick the checkboxes in the columns if you are provided
with the first-year depreciation allowances. This will be present as
Qualified for Special Depr. Allowance, as seen in the image above.

Automatically charging depreciation to QuickBooks
Normally the most difficult process at the time of book closure is
calculating the depreciation charge on your fixed assets, and this entire
process involves reconciling all the accounts to arrive at the actual figures.
In QuickBooks, the Fixed Asset Manager tool provides an immense
benefit in such difficult times.

This tool automatically calculates the depreciation charge on the entire
fixed asset schedule and prepares the entry ready for posting in
QuickBooks. You must remember that this tool calculates the depreciation
based on the figures which you have entered in its fields.

So any type of inconsistency in the depreciation charge by this tool and the
actual depreciation charge will solely depend upon your criteria selection.
Keep in mind that these inconsistencies can only be fixed if the rectification
is made in the field values of the fixed assets. Otherwise, you will have to
adjust the balances every time the Fixed Asset Manager tool will pass the
entry.

To use the automatic calculation and posting function for the depreciation
charge by this tool, follow the procedure below:



1. Open the Fixed Asset Manager tool.

2. From the menu, choose the QuickBooks -> Post Journal Entry to
QuickBooks option.

3. Pick the period or month ending for the depreciation charge to be
posted to QuickBooks.

4. The tool will automatically calculate and create the journal entry for
the depreciation expense or the amortization expense.

5. Select a name for the journal entry, and you can rewrite the
description if you desire.

6. Press enter to post the entry to QuickBooks.

Sometimes, there might be a minor difference between the debit and credit
side of the journal entry. Simply use the value of the Depreciation Expense
for the Accumulated Depreciation account. This will balance out the
journal entry, and it will be posted to QuickBooks.

Instant Asset Disposal
This tool also provides you with the option to dispose of your assets and
pass their journal entry quickly and instantaneously. All you will have to do
is enter the sales amount along with any expenses borne to make the
particular sale happen.

The rest will be done by the Fixed Asset Manager tool, which will
automatically calculate the gain or loss on the sale of assets. All you will
have to do is copy the gain or loss amount and the accumulated depreciation
amount from FAM (Fixed Asset Manager) tool and simply post it in
QuickBooks as the journal entry.

Simply double click on the asset to dispose of the FAM Schedule and
navigate to the Disposal tab. Add all the appropriate information regarding
the disposal of the asset along with the date and sale value of the fixed



asset. The FAM tool will quickly display the gain or loss amount on the sale
transaction.

Once you are done, exit the tab to save the disposal of the asset.

Other Useful Features
The FAM tool has other useful features as well that it also allows you to
Split the Asset. Not only that, but it also provides the depreciation
projections of the fixed asset’s entire useful life tenure. These features
enable you to decide on a timely basis whether you want to dispose of the
asset right now or after a certain period.

You can also open up the depreciation projections based on federal and state
laws as well. Along with that, you can also create the finalized fixed asset
schedule to be used in the financial statements.

You can also create notes in the FAM tool, which will allow you to simply
create a personal notepad with all the information regarding a particular
asset. Not only that, but you will also be able to generate a full track record
of all the entries made to QuickBooks from the FAM tool. You will also be
able to view any of the changes which have been made on the tool itself as
well.





Conclusion

In this book, we have covered all the fundamental topics regarding the
advanced techniques, methods, and tools that can provide you with the
benefit of the practical use of QuickBooks accounting software. After
reading this entire book, you will understand that QuickBooks has a lot
more hidden functionalities and features that are still waiting to be
explored. Not only that, but every release of a newer version of
QuickBooks also provides its user with a thousand more features and a
thousand more tools that can endlessly be used in creative and unique ways
to solve the problems that we face day to day. We have made sure to cover
all the advanced major aspects of QuickBooks that are used by many users
frequently that involve the advanced methodologies and techniques for
handling inventory, sales, and purchases. In addition to this, we have
ensured to take into account the necessary tools that are present in
QuickBooks and elaborate them completely to provide you with much
extensive detail on how they can ease you in your work operations.

This book was aimed to cover the advanced level methods for managing
your company or business on QuickBooks while also providing minor
insights on how to manage your finances in it as well. However, we have
also ensured that each topic covered in this book is looked at from the cash
management and cash flow perspective as well to keep everything relatable
with examples and actual financial records.

The book also aimed to solve the issues and the errors in the best and
efficient manner to facilitate you in the entire process rather than placing
more burden on you. We have tried to introduce the new ways and methods
in which you can try to solve other problems as well.
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